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Prologue
Welcome
Welcome to Geing Started with Ubuntu, an introductory guide wrien to
help new users get started with Ubuntu.
Our goal is to cover the basics of Ubuntu (su as installation and working
with the desktop) as well as guide you through some of the most popular
applications. We designed this guide to be simple to follow, with step-by-step
instructions and plenty of screen shots, allowing you to discover the potential
of your new Ubuntu system even if you are a novice computer user or are
migrating from another operating system for the ﬁrst time.
Please bear in mind that this guide is still very mu a work in progress
and always will be. It is wrien speciﬁcally for Ubuntu ., and although
we have aimed to not limit our instructions to this version, it is unavoidable
that some things will ange over the life of Ubuntu. Whenever a new version
of Ubuntu is released, we will incorporate updates and anges into our guide,
and make a new version available at http://www.ubuntu-manual.org.
Geing Started with Ubuntu . is not intended to be a comprehensive
Ubuntu instruction manual. It is more like a qui-start guide that will get
you doing the things you need to do with your computer quily and easily,
without geing bogged down with tenical details.
If you are aer more detail, you will ﬁnd excellent resources available
at http://help.ubuntu.com. Ubuntu’s built-in system documentation is also
very useful for accessing help on speciﬁc topics, and can be found by cliing
System ‣ Help and Support in Ubuntu.
If something isn’t covered here, ances are you will ﬁnd the information
you are looking for in one of those locations. We will try our best to include
links to more detailed help wherever we can.

Ubuntu philosophy
e term “Ubuntu” is a traditional African concept that originated from the
Bantu languages of southern Africa. It can be described as a way of connecting with others—living in a global community where your actions aﬀect all of
humanity. Ubuntu is more than just an operating system: it is a community
of people that come together voluntarily to collaborate on an international
soware project that aims to deliver the best possible user experience.

More information about Ubuntu’s online
and system documentation can be found in
Chapter : Learning More.
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The Ubuntu promise
‣ Ubuntu will always be free of arge, along with its regular enterprise
releases and security updates.
‣ Ubuntu comes with full commercial support from Canonical and hundreds
of companies from across the world.
‣ Ubuntu provides the best translations and accessibility features that the
free soware community has to oﬀer.
‣ Ubuntu’s core applications are all free and open source. We want you to
use free and open source soware, improve it, and pass it on.

A brief history of Ubuntu
Ubuntu was conceived in  by Mark Shuleworth, a successful South
African entrepreneur, and his company Canonical. Shuleworth recognized
the power of Linux and open source, but was also aware of weaknesses that
prevented mainstream use.
Shuleworth set out with clear intentions to address these weaknesses
and create a system that was easy to use, completely free (see Chapter :
Learning More for the complete deﬁnition of “free”), and could compete with
other mainstream operating systems. With the Debian system as a base,
Shuleworth began to build Ubuntu. Using his own funds at ﬁrst, installation
s were pressed and shipped worldwide at no cost to the end user. Ubuntu
spread quily, the size of the community rapidly increased, and it soon
became the most popular Linux distribution available.
With more people working on the project than ever before, Ubuntu continues to see improvement to its core features and hardware support, and has
gained the aention of large organizations worldwide. For example, in ,
Dell began a collaboration with Canonical to sell computers with Ubuntu
preinstalled. Additionally, in , the Fren Police began to transition their
entire computer infrastructure to a variant of Ubuntu—a process whi has
reportedly saved them “millions of euros” in licensing fees for Microso
Windows. By the year , the Fren Police anticipates that all of their computers will be running Ubuntu. Canonical proﬁts from this arrangement by
providing tenical support and custom-built soware.
While large organizations oen ﬁnd it useful to pay for support services,
Shuleworth has promised that the Ubuntu desktop system will always be
free. As of , Ubuntu is installed on nearly % of the world’s computers.
is equates to millions of users worldwide, and is growing ea year.

What is Linux?
Ubuntu is built on the foundation of Linux, whi is a member of the Unix
family. Unix is one of the oldest types of operating systems and has provided
reliability and security in professional applications for almost half a century.

Canonical is the company that provides
financial and technical support for Ubuntu.
It has employees based around the world
who work on developing and improving
the operating system, as well as reviewing
work submied by volunteer contributors.
To learn more about Canonical, go to
http://www.canonical.com.

For information on Ubuntu Server Edition,
and how you can use it in your company,
visit http://www.ubuntu.com/business/
server/overview.



Many servers around the world that store data for popular websites (su as
YouTube and Google) run some variant of a Unix system. e Linux kernel is
best described as the core, or almost the brain, of the operating system.
e Linux kernel is the shi manager of the operating system; it is responsible for allocating memory and processor time. It can also be thought of as
the program whi manages any and all applications on the computer itself.
Linux was designed from the ground up with security and hardware compatibility in mind, and is currently one of the most popular Unix-based operating systems. One of the beneﬁts of Linux is that it is incredibly ﬂexible
and can be conﬁgured to run on almost any device—from the smallest microcomputers and cellphones to larger super-computers. Unix was entirely command line–based until graphical user interfaces (s) began to emerge in the
early s.
ese early s were diﬃcult to conﬁgure and clunky at best, and generally only used by seasoned computer programmers. In the past decade,
however, graphical user interfaces have come a long way in terms of usability,
reliability, and appearance. Ubuntu is just one of many diﬀerent Linux distributions, and uses one of the more popular graphical desktop environments
called .



While modern graphical desktop environments have generally replaced early
command-line interfaces, the command
line can still be a quick and eﬀicient way
of performing many tasks. See Chapter :
Advanced Topics for more information,
and Chapter : The Ubuntu Desktop to
learn more about  and other desktop
environments.
A desktop environment is a sophisticated
and integrated user interface that provides
the basis for humans to interact with a
computer using a monitor, keyboard and a
mouse.
To learn more about Linux distributions, see
Chapter : Learning More.

Is Ubuntu right for you?
New users to Ubuntu may ﬁnd that it takes some time to feel comfortable
when trying a new operating system. You will no doubt notice many similarities to both Microso Windows and Mac  , and some diﬀerences. Users
coming from Mac   are more likely to notice similarities due to the fact
that both Mac   and Ubuntu originated from Unix.
Before you decide whether or not Ubuntu is right for you, we suggest
giving yourself some time to grow accustomed to the way things are done in
Ubuntu. You should expect to ﬁnd that some things are diﬀerent from what
you are used to. We also suggest taking the following into account:
‣ Ubuntu is community based. at is, Ubuntu is developed, writen, and
maintained by the community. Because of this, support is probably not
available at your local computer store. Fortunately, the Ubuntu community
is here to help. ere are many articles, guides, and manuals available,
as well as users on various Internet forums and Internet Relay Chat ()
rooms that are willing to assist beginners. Additionally, near the end of this
guide, we include a troubleshooting apter: Chapter : Troubleshooting.
‣ Many applications designed for Microso Windows or Mac   will
not run on Ubuntu. For the vast majority of everyday computing tasks,
you will ﬁnd suitable alternative applications available in Ubuntu. However, many professional applications (su as the Adobe Creative Suite) are
not developed to work with Ubuntu. If you rely on commercial soware
that is not compatible with Ubuntu, yet still want to give Ubuntu a try,

A popular forum for Ubuntu discussion
and support is the Ubuntu Forums, http://
ubuntuforums.org.

To learn more about dual-booting (running
Ubuntu side-by-side with another operating
system), see Chapter : Installation. For
more information on Wine, go to http://
www.winehq.org/.
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you may want to consider dual-booting. Alternatively, some applications
developed for Windows will work in Ubuntu with a program called Wine.
‣ Many commercial games will not run on Ubuntu. If you are a heavy
gamer, then Ubuntu may not be for you. Game developers usually design
games for the largest market, whi leads to larger proﬁts. Since Ubuntu’s
market share is not as substantial as Microso’s Windows or Apple’s Mac
 , most game developers will not allocate resources towards making
their games compatible with Ubuntu. If you just like to play a game every
now and then, there is active game development within the community,
and many high quality games can be easily installed through Ubuntu
Soware Center. Additionally, some games developed for Windows will
also work in Ubuntu with Wine.

Contact details
Many people have contributed their time to this project. If you notice any
errors or think we have le something out, feel free to contact us. We do
everything we can to make sure that this manual is up to date, informative,
and professional. Our contact details are as follows:
e Ubuntu Manual Team
Website: http://www.ubuntu-manual.org/
Email: ubuntu-manual@lists.launchpad.net
: #ubuntu-manual on irc.freenode.net
Bug Reports: http://bugs.ubuntu-manual.org

About the team
Our project is an open source volunteer eﬀort to create and maintain quality
documentation for Ubuntu and its derivatives.
We were founded in  by Benjamin Humphrey, who saw the need for
targeted up-to-date and consistent documentation for the Ubuntu operating
system. It didn’t take long until the project amassed hundreds of contributors, and what Benjamin originally envisioned became a reality as the Ubuntu
Manual Project blossomed into an ambitious and successful project. e
Ubuntu Manual Team emphasizes “geing things done,” and therefore operates in a fast-paced development environment ﬁlled with lots of unique
ideas.
Our mission is to provide a wide range of quality educational materials to
lower the Linux barrier to entry for new users and in turn increase Ubuntu’s
market share.

See Chapter : Soware Management to
learn more about Ubuntu Soware Center.



Want to help?
We are always looking for talented people to work with, and due to the size of
the project we are fortunate to be able to cater to a wide range of skill sets:
‣
‣
‣
‣
‣
‣
‣
‣
‣

Authors, editors
Programmers (Python or TeX)
User interface designers
Icon and title page designers
Event organizers and ideas people
Testers
Web designers and developers
Translators and screenshoers
Bug reporters and triagers

To ﬁnd out how you can get started helping, please visit http://ubuntu-manual.
org/getinvolved.

Conventions used in this book
e following typographic conventions are used in this book:
‣ Buon names, menu items, and other  elements are set in boldfaced
type.
‣ Menu sequences are sometimes typeset as System ‣ Preferences ‣ Appearance,
whi means, “Choose the System menu, then oose the Preferences submenu, and then select the Appearance menu item.”
‣ Monospaced type is used for text that you type into the computer, text that
the computer outputs (as in a terminal), and keyboard shortcuts.





Installation

Geing Ubuntu
Before you can get started with Ubuntu, you will need to obtain a copy of
the Ubuntu installation image for  or . Some options for doing this are
outlined below.

Many companies (such as Dell and System) sell computers with Ubuntu preinstalled. If you already have Ubuntu installed
on your computer, feel free to skip to
Chapter : The Ubuntu Desktop.

Minimum system requirements
Ubuntu runs well on most computer systems. If you are unsure whether it
will work on your computer, the Live  is a great way to test things out ﬁrst.
Below is a list of hardware speciﬁcations that your computer should meet as a
minimum requirement.
‣
‣
‣
‣
‣
‣

The majority of computers in use today will
meet the requirements listed here; however,
refer to your computer’s documentation
or contact the manufacturer for more
information.

 GHz x processor
  of system memory ()
. of disk space (at least  is recommended)
Graphics card capable of × resolution
Sound card
A network or Internet connection

Downloading Ubuntu
e easiest and most common method for geing Ubuntu is to download the
Ubuntu  image directly from http://www.ubuntu.com. Head to the website
and cli the “Download Ubuntu” link. Select whether you require the -bit
or -bit version (-bit is recommended for most users), then cli “Start
Download.”
-bit vs -bit
You may notice the words “Ubuntu Desktop Edition -bit” underneath the
start download buon on the website. If you are unsure what -bit means,
don’t worry. e -bit version will work on most computers, so if in doubt,
simply proceed with the download. However, if you know that your computer
is capable of using -bit soware, you may wish to try the -bit version
instead. To do this, cli on the “-bit” option before you cli “Start download.”

-bit and -bit are types of processor
architectures. -bit is newer, and most
recent computers will come with a -bit
capable processor. See Chapter : Learning
More for more information.
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Downloading Ubuntu as a torrent
When a new version of Ubuntu is released, the download servers can get
“clogged” as large numbers of people try to download or upgrade Ubuntu
at the same time. If you are familiar with using torrents, you may wish to
download the torrent ﬁle by cliing “Alternative downloads,” to obtain your
copy of the  image this way instead. You may see signiﬁcant improvements
to your download speed, and will also be helping to spread Ubuntu to other
users worldwide.

Torrents are a way of sharing files and
information around the Internet via peerto-peer file sharing. A file with a .torrent
extension is made available to users, which
is then opened with a compatible program
such as uTorrent, Deluge, or Transmission.
These programs download parts of the file
from other people all around the world.

Burning the  image
Once your download is complete, you will be le with a ﬁle called ubuntu.-desktop-i.iso or similar (i here in the ﬁlename refers to the -bit
version. If you had downloaded the -bit version, the ﬁlename would contain
amd instead). is ﬁle is a  image—a snapshot of the contents of a 
—whi you will need to burn to a . You can ﬁnd detailed instructions at
https://help.ubuntu.com/community/BurningIsoHowto.
If your  will boot from a  port, you may opt to use a  memory
sti instead of a Live . You can ﬁnd further instructions at https://help.
ubuntu.com/./installation-guide/i/boot-usb-files.html. If you oose
this option, your installation will be running from the  memory sti. In
this case, references to Live , will refer to the  memory sti.

While the -bit version of Ubuntu is
referred to as the “AMD” version, it will
work on Intel, AMD, and other compatible
-bit processors.

The Live CD
e Ubuntu  functions not only as an installation  for puing Ubuntu
onto your computer, but also as a Live . A Live  allows you to test
Ubuntu without making any permanent anges to your computer by running the entire operating system from the .
Your computer reads information from a  at a mu slower speed than
it can read information oﬀ of a hard drive. Running Ubuntu from the Live
 also occupies a large portion of your computer’s memory, whi would
usually be available for applications to access when Ubuntu is running from
your hard drive. e Live  experience will therefore feel slightly slower
than it does when Ubuntu is actually installed on your computer. Running
Ubuntu from the  is a great way to test things out and allows you to try
the default applications, browse the Internet, and get a general feel for the
operating system. It’s also useful for eing that your computer hardware
works properly in Ubuntu and that there are no major compatibility issues.
To try out Ubuntu using the Live , insert the Ubuntu  into your 
drive and restart your computer.
Aer your computer ﬁnds the Live , and a qui loading screen, you
will be presented with the “Welcome” screen. Using your mouse, select your

In some cases, your computer will not
recognize that the Ubuntu  or 
is present as it starts up and will start
your existing operating system instead.
Generally, this means that the priority given
to boot devices when your computer is
starting needs to be changed. For example,
your computer might be set to look for
information from your hard drive, and then
to look for information on a  or . To
run Ubuntu from the Live  or , we
want the computer to look for information
from the appropriate device first. Changing
your boot priority is beyond the scope
of this guide. If you need assistance to
change the boot priority, see your computer
manufacturer’s documentation for more
information.

 

language from the list on the le, then cli the buon labeled Try Ubuntu.
Ubuntu will then start up, running straight from the Live .
Figure .: The “Welcome” screen allows
you to choose your language.

Once Ubuntu is up and running, you will see the default desktop. We
will talk more about how to actually use Ubuntu in Chapter : e Ubuntu
Desktop, but for now, feel free to test things out. Open some applications,
ange seings and generally explore—any anges you make will not be
saved once you exit, so you don’t need to worry about accidentally breaking
anything.
When you are ﬁnished exploring, restart your computer by cliing the
“Power” buon in the top right corner of your screen (a circle with a line
through the top) and then select Restart. Follow the prompts that appear on
screen, including removing the Live  and pressing Enter when instructed,
and then your computer will restart. As long as the Live  is no longer in the
drive, your computer will return to its original state as though nothing ever
happened!

Installing Ubuntu
e process of installing Ubuntu is designed to be qui and easy. To help
you get started, we have included step-by-step instructions below, along with
screenshots so you can see how things will look along the way.
At least . of free space on your hard drive is required in order to install
Ubuntu; however,   or more is recommended. is will ensure that you
will have plenty of room to install extra applications later on, as well as store
your own documents, music, and photos.

Alternatively, you can also use your mouse
to double-click the “Install Ubuntu .”
icon that is visible on the desktop when
using the Live . This will start the Ubuntu
installer.
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Geing started
To get started, place the Ubuntu  in your  drive and restart your computer. Your computer should load Ubuntu from the . When you ﬁrst start
from the , you will be presented with a screen asking you whether you
want to ﬁrst try out Ubuntu or install it. Select the language you want to view
the installer in and cli on the Install Ubuntu buon. is will start the
installation process.
If you have an Internet connection, the installer will ask you if you would
like to “Download updates while installing,” and if you would like to “Install
this third-party soware.” e laer option includes the Fludendo MP codec.
Updates and third-party soware installation can be completed at a later time.
e “Welcome” screen will also let you know if you have enough disk
space and if you are connected to a power source (in case you are installing
Ubuntu on a laptop running on baery).

Clicking on the blue underlined release
notes will open a web page containing any
important information regarding the current
version of Ubuntu.

Prepare disk space
is next step is oen referred to as partitioning. Partitioning is the process of
allocating portions of your hard drive for a speciﬁc purpose. When you create
a partition, you are essentially dividing up your hard drive into sections that
will be used for diﬀerent types of information. Partitioning can sometimes
seem complex to a new user; however, it does not have to be. In fact, Ubuntu
provides you with some options that greatly simplify this process. Following
on from the Preparing to install Ubuntu screen, when you cli on the
Forward buon, the next page will show diﬀerent options for installation.
e Ubuntu installer will automatically detect whether you have any existing
operating system installed on your maine. Once done, you will get three
options listed below. If you are installing on a new maine with no operating
system, you will not get the ﬁrst option.
. Install alongside other operating systems.
. Erase and use the entire disk.
. Specify partitions manually (advanced)
Install alongside other operating systems.
If you are a Windows/Mac user and you are trying to install Ubuntu for the
ﬁrst time, oose the Install alongside other operating systems option.
is option will enable you to oose whi operating system you wish to
use when you computer starts. Ubuntu will automatically detect the other
operating system and install Ubuntu alongside it.
For more complicated dual-booting setups, you will need to conﬁgure the partitions manually.

Many people installing Ubuntu for the first
time currently use another operating system
on their computer, such as Windows ,
Windows Vista, Windows , or Mac  .
Ubuntu provides you with the option of
either replacing your existing operating
system altogether, or installing Ubuntu
alongside your existing system. The laer is
called dual-booting. Whenever you turn on
or restart your computer, you will be given
the option to select which operating system
you want to use for that session.

 

Figure .: Choose where you would like to
install Ubuntu.

Erase and use the entire disk
Use this option if you want to erase your entire disk. is will delete any
existing operating systems that are installed on that disk, su as Windows ,
and install Ubuntu in its place. is option is also useful if you have an empty
hard drive, as Ubuntu will automatically create the necessary partitions for
you.
Formaing a partition will destroy any data currently on the partition. Be sure to
ba up any data you want to save before Formaing.

Specifying partitions manually
is option is for more advanced users and is used to create special partitions,
or format the hard drive with a ﬁlesystem diﬀerent to the default one. It can
also be used to create a separate /home partition. is can be very useful in
case you decide to reinstall Ubuntu, as it allows you to format and reinstall
the operating system, whilst keeping all your personal ﬁles and program
seings intact in a separate partition.
Because this is quite an advanced task, we have omied the details from
this edition of Geing Started with Ubuntu. You can see more information
and detailed instructions on partitioning here: https://help.ubuntu.com/
community/HowtoPartition.

Confirm Partition choices and start install
Once you are happy with the way the partitions are going to be set up, cli
the Install Now buon at the boom right to move on. To reduce the time

Ubuntu installs a home folder where your
personal files and configuration data are
located by default. If you choose to have
your home folder on a separate partition,
then in the event that you decide to reinstall
Ubuntu or perform a fresh upgrade to
the latest release, your personal files and
configuration data won’t be lost.
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required for installation, Ubuntu will continue the installation process “in the
baground” while you conﬁgure important user details—like your username,
password, keyboard seings and default timezone.

Where are you?
e next screen will display a world map. Using your mouse, cli your
geographic location on the map to tell Ubuntu where you are. Alternatively,
you can use the drop-down lists underneath the map. is allows Ubuntu to
conﬁgure your system clo and other location-based features. Cli Forward
when you are ready to move on.
Figure .: Tell Ubuntu your location.

Next, you need to tell Ubuntu what kind of keyboard you are using. In
most cases, you will ﬁnd the suggested option satisfactory. If you are unsure
whi keyboard option to select, you can cli the Figure Out Keyboard
Layout buon to have Ubuntu determine the correct oice by asking you
to press a series of keys. You can also manually oose your keyboard layout
from the list of options. If you like, type text into the box at the boom of the
window to ensure you are happy with your selection, then cli Forward to
continue.

Enter your details
Ubuntu needs to know some information about you so it can set up the primary user account on your computer. When conﬁgured, your name will
appear on the login screen as well as the MeMenu, whi we discuss in Chapter : e Ubuntu Desktop.
On this screen you will need to tell Ubuntu:

 

Figure .: Verify that your keyboard layout
is correct.

‣
‣
‣
‣
‣

your real name
what you want to call your computer
your desired username
your desired password
how you want Ubuntu to log you in

Figure .: Setup your user account.

Type in your full name under “Your name?”. e next text ﬁeld is the
name your computer uses, for terminals and networks. You can ange this

Although you can choose your preferred
username and computer name, you are
required to stick with Latin leers, numbers,
hyphens, and dots. You will receive a
warning if non-acceptable symbols or other
characters are entered, and until this is
altered you will be unable to progress to the
next screen.
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to what you want, or keep the predetermined name. Next is your username,
the name that is used for the Me Menu, your home folder, and behind the
scenes. You will see this is automatically ﬁlled in for you with your ﬁrst name.
Most people ﬁnd it easiest to sti with this. However, it can be anged if you
prefer.
Next, oose a password and enter it into the password ﬁeld on the le,
and then type the same password into the password ﬁeld on the right. When
both passwords mat, a strength rating will appear to the right that will
show you whether your password is “too short,” “weak,” “fair,” or “strong.” You
will be able to continue the installation process regardless of your password
strength, but for security reasons it is best to oose a strong one. is is best
aieved by having a password that is at least six aracters long, and is a
mixture of leers, numbers, symbols, and uppercase/lowercase. For extra
security, avoid obvious passwords like your birth date, spouse’s name, or the
name of your pet.

Login Options
Finally, at the boom of this screen you have three options from whi to
oose regarding how you wish to log in to Ubuntu.
‣ Log in automatically
‣ Require my password to log in
‣ Encrypt my home folder
Log in automatically
Ubuntu will log in to your primary account automatically when you start up
the computer so you won’t have to enter your username and password. is
makes your login experience quier and more convenient, but if privacy or
security are important to you, we don’t recommend this option. Anyone who
can physically access your computer will be able to turn it on and also access
your ﬁles.
Require my password to login
is option is selected by default, as it will prevent unauthorized people from
accessing your computer without knowing the password you created earlier.
is is a good option for those who, for example, share their computer with
other family members. Once the installation process has been completed, an
additional login account can be created for ea family member. Ea person
will then have their own login name and password, account preferences,
Internet bookmarks, and personal storage space.

 

Encrypt my home folder
is option provides you with an extra layer of security. Your home folder
is where your personal ﬁles are stored. By selecting this option, Ubuntu will
automatically enable encryption on your home folder, meaning that ﬁles and
folders must be decrypted using your password before they can be accessed.
erefore if someone had physical access to your hard drive (for example, if
your computer was stolen and the hard drive removed), they would not be
able to see your ﬁles without knowing your password.
If you oose this option, be careful not to enable automatic login at a later date.
It will cause complications with your encrypted home folder, and will potentially
lo you out of important ﬁles.

Installation Slideshow
Ubuntu will now ﬁnish installing on your hard drive. As the installation
progresses, a slideshow will give you an introduction to some of the default
applications included with Ubuntu. ese applications are covered in more
detail in Chapter : Working with Ubuntu.
Figure .: The first slide in the installation
slideshow.

Aer approximately twenty minutes, the installation will complete and
you will be able to cli Restart Now to restart your computer and start
Ubuntu. e  will be ejected, so remove it from your  drive and press
Enter to continue.
Wait while your computer restarts, and you will then see the login window
(unless you selected automatic login).
Cli your username and enter your password, then press Enter or cli
Log in. You will then be logged in to Ubuntu and will be presented with your
new desktop!
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Figure .: You are now ready to restart
your computer.

Figure .: The Ubuntu login window.



The Ubuntu Desktop

Understanding the desktop
At ﬁrst glance, you will notice many similarities between Ubuntu and other
operating systems su as Windows or Mac  . is is because they are all
based on the concept of a graphical user interface ()—that is, you use your
mouse to navigate the desktop, open applications, move ﬁles, and perform
most other tasks. In short, things are visually oriented, whi means that it’s
important for you to become familiar with where and what to cli in Ubuntu.

Ubuntu . has an emphasis on “social
from the start” and features social network
integration in the desktop for sites like
Twier and Facebook.

GNOME
All -based operating systems use a desktop environment. Desktop environments encompass many things, su as:
‣
‣
‣
‣

the look and feel of your system
how the desktop is organized
the way the desktop is laid out
how the desktop is navigated by the user

In Linux distributions (su as Ubuntu), there are a number of desktop environments available for use. One of the most popular desktop environments
is called , whi the default in Ubuntu. , , and  are other
popular desktop environments (used in Kubuntu, Xubuntu, and Lubuntu, respectively), although there are many more. Since Ubuntu uses , we will
limit this guide to exploring your  desktop.
When you ﬁrst log in to Ubuntu aer installing it, you will see the 
desktop. Ubuntu is highly customizable, as is the  desktop, but for now
let’s just explore the default layout that is in front of you.
First, you will notice there are two panels—one at the top of your desktop
and one at the boom. A panel is a bar that sits on the edge of your screen
and contains various applets. ese applets provide useful functions su as
running applications, viewing the time, or accessing the main menu.

To read more about other variants of
Ubuntu, refer to Chapter : Learning More.

Everything on a panel is an applet, even the
main menu.

The top panel
Starting from the le, you will see three menu headings—Applications,
Places, and System—followed by two program icons. e ﬁrst of these icons
will open the Firefox web browser (see Chapter : Working with Ubuntu for
more information), and the next will open the Ubuntu Help Center.
On the right side of this panel you will ﬁnd the notiﬁcation area, whi
is similar in function to the “system tray” in Windows, or the “menu extras”

The Ubuntu Help Center is a highly useful
resource. It provides a wealth of information about your Ubuntu system, and is
always at your fingertips by simply clicking
this panel icon (or navigating to System ‣
Help and Support).
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Figure .: The Ubuntu . default desktop.

area on the Mac   menubar. Next to this is the MeMenu, whi will display your username (the name you entered during installation) and is used
to update social network sites like Twier and Facebook as well as set your
Instant Messaging status in Empathy. Finally, on the far right of the panel is
the session menu, whi provides menu options for loing your computer,
logging out, restarting, or shuing down completely.

New notifications of emails and instant
messages appear in the messaging menu
applet. When you have a new message, the
envelope icon will turn green.

The notification area
Inside the notiﬁcation area you will ﬁnd the network indicator, volume adjustment, Bluetooth indicator (if your computer has Bluetooth capability),
messaging, and the date and time. Some applications will also place an icon in
the notiﬁcation area when you open them.
Le-cliing icons in the notiﬁcation area will bring up a list of options
associated with the application. In some cases right-cliing an icon will also
perform another action related to that application. For example, to adjust the
volume, simply le-cli once on the volume icon and a volume slider will
appear. Cli the date and time applet to open a small calendar, and then cli
a speciﬁc date to add a reminder to your calendar through Evolution (see
Chapter : Working with Ubuntu for more information on Evolution).
When the calendar is expanded there is a buon labeled Locations, whi
will open a small world map when clied. Here you can further set up your
location preferences by cliing Edit. In the window that appears, cli Add,
then enter your location in the text ﬁeld. If you live in a major city it may be
on the list already; if not, you can enter your latitude and longitude manually

To remove a panel applet, right-click on it
and select Remove From Panel. To add a
new applet to a panel, right-click in a clear
area on the panel and select Add to Panel.

   

If you don’t know this information try searing online for it. Make sure your
time zone is selected, then cli OK to return to the preferences screen.
Feel free to explore the other options available under the General and
Weather tabs if you like, then cli Close at the boom when you are done.
If weather information is available for your home city, you will now see the
current temperature displayed alongside the date and time in the notiﬁcation
area.

The boom panel
Ubuntu uses most of the boom panel to display a list of all applications or
windows that are currently open. ese appear as horizontal buons whi
can be clied to minimize or restore the corresponding windows (see Managing windows below for more information).
To show the desktop you can press

On the far le of the boom panel is a small icon that resembles a desktop.
is Show Desktop buon will minimize all open windows at once, giving
you clear access to your desktop. is is oen useful when you have many
windows open at once and your desktop becomes cluered. Cliing the
buon again will restore the windows to their original position.
On the right side of the panel you will see some small boxes in a row;
this is the Workspace Switer. By default, Ubuntu . is set up with four
workspaces.
Finally, the icon farthest to the right is the trash, whi performs a similar
function to the Recycle Bin in Windows or the Trash in Mac  . Any ﬁles
you delete are ﬁrst sent to the trash. To see the contents of the trash, cli
on this icon. You can empty it by cliing on the Empty Trash buon in
the window that appears, or alternatively by right-cliing the trash icon
in the boom panel and selecting Empty Trash from the menu. is will
permanently delete any ﬁles or folders that it contains.

The desktop background
In between the top and boom panels is an image that covers the entire desktop. is is the desktop baground or wallpaper and the one you see in front
of you belongs to the default Ubuntu . theme known as Ambiance. To
learn more about customizing your desktop including anging your baground, see the section on Customizing your desktop below.

Managing windows
When you open a program in Ubuntu (su as a web browser or a text editor
—see Chapter : Working with Ubuntu for more information on using applications)—a window will appear on your desktop. If you have used another
operating system before, su as Microso Windows or Mac  , you are

Ctrl+Alt+D

The  desktop environment used in
Ubuntu can provide two or more “virtual
desktops,” or workspaces. Using these
workspaces can reduce cluer by opening
windows on separate desktops, without
needing a separate monitor. For example, in
order to organize your activities you may
have your email open in one workspace
and a text document you are working on in
another. To switch workspaces, simply click
on the boxes in the workspace switcher or
use the keyboard shortcut Ctrl+Alt+Left
arrow or Ctrl+Alt+Right arrow to switch
workspaces quickly.
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probably familiar with the concept of a “window”—the box that appears on
your screen when you start a program. In Ubuntu, the top part of a window
(the titlebar) will have the title of the window in the center, and three buons
in the top le corner. From le to right, these buons close, minimize, and
maximize the window. Additionally, you can right-cli anywhere on the
titlebar for a list of other window management options.

Closing, maximizing, restoring, and minimizing windows
Figure .: The close, minimize, and maximize buons are on the top-le corner of
windows.

To close a window, cli on the “×” in the upper le corner of the window
—this will be the ﬁrst buon on the le-hand side. Immediately to the right
of this is a downward-pointing arrow that is used to minimize the window to
the boom panel of your desktop. Once minimized the window will no longer
be visible, but its corresponding buon in the boom panel will remain,
indicating the program is still running in the baground. Cliing this buon
will restore the window to its original position. Finally, the right-most buon
of this group will maximize the window, making it ﬁll the entire screen.
Cliing this buon again will return the window to its original size.

Moving and resizing windows
To move a window around the workspace, place the mouse pointer over the
window’s titlebar, then cli and drag the window while continuing to hold
down the le mouse buon. To resize a window, place the pointer on an edge
or corner of the window so that it turns into a larger arrow, the resize icon.
You can then cli and drag to resize the window.

You can also move a window by holding the
Alt+F7 keys and dragging the window

Switching between open windows
ere are at least three ways in Ubuntu to swit between open windows in
a workspace. You can ﬁnd the window on the boom panel taskbar and cli
to bring it up on the screen, or you can use Alt+Tab to select the window you
wish to work on. Hold down the Alt key, and keep pressing the Tab buon
until the window you’re looking for appears in the popup. If the window is
visible on your screen, you can cli any portion of it to raises it above all
other windows.

Using the Applications menu
ere are three menu headers in the top panel. Let’s take a look at these in
more detail, starting with the Applications menu.

You may find that there are applications
in the Applications menu that you don’t
use frequently, or just don’t want to be
displayed on the menu. To hide those
applications (without deleting the actual applications), click on System ‣ Preferences ‣
Main Menu. Find the applications in the
right panel that you want to hide from the
menu, and deselect them in the “Show”
column.

   

Accessories
e Accessories sub-menu has many applications that are suited for productivity, including Calculator and Tomboy Notes.
Other applications in Accessories include the gedit Text Editor (similar to
Windows’ Notepad and Mac  ’s TextEdit), Sear for Files (we’ll discuss
that later), and Take Screenshot, whi allows you to take a picture of your
desktop screen.

See Chapter : Working with Ubuntu
for more information about the included
applications.
Another way to take a screenshot is to press
PrtSc.

Games
Ubuntu has several games built in for your entertainment. If you enjoy card
games, e out AisleRiot Solitaire. Perhaps you’re looking for more of a
allenge: in that case, there’s gBrainy and Sudoku. e Games menu also
includes Mahjongg, Mines (similar to Windows’ Minesweeper game) and
adrapassel (similar to Tetris).

Graphics
Under the Graphics sub-menu, you’ll ﬁnd the Shotwell photo manager where
you can view, edit and share pictures you’ve downloaded from your camera.
OpenOﬃce.org Drawing allows you to create images using the OpenOﬃce.org
suite, and Simple Scan is a program for scanning images and documents from
your scanner.

Internet
e Internet sub-menu is where you will ﬁnd the Firefox web browser and
the Empathy Instant Messenger client to allow you to talk to your friends
and family. is menu also includes the Gwibber Social Client, a full featured
micro blogging client (Twier, Identi.ca, Facebook, etc.)

Instant messaging () is a means of textbased communication where you can hold
a conversation with someone over the
Internet, instantly.

Oﬀice
e Oﬃce sub-menu is where you will ﬁnd most of the OpenOﬃce.org suite
to help you create formal documents, presentations, or spreadsheets. Also
under Oﬃce is the Evolution email client and an online dictionary. e full
OpenOﬃce.org suite installed in Ubuntu by default consists of:
‣
‣
‣
‣

OpenOﬃce.org Word Processor
OpenOﬃce.org Spreadsheet
OpenOﬃce.org Presentation
OpenOﬃce.org Drawing (located under the Graphics sub-menu)

Sound and video
e Sound and Video sub-menu has applications for working with multimedia, su as:

To learn more about OpenOﬀice.org and to
get help with using the OpenOﬀice.org suite
of applications, visit http://openoffice.org.



‣
‣
‣
‣
‣

    .

Brasero disc burner
Totem movie player
Pitivi video editor
Rhythmbox music player
Sound Recorder

More information on all of these applications can be found in Chapter :
Working with Ubuntu.

Ubuntu Soware Center
At the very boom of the Applications menu is the Ubuntu Soware Center. is application gives you access to a library of soware that you can
download. When you open the Ubuntu Soware Center, the main screen is
similar to your Applications menu, for easy searing. If you know the name
of the program you’re looking for, just type the name into the sear box in
the top right. e Ubuntu Soware Center keeps tra of applications that are
installed on your computer. If you’re simply curious as to what is available,
you can explore the soware available using the categories listed on the le
side of the window.

Learn more about the Ubuntu Soware
Center in Chapter : Soware Management.

Using the System menu
e System menu, located on the top panel, contains two important submenus. ese sub-menus, Preferences and Administration, allow you to
make modiﬁcations to Ubuntu’s appearance, as well as the way it functions.
rough the System menu, you can also open the Ubuntu Help Center (Help
and Support), ﬁnd out more about your  desktop environment (About
GNOME), and ﬁnd out more about Ubuntu in general (About Ubuntu).

See Chapter : Hardware for more information on seing up Ubuntu.

Preferences
You can use the Preferences sub-menu to modify the appearance of the
desktop and windows, assign a default printer, designate keyboard shortcuts,
ange the entries listed in the Applications menu, edit network connections,
and ange mouse seings, among other options.

Administration
e Administration sub-menu contains applications you can use to monitor
computer performance, ange disk partitions, activate third-party drivers,
manage all installed printers, and manage how your computer receives updates from Ubuntu. is sub-menu also has the Synaptic Paage Manager
for locating and downloading soware paages. is is a more tenical
alternative to Ubuntu Soware Center and should be used by power users.

Most of the applications in the System ‣
Administration menu will prompt you to
enter your user password when you launch
them. Some applications will require you
to click a buon to unlock it. Press this
buon, and enter your password. Aer
entering your password you gain increased
privileges. This is a security feature to make
sure that only authorized people are allowed
to change system seings. To learn more
about security in Ubuntu, see Chapter :
Advanced Topics.

   

Browsing files on your computer
ere are two ways to locate ﬁles on your computer. You can use the Sear
for Files tool in the Applications ‣ Accessories. You can also use the Places
menu on the top panel. See the section below about the Nautilus ﬁle browser
for more details.

Places
e Places menu holds a list of commonly used folders (su as Documents,
Music, Downloads, and the Home Folder). You can also browse the disks
on your computer by cliing Computer in this menu. If you set up a home
network, you will ﬁnd a menu item to access shared ﬁles/folders. You can also
access the Sear for Files tool from the Places menu, as well as browse a list
of recently opened documents.

Your home folder
e home folder is where ea user’s personal ﬁles are located. When you
installed Ubuntu, you entered a name to set up your user account. at same
name is assigned to your home folder. When you open your personal folder,
you will see that there are several folders inside: Desktop (whi contains any
ﬁles that are visible on the desktop), Documents, Downloads, Music, Pictures,
Public, Templates, and Videos.
You will also see a link named Examples. Double-cli on that link to open
a folder containing example documents, spreadsheets, and multimedia ﬁles.
You will not be able to edit them. If you want to edit them move them to you
home folder.

You should open the example content to see
how diﬀerent types of files are displayed in
Ubuntu.

Nautilus file browser
Just as Windows has Windows Explorer and Mac   has Finder to browse
ﬁles and folders, Ubuntu uses the Nautilus ﬁle browser by default. We will
now look at the features oﬀered in Nautilus.

The Nautilus file browser window
When you open a folder on the desktop or from the Places menu, the Nautilus
ﬁle browser window opens up. e standard browser window contains the
following features:
‣ Menubar: e menubar is located at the top of the window. ese menus
allow you to modify the layout of the browser, navigate, bookmark
commonly used folders and ﬁles, and view hidden folders and ﬁles.
‣ Toolbar: e toolbar has tools for navigation and a tool to make the contents of the window larger or smaller. A drop-down list gives you the

If you bookmark a folder, it will appear in
the Places menu.
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option of switing the view from Icon View to List View or Compact
View. e sear icon (whi looks like a magnifying glass) opens a ﬁeld
so you can sear for a ﬁle by name.
‣ Additional Navigation Tools: Just below the toolbar, you will see a representation of where you are currently browsing. is is similar to the history function of most browsers; it keeps tra of where you are and allows
you to batra if necessary. You can cli on the locations to navigate
ba through the ﬁle browser.
‣ Le Pane: e le pane of the ﬁle browser has shortcuts to commonlyused folders. When you bookmark a folder, it appears in the le pane.
No maer what folder you open, the le pane will always contain the
same folders. is le pane can be anged to display diﬀerent features by
cliing the down arrow beside “Places” near the top.
‣ Central Pane: e largest pane shows the ﬁles and folders in the directory
that you are currently browsing.

If you start typing a location starting with
a / character, Nautilus will automatically
change the navigation buons into a text
field labeled Location. It is also possible to
convert the navigation buons into a text
field by pressing Ctrl+L.

Figure .: Nautilus file manager displaying
your home folder.

Navigating between directories
To navigate between directories, use the bookmarks in the le pane of the
Nautilus ﬁle browser. You can also retrace your steps by cliing on the name
of a folder where it is listed just below the navigational icons. Double-cliing
on a visible directory will cause you to navigate to it in Nautilus.

   

Opening files
To open a ﬁle, you can either double-cli on its icon or right-cli and select
Open With (program).

Creating new folders
To create a new folder from within Nautilus cli File ‣ Create Folder, then
name the folder that appears by replacing the default “untitled folder” with
your desired label (e.g., “Personal Finances”). You can also create a new folder
by pressing Ctrl+Shift+N, or by right-cliing in the ﬁle browser window
and selecting Create Folder from the popup menu (this action will also work
on the desktop). If you wish to hide certain folders or ﬁles, place a dot (.) in
front of the name (e.g., “.Personal Finances”). In some cases it is impossible
to hide ﬁles and folders without preﬁxing them with a dot. In Nautilus these
folders can be hidden by creating a .hidden ﬁle. Open the ﬁle and type in the
name of the ﬁle(s) or folder(s) you wish to hide. Make sure that ea ﬁle or
folder is on a separate line. When you open Nautilus the folder will no longer
be visible.

Note that you can easily view hidden files
by clicking View ‣ Show Hidden Files, or
alternatively by pressing Ctrl+H. Hiding
files with a dot (.) is not a security measure
—instead it provides a way of keeping your
folders organized and tidy.

Copying and moving files and folders
You can copy ﬁles or folders in Nautilus by cliing Edit ‣ Copy, or by rightcliing on the item and selecting Copy from the popup menu. When using
the Edit menu in Nautilus, make sure you’ve selected the ﬁle or folder you
want to copy ﬁrst (by le-cliing on it once).
Multiple ﬁles can be selected by le-cliing in an empty space (i.e., not
on a ﬁle or folder), holding the mouse buon down, and dragging the cursor
across the ﬁles or folders you want. is “cli-drag” move is useful when you
are selecting items that are grouped closely together. To select multiple ﬁles
or folders that are not positioned next to ea other, hold down the Ctrl key
while cliing on ea item individually. Once multiple ﬁles and/or folders
are selected you can use the Edit menu to perform actions just like you would
for a single item.When one or more items have been “copied,” navigate to the
desired location then cli Edit ‣ Paste (or right-cli in an empty area of the
window and oose Paste) to copy them to the new location.
While the copy command can be used to make a duplicate of a ﬁle or folder
in a new location, the cut command can be used to move ﬁles and folders
around. at is, a copy will be placed in a new location, and the original will
be removed from its current location.
To move a ﬁle or folder, select the item you want to move then cli Edit ‣
Cut. Navigate to your desired location, then cli Edit ‣ Paste. As with the
copy command above, you can also perform this action using the right-cli
menu, and it will work for multiple ﬁles or folders at once. An alternative

You can also use the keyboard shortcuts
Ctrl+X, Ctrl+C and Ctrl+V to cut, copy and
paste (respectively) files and folders.

When you “cut” or “copy” a file or folder,
nothing will happen until you “paste” it
somewhere. Paste will only aﬀect the most
recent item that was cut or copied.

In the Nautilus Edit menu, you will also
find the Copy To and Move To buons.
These can be used to copy or move items to
common locations, and can be useful if you
are using panes (see below). Note that it is
unnecessary to use Paste when using these
options.
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way to move a ﬁle or folder is to cli on the item, and then drag it to the new
location.

Using multiple tabs and multiple Nautilus windows
Opening multiple Nautilus windows can be useful for dragging ﬁles and
folders between locations. e option of tabs is also available in Nautilus,
as well as the use of panes. When browsing a folder in Nautilus, to open a
second window select File ‣ New Window or press Ctrl+N. is will open a
new window, allowing you to drag ﬁles and folders between two locations.
To open a new tab, cli File ‣ New Tab or press Ctrl+T. A new row will
appear above the space used for browsing your ﬁles containing two tabs—both
will display the directory you were originally browsing. You can cli these
tabs to swit between them, and cli and drag ﬁles or folders between tabs
the same as you would between windows. You can also open a second pane
in Nautilus so you can see two locations at once without having to swit
between tabs or windows. To open a second pane, cli View ‣ Extra Pane, or
press F3 on your keyboard. Again, dragging ﬁles and folders between panes is
a qui way to move or copy items.

When dragging items between Nautilus
windows, tabs or panes, a small symbol will
appear over the mouse cursor to let you
know which action will be performed when
you release the mouse buon. A plus sign
(+) indicates you are about to copy the item,
whereas a small arrow means the item will
be moved. The default action will depend
on the locations you are using.

Searching for files on your computer
Earlier, we mentioned that you can sear for ﬁles on the computer by using
the Sear for Files feature on the Places menu in the top panel. You can also
use the Nautilus browser to sear for ﬁles, as explained above.

Customizing your desktop
Now that you’ve been introduced to the  desktop environment, let’s
take a look at customizing some of its features, su as modifying the behavior of your panels, or anging the look and feel of your desktop.

Panels
e panels (currently siing at the top and boom of your screen) can be
moved from their default positions to the sides of the screen, set to hide
from view when not in use, and can ange color. To access these features,
right-cli the panel you want to modify and select Properties from the popup menu. e General tab has options to autohide, position the panel, and
ange the panel size (width).
Use the Orientation drop-down box to select where you want the panel to
be located, and underneath this you can set the desired width (in pixels).
By default, a panel covers the entire length of the desktop. To ange that,
you can deselect the Expand option. e panel will then shrink so that it is
just long enough to accommodate any applets or program launers that are

Search for files quickly by pressing Ctrl+F
in Nautilus and then typing what you want
to find.

   

currently siing in it. Tiing the Autohide buon will cause your panel to
“fold” up into the edge of the screen when you are not using it, and remain
hidden until you move your mouse cursor ba to that screen edge.
An alternative way of hiding the panel is to do so manually. Cliing on
Show hide buttons will add a buon to ea side of the panel that can be
used to hide it from view. By default these buons will display directional arrows; however, you can select the Arrows on hide buttons option to remove
the arrows and just have plain buons. Cliing one of these hide buons on
the panel will slide it across the screen and out of view, leaving just the opposite hide buon in sight whi you can cli to bring it ba. e Baground
tab in the “Panel Properties” window allows you to ange the appearance of
the panel. By default, this is set to None (use system theme), meaning that
your desktop theme will dictate the appearance of the panel (we will look
at how to ange your desktop theme below). If you prefer, you can oose
your own panel color by selecting the Solid color buon, then opening the
color select window. You can also set the panel transparency using the slider.
Alternatively, you can cli the Baground image buon if you have an
image or paern stored on your computer that you would like to use as your
panel baground. Use the ﬁle selector to locate the baground image in your
computer, then cli Open to apply the ange.

By default, Ubuntu requires that you
maintain at least one panel on the desktop.
If you prefer a Microso Windows feel, a
panel at the boom of the desktop can be
set to start applications as well as select
between open windows. Alternatively, if
you prefer a Mac   look you can keep
a panel at the top and add an applications
dock such as Docky, Avant Window
Navigator (), or Cairo-Dock. These are
all available in the Ubuntu Soware Center,
which is discussed further in Chapter :
Soware Management.

Adding applets
Ubuntu provides a selection of applets that can be added to any panel. Applets
range from the informative to the fun, and can also provide qui access to
some tasks. To add an applet, right-cli on a panel then select Add to Panel…
from the popup menu. A window will appear with a list of available applets,
whi can then be dragged to an empty space on a panel. You may want
to spend some time exploring the diﬀerent ones available—they can easily
be removed from your panel by right-cliing on the applet and selecting
Remove From Panel.
To reposition an existing applet, right-cli on it and select Move. Move
your mouse cursor to the desired location (this can even be a diﬀerent panel)
and the applet will follow, then le-cli to drop it into place.
e “Add to Panel…” window can also be used to add additional application
launers to your panel, similar to the Firefox launer that sits to the right of
the System menu. To add a new one, double-cli on Application Launer…
near the top of the window. Here you can navigate through your applications
and drag them to your panel to create a new launer, just as you did to add
an applet previously. Program launers can also be removed and repositioned
through their right-cli menu.

Some applets will be locked and can’t be
moved. Right-click on them and deselect the
“Lock to Panel” check box.

You can also add program launchers to a
panel by dragging them directly from the
Applications menu, in the le of the top
panel.
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Workspaces
To modify your workspaces, right-cli on the workspace switer applet (by
default this is on the right side of the boom panel, just to the le of the Trash
applet) and select Preferences. In the window that appears you can oose
how many workspaces you want in total, and whether these will be displayed
on the panel in one or more rows. You can also rename ea workspace, and
have the names displayed in the panel applet. If you prefer, you can also
oose to just have the workspace you are currently using displayed in the
panel. In this case, you can still ange between workspaces by moving the
mouse over the workspace switer and scrolling the mouse wheel.

Appearance
You can ange the baground, fonts, and window theme to further modify
the look and feel of your desktop. To begin, open the Appearance Preferences
by navigating to System ‣ Preferences ‣ Appearance in the top panel.
Theme
e “Appearance Preferences” window will initially display the eme tab
when it opens. Here you can select a theme that will control the appearance
of your windows, buons, scroll bars, panels, icons, and other parts of the
desktop. e “Ambiance” theme is used by default, but there are seven other
themes you can oose from. Just cli once on the theme you want to try.
e theme will ange immediately.
You can download additional themes by cliing the “Get More emes
Online” link at the boom of this window. Your web browser will open and
take you to http://art.gnome.org/themes/, where you can download new
themes from a large selection. Once you have downloaded a theme, locate
the ﬁle on your computer (using Nautilus) and drag it across to the emes
window. is will add it to your list of available themes, and a window will
appear asking whether you want to apply the anges immediately.
You can also customize any theme to your liking by selecting it then cliing the Customize… buon underneath. Here you can mix elements of different themes su as icons, mouse pointers, buons, and window borders to
create your own unique look.
Desktop background
Cli the Baground tab in the Appearance Preferences window to ange
the desktop baground. Here you will see Ubuntu’s default selection of
bagrounds. To ange the baground simply cli the picture you would
like to use. You’re not limited to this selection though. To use one of your own
pictures, cli the Add… buon, and navigate to the image you want. Double-

You can also change the background by
right-clicking on the desktop and selecting
Change Desktop Background from the
pop-up menu.

   

Figure .: You can change the theme in the
Theme tab of “Appearance Preferences”.

cli it, and the ange will take eﬀect immediately. is image will also then
be added to your list of available bagrounds.
If you are aer a larger selection of desktop bagrounds, cli the “Get
More Bagrounds Online” link at the boom of the Appearance Preferences
window. is link will open your web browser, and direct you to the http://
art.gnome.org/backgrounds website.
Fonts
You can also ange the fonts used throughout your desktop through the
Appearance Preferences window by cliing on the Fonts tab. You can individually set the font style and size for applications, documents, desktop items,
window titles, and for anything using ﬁxed width fonts. e Rendering section at the boom of the Fonts tab gives you four options for anging the
way that fonts are drawn on your screen. Changing these may improve the
appearance of text on diﬀerent types of monitors.

Screensaver
Ubuntu oﬀers a selection of screensavers. By default, a blank screen will be
displayed aer a short period of inactivity. To select a diﬀerent screensaver,
cli on the System menu in the top panel, then Preferences ‣ Screensaver.
is will open the “Screensaver Preferences” window, with the available
screensavers listed on the le. When you select a screensaver, you will see
a mini-preview in the window, or you can see how it will look on your full
screen by cliing the Preview buon. e le and right arrow buons at the
top allow you to scroll through the diﬀerent screensavers without leaving the



    .

full screen preview. To return to the Screensaver Preferences window, cli
the Leave Fullscreen buon at the top of the screen.
Make sure that the Activate screensaver when computer is idle option
is selected if you want to enable the screensaver. e slider can be adjusted
to set the duration of inactivity before the screensaver appears. Once it does,
you can resume working on your computer by pressing any key or by moving
your mouse. For added security, you can also select the Lo screen when
screensaver is active option. In this case, Ubuntu will ask you for your login
password when you return to the computer.

Accessibility
Ubuntu has built-in tools that make using the computer easier for people
with certain physical limitations. You can ﬁnd these tools by opening the
System menu, then selecting Preferences ‣ Assistive Tenologies. You can
adjust keyboard and mouse seings to suit your needs through the “Assistive
Tenologies Preferences” window by cliing on the Keyboard Accessibility
or Mouse Accessibility buons.
Figure .: Assistive Technologies allows
you to enable extra features to make it easier
to use your computer.

Other assistive technologies
Orca is another useful tool for persons with visual impairments, and comes
preinstalled on Ubuntu. To run Orca, press Alt+F2 and type orca into the
command text ﬁeld. en press Enter or cli Run. Orca’s voice synthesizer
will activate and assist you through the various options su as voice type,
voice language, Braille, and screen magniﬁcation. Once you have ﬁnished
selecting your seings, you will need to log out of the computer (Orca will
oﬀer to do this for you). When you log ba in, the Orca seings you ose
will automatically run every time you use your computer.
In addition to these options, selecting high-contrast themes and larger
on-screen fonts can further assist those with vision diﬃculties.

   

Managing your computer
When you have ﬁnished working on your computer, you can oose to log
out, suspend, restart, or shut down through the session menu on the far right
side of the top panel. You can also quily access these options by pressing the
Ctrl+Alt+Del keys.

Logging out
Logging out will leave the computer running but return you to the login
screen. is is useful for switing users, su as when a diﬀerent person
wishes to log in to their account, or if you are ever instructed to “log out and
ba in again.” You should save your work before logging out.

Suspend
To save energy, you can put your computer into suspend mode, whi will
save its current condition and allow you to start more quily while remaining on but using very lile energy. Suspending the computer spins down the
hard disk and saves your session to memory, so it is very qui to suspend and
resume from suspension.

Hibernate
Hibernate is similar to suspend, except that instead of saving your session to
memory, hibernate will save your session to the hard disk. is takes a lile
longer, but with the added beneﬁt that hibernation uses no power while it is
in a hibernated state.

Rebooting
To reboot your computer, select Restart from the session menu.

Shut down
To totally power down your computer, select Shut Down from the session
menu.

Other options
From the session menu, you can also select Lo Screen to require a password
before using the computer again—this is useful if you need to leave your
computer for some duration. You can also use the session menu to set up a
guest session for a friend to try Ubuntu, or to swit users to log into another
user account without closing your applications.

You can lock your screen quickly by using
the keyboard shortcut Ctrl+Alt+L. Locking
your screen is recommended if you move
away from your computer for a short
amount of time.
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Geing help
Ubuntu, just like other operating systems, has a built-in help reference, called
the Ubuntu Help Center. To access it, cli on the help icon in the top panel.
You can also access it by cliing Help and Support in the System menu.

Many applications have their own help
which can be accessed by clicking the Help
menu within the application window.

Figure .: Clicking the blue help icon
in the top panel (just to the right of the
System menu and the Firefox icon) will
open Ubuntu’s built-in system help.
Figure .: The built-in system help provides
topic-based help for Ubuntu.

If you can’t ﬁnd an answer to your question in this manual or in the
Ubuntu Help Center, you can contact the Ubuntu community through the
Ubuntu Forums (http://ubuntuforums.org). Many Ubuntu users open an account on the forums to receive help, and in turn provide support to others
as they gain more knowledge. Another useful resource is the Ubuntu Wiki
(https://wiki.ubuntu.com), a website maintained by the Ubuntu community.

We encourage you to check any information you find on other websites with
multiple sources when possible, but only
follow directions if you understand them
completely.



Working with Ubuntu

Geing online
If you are in a location with Internet access, you will want to make sure
you are connected in order to get the most out of your Ubuntu operating
system. is section of the manual will help you e your connection and
conﬁgure it where necessary. Ubuntu can connect to the Internet using a
wired, wireless, or dialup connection. It also supports some more advanced
connection methods, whi we will brieﬂy discuss at the end of this section.
A wired connection refers to when your computer is physically connected
to a router or an Ethernet port with a cable. is is the most common connection for desktop computers.
A wireless connection is when your computer is connected to the Internet
via a wireless radio network, also known as Wi-Fi. Laptop computers commonly use Wi-Fi due to portability, making it easy to access the Internet from
diﬀerent rooms in the house or when traveling.
In order to connect wirelessly, you must be in a location with a working
wireless network. To have your own, you will need to purase and install a
wireless router or access point. Some locations may already have a publicly
accessible wireless network available.
A dialup connection is when your computer uses a modem to connect to an
Internet service provider through your telephone line.

NetworkManager
In order to connect to the Internet in Ubuntu, you need to use the NetworkManager utility. NetworkManager allows you to turn all networking on or oﬀ,
and helps you manage your wired, wireless, and other connections.

If you are unsure whether your computer
has a wireless card, check with your
manufacturer.

Figure .: NetworkManager will display
this icon in the top panel when you are
connected to a wired network.

You can access all the functions of NetworkManager using its icon in the
top panel. is icon may look diﬀerent depending on whether you currently
have a working connection, and whether the connection is wired or wireless.
If you are unsure, try hovering your mouse over the icon until a short description appears near the cursor. is will read “Wired network connection
‘Auto eth0’ active” (for example) if you have a working wired connection, or
otherwise something else related to networking or connections su as “No
connection” or “Networking disabled.”
Cliing this icon will bring up a list of network connections that are
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Figure .: Here you can see the currently
active “auto eth0” connection listed in the
NetworkManager menu.

available to you. If you are currently connected to the Internet, the name of
this connection will be highlighted in bold.
Figure .: This is the menu when you
right-click the networking icon.

You can also right-cli on the NetworkManager icon. is will open a
menu allowing you to enable or disable networking, view tenical details
about your current connection, or edit all connection seings. In the image
above, the e box next to “Enable Networking” is currently selected; you
can deselect it to disable all network connections. is may be useful if you
need to shut oﬀ all wireless communication, su as when in an airplane.

Establishing a wired connection
If you have an Ethernet cable running from a wall soet, a router, or some
other device, then you will want to set up a wired network connection in
Ubuntu.
In order to connect with a wired connection, you need to know whether
your network connection supports . is stands for “Dynamic Host
Conﬁguration Protocol,” and is a way for computers on your network to
automatically receive conﬁguration information from your Internet service
provider (). is is usually the quiest and easiest way of establishing
a connection between your computer and your  in order to access the
Internet, although some s may provide what is called a static address
instead. If you are unsure whether your  supports , you may wish to
contact their customer service line to e. ey will also be able to provide
you with information on your static address if one has been allocated to you
(in many cases s only allocate static addresses to customers upon request).
Automatic connections with DHCP
If your network supports , you may already be set up for online access.
To e this, cli on the NetworkManager icon. ere should be a “Wired

Are you already online? If the NetworkManager icon in the top panel shows a
connection, then you may have successfully
connected during the installation process. If
so, you do not need to follow the rest of this
section.

  



Network” heading in the menu that is displayed. If “Auto eth0” appears directly underneath, then your computer is currently connected and probably
already set up correctly for . If “disconnected” appears in gray underneath the wired network section, look below to see if an option labeled “Auto
eth0” appears in the list. If so, cli on it to aempt to establish a wired connection.
To e if you are online, right-cli on the NetworkManager icon in the
top panel and select the Connection Information option.
Figure .: This window displays your 
address and other connection information.

You should see a window showing details about your connection. If your 
address is displayed as ... or starts with ., then your computer was
not successfully provided with an address through . If it shows another
address, it is most likely that your connection was automatically conﬁgured
correctly. To test out your Internet connection, you may want to open the
Firefox web browser to try loading a web page. More information on using
Firefox can be found later in this apter.
If you are still not online aer following these steps, you may need to try
seing up your Internet conﬁguration manually, using a static  address.
Manual configuration with static addresses
If your network does not support , then you need to know a few items of
information before you can get online.
‣ An  address is a unique address used for identifying your computer on
the Internet. When connecting through  this is likely to ange at
times. However, if your  has provided you with a static address then
it will not. An  address is always given in the form of four numbers
separated by decimal points, for example, ....
‣ e network mask tells your computer how large the network is that it belongs to. It takes the same form as an  address, but is usually something
like ...
‣ e gateway is the  address at your ’s end. It helps your computer

An Internet Protocol () address is a
numerical label assigned to devices on a
computer network. It is the equivalent of
phone numbers for your house and allows
your computer to be uniquely identified so
you can access the Internet and share files
with others.

To access the “Connection Information”
window, you will need to make sure that
networking is enabled. Otherwise this
option will be gray and you will not be
able to select it through the right-click
menu of the NetworkManager applet.
To enable networking, right-click on the
NetworkManager applet and select Enable
Networking from the popup menu.
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connect or “talk” with their network, whi acts as a “gateway” between
your computer and the Internet.
‣  servers are one or more  addresses of “Domain Name System”
servers. ese servers convert standard web addresses (like http://www.
ubuntu.com) into  addresses su as .... is step allows your
computer to “ﬁnd” the correct web site when you type in the web address
you wish to visit. A minimum of one  server is required, up to a maximum of three. e additional ones are used in case the ﬁrst one fails.
To manually conﬁgure a wired connection, right-cli on the NetworkManager icon and select Edit Connections. Make sure you are looking at the
Wired tab inside the “Network Connections” window that is displayed.
e list may already have an entry su as “Auto eth0,” or a similar name.
If a connection is listed, select it and then cli the Edit buon. If no connection is listed, cli the Add buon instead.
If you are adding a connection, you ﬁrst need to provide a name for the
connection so you can distinguish it from any others that are added later. In
the “Connection name” ﬁeld, oose a name su as “Wired connection .”

If you do not already have these seings,
you will need to consult your network
administrator or  customer support to
receive them.

Figure .: In this window you can manually
edit a connection.

To set up the connection:
. Under the connection name, make sure that the Connect automatically
option is selected.
. Swit to the v Settings tab.
. Change the Method to “Manual.”
. Cli on the Add buon next to the empty list of addresses.
. Type in your  address in the ﬁeld below the Address header.
. Cli to the right of the  address, directly below the Netmask header,
and type in your network mask. If you are unsure of your network mask,
“...” is the most common.
. Cli to the right of the network mask, directly below the Gateway header,
and type in the address of your gateway.

  

. In the  servers ﬁeld below, type in the addresses of your  server. If
your network has more than one  server, enter them all, separated by
spaces or commas.
. Cli Apply to save your anges.
A  address is a hardware address for your computer’s network card, and
entering it is sometimes important when using a cable modem connection or
similar. If you know the  address of your network card, this can be entered in
the appropriate text ﬁeld in the Wired tab of the editing window.

When you have returned to the Network Connections screen, your newlyadded connection should now be listed. Cli Close to return to the desktop.
If your connection is conﬁgured correctly, the NetworkManager icon should
have anged to show an active connection. To test if your connection is
properly set up, refer to the instructions above for eing a  connection.

Wireless
If your computer is equipped with a wireless (Wi-Fi) card and you have a
wireless network nearby, you should be able to set up a wireless connection in
Ubuntu.
Connecting to a wireless network for the first time
If your computer has a wireless network card, you should be able to connect
to a wireless network. Most laptop and netbook computers have a wireless
network card.
Ubuntu is usually able to detect any wireless networks that are available
within range of your wireless card. To see a list of wireless networks, cli
on the NetworkManager icon. Under the “Wireless Networks” heading, you
should see a list of available wireless networks. Ea network will be shown
with a name on the le, and a signal meter on the right. A signal meter looks
like a series of bars—the more bars that are ﬁlled in, the stronger the connection will be.
A wireless network may be open to anyone to connect, or may be protected with network security. A small padlo will be displayed next to the
signal meter of any wireless networks that are protected. You will need to
know the correct password in order to connect to these.
To connect to a wireless network, select the desired network’s name from
the list. is will be the name that was used when the wireless router or
access point was installed. If you are in a workplace or a location with a
publicly accessible wireless network, the network name will usually make it
easy to identify.
If the network is unprotected (i.e., the network signal meter does not
display a padlo), a connection should be established within a few seconds.

To improve speed and reliability of your
connection, try to move closer to your
router or access point.
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e NetworkManager icon in the top panel will animate as Ubuntu aempts
to establish a connection. If it connects successfully the icon will ange
to display a signal meter. A notiﬁcation message in the upper right of your
screen will also appear, informing you that a connection was established.
If the network is secured, Ubuntu will display a window called “Wireless
Network Authentication Required” once it tries to connect. is means that a
password is required in order to connect.
Figure .: Type in your wireless network
passphrase.

If you know the password, enter it in the Password ﬁeld, and then cli
Connect. As you type your password, it will be obscured to prevent others
from seeing it. If you prefer, you can select the Show password option to see
the password as you type.
Aer you cli the Connect buon, the NetworkManager icon in the top
panel will animate as it tries to connect to the network. If you have entered
the correct password, a connection will be established and the NetworkManager icon will ange to show signal meter bars. Again, Ubuntu will display
a pop up message in the upper right of your screen informing you that a connection was established.
If you entered the wireless network’s password incorrectly, NetworkManager will aempt to establish a connection then return to the “Wireless
Network Authentication Required” window. You can aempt to enter the
correct password again, or cli Cancel to abort your connection. If you do
not know the password to the network you have selected, you will need to get
the password from the network administrator.
Once you have successfully established a wireless network connection,
Ubuntu will store these seings (including the network password) in order
to make it easier to connect to the same wireless network in future. You
may also be prompted to select a keyring password here. e keyring stores
network and other important passwords in the one place, so you can access
them all in future by just remembering your keyring password.
Connecting to a saved wireless network
If you have previously successfully established a wireless connection, that
connection’s password will be saved on your computer. is will allow you to
connect to the same network without having to re-enter the password.

Select the Show Password option to make
sure you haven’t made a mistake when
entering the password.

  



In addition, Ubuntu will automatically try to connect to a wireless network
within range if it has its seings saved. is will work for both open and
secured wireless networks.
If you have many saved wireless networks that are in range, Ubuntu may
oose to connect to one of them, while you may prefer to connect to another.
In this case, cli on the NetworkManager icon. You should see a list of wireless networks in range, along with their signal meters. Cli on your desired
network.
If the password and other seings have not anged, Ubuntu will connect
to the wireless network you ose. If the password has anged, Ubuntu will
open the “Wireless Network Authentication Required” window. In this case,
follow the instructions in the previous section.
Connecting to a hidden wireless network
In some circumstances, you may need to connect to a hidden wireless network. ese hidden networks do not broadcast their names, whi means that
they will not show up in the list of wireless networks in the NetworkManager
menu. In order to be able to connect to a hidden network, you will need to get
its name and security seings from your network administrator.
To connect to a hidden network:
. Cli on the NetworkManager icon in the top panel.
. Choose the Connect to Hidden Wireless Network option. Ubuntu should
open the “Connect to Hidden Wireless Network” window.
. By default, the Connection ﬁeld should show “New…”—you can leave this
unanged.
. In the Network name ﬁeld, enter the name of the wireless network. is
name is also known as a . Please enter the network name exactly as it
was given to you.
. In the Wireless security ﬁeld, select one of the options. If the network is
open, leave this ﬁeld as “None.” If you do not know the correct seing for
the network you will not be able to connect to the hidden network.
. Cli on the Connect buon.
e rest of the process should work exactly as in the section on the initial
connection to wireless networks. Once set up according to the instructions
above, the hidden network should show up in the list of saved networks.
Disabling and enabling your wireless network card
Wireless access in Ubuntu is enabled by default if you have a wireless network card in your computer. In certain cases, for example on airplanes, you
may need or be required to turn your wireless radio oﬀ.
To do this, right-cli on the NetworkManager icon, and deselect the En-

Some computers may have a physical switch
or buon to turn oﬀ Wi-Fi.
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able Wireless option. Your wireless network will be turned oﬀ, and your
computer will no longer sear for available wireless networks.
To turn wireless networking ba on, right-cli on the NetworkManager
icon, and cli on the Enable Wireless option to re-select it. Your wireless
network will be turned ba on. Ubuntu will then sear for nearby wireless
networks and will connect to any saved networks within range.
Changing an existing wireless network
At times, you may want to ange the seings for a wireless connection that
you have previously saved. Its password may have anged, or your system
administrator asked you to ange some networking or security seings.
To edit a saved wireless network connection:
. Right-cli on the NetworkManager icon and select Edit Connections…
. A “Network Connections” window should open. Cli on the Wireless tab
to see a list of saved wireless connections
. By default, this list shows connections in the order of most recently used to
least recently used. Find the connection you want to edit, cli on it, and
then cli Edit.
. Ubuntu should open a window called “Editing ⟨connection name⟩”, where
⟨connection name⟩ is the name of the connection you are editing. e
window should display a number of tabs.
. Above the tabs, you may ange the Connection name ﬁeld if you want to
give the connection a more recognizable name
. If the Connect automatically option is not selected, Ubuntu will detect
the wireless network but will not automatically connect to it without you
oosing it from the NetworkManager menu. Select or deselect this seing
as needed.
. On the Wireless tab of the “Editing ⟨connection name⟩” window, you may
need to edit the  ﬁeld. A  is the wireless connection’s network
name—if set incorrectly, the network may not be detected and a connection
may not be made. Please make sure that the  is set according to your
network administrator’s instructions.
. Below the , you should see the Mode ﬁeld. e “Infrastructure” mode
means that you would be connecting to a wireless router or access point.
is is the most common mode for wireless networks. e “Ad-hoc” mode
is a computer-to-computer mode and is oen only used in advanced cases.
. On the Wireless Security tab of the “Editing ⟨connection name⟩” window,
you may need to ange the Security ﬁeld to the correct seing. A selection of None means that you are using an open network with no security.
Other selections may require slightly diﬀerent additional information:
‣  /-bit Key is an older security seing still in use by some
wireless networks. If your network uses this security mode, you will

  



need to enter a key in the Key ﬁeld that should appear aer you select
this mode.
‣  -bit Passphrase is the same older security seing as the entry
above. However, instead of a key, your network administrator should
have provided you with a text passphrase—a password—to connect to
the network. Once you select this security mode, you will need to enter
your passphrase in the Key ﬁeld.
‣  &  Personal is the most common security mode for wireless
network connections at home and at businesses. Once you select this
mode, you will need to enter a password in the Password ﬁeld.
‣ If your network administrator requires , Dynamic , or  &
 Enterprise security, you will need to have the administrator help
you set up those security modes.
. On the v Settings tab, you may need to ange the Method ﬁeld from
“Automatic ()” to “Manual,” or one of the other methods. For seing
up manual seings (also known as static addresses), please see the section
above on manual set up for wired network connections.
. When you ﬁnish making anges to the connection, cli Apply to save
your anges and close the window. You can cli Cancel to close the
window without making anges.
. Finally, cli Close on the “Network Connections” window to return to the
desktop.
Aer making anges, your new seings should go into eﬀect immediately.

Other connection methods
ere are other ways to get connected with Ubuntu.
With NetworkManager, you can also conﬁgure Mobile Broadband connections to keep online through your cellular or other mobile data carrier.
You can also connect to s (Digital Subscriber Lines), whi are a method
of Internet connection that uses your telephone lines and a “ modem.”
It’s also possible to use NetworkManager to establish a  (Virtual Private
Network) connection. ese are commonly used to create secure connectivity
to a workplace.
e instructions for making connections using mobile broadband, s, or
s, are beyond the scope of this guide.

Browsing the web
Once you have connected to the Internet, you should be able to browse the
web with Ubuntu. Mozilla Firefox is the default application for browsing the
web in Ubuntu.

A  is a “Virtual Private Network,” and is
sometimes used to help secure connections.
s are “Digital Subscriber Lines,” a type of
broadband connection.
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Figure .: The default Ubuntu home page
for the Firefox web browser.

Starting Firefox
To start Firefox, cli Applications ‣ Internet ‣ Firefox Web Browser. If your
keyboard has a “” buon, you can also press that buon to start Firefox.

To set other keyboard shortcuts or to
change the shortcut for launching Firefox,
go to System ‣ Preferences ‣ Keyboard
Shortcuts.

Navigating web pages
Viewing your homepage
When you start Firefox, you will see your home page. By default, you will see
the Ubuntu Start Page.
To go to your home page quily, press Alt+Home.
Navigating to another page
To navigate to a new web page, you need to type its Internet address (also
known as a ) into the Location Bar. s normally begin with “hp://”
followed by one or more names that identify the address. One example is
“http://www.ubuntu.com/”.

 stands for uniform resource locator and
 stands for world wide web.

Figure .: You can enter a web address or
search the Internet by typing in the location
bar.

To navigate:
. Cli on the Location Bar to select the  that is already there.
. Type the  of the page you want to visit. e  you type replaces any
text already in the Location Bar.

  



. Press Enter.
To quily select the  of the Location Bar, press Ctrl+L.
If you don’t know a , try typing something speciﬁc to the page you
want to visit (for example a name or other sear request) into the Location
Bar and press Enter. is will sear your preferred sear engine—Google by
default—for that term, and take you to the web page that is the top result from
the sear.

You can also press F6 on your keyboard to
highlight the location bar in Firefox.

Clicking a link
Most web pages contain links you can cli to move to other pages.
To cli a link:
. Move the mouse pointer until it anges to a pointing ﬁnger. is happens
whenever the pointer is over a link. Most links are underlined text, but
buons and pictures on a web page can also be links.
. Cli on the link once. While Firefox locates the link’s page, status messages will appear at the boom of the window.
Retracing your steps
If you want to visit a page you have seen before, there are several ways to do
so.
‣ To go ba or forward one page, cli on the Ba or Forward buon.
‣ To go ba or forward more than one page, cli on the small triangle
next to the Forward buon. You should see a list of pages you’ve recently
visited. To return to a page, select it from the list.
‣ To see a list of any s you’ve typed into the Location Bar, cli on the
down arrow at the right end of the Location Bar. To view a page, select it
from the list.
‣ To oose from pages you’ve visited during the current session, open the
History menu and oose from the list in the boom section of the menu.
‣ To oose from pages you’ve visited during the past several sessions, open
the History menu and oose Show All History. Firefox should open a
“Library” window, whi shows a list of folders. Cli on the folders to
displays sub-folders, or titles of web pages you’ve visited in the past. Cli
on a page’s title to view that page.
Stopping and reloading
If a page is loading too slowly or you no longer wish to view a page, cli on
the Stop buon.
To reload the current page or to get the most up-to-date version, cli on
the Reload buon or press Ctrl+R.

To go backwards and forwards you can also
use Alt+Leftto go backwards or Alt+Right
to go forwards.
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Opening new windows
At times, you may want to have more than one browsing window. is may
help you organize your browsing session beer, or separate web pages that
you are viewing for diﬀerent reasons.
ere are two ways to create a new window:
‣ On the menubar, open the File menu, then oose New Window.
‣ Press Ctrl+N.
Once a new window has opened, you can use it just like the ﬁrst window
—including navigation and opening tabs.
Opening a link in a new window
Sometimes, you may want to cli on a link to navigate to another web page,
but do not want the original page to close. To do this, you can open the link
you’d like to cli in its own window.
ere are two ways to open a link in its own window:
‣ Right-cli on a link to open its popup menu. Choose the Open Link in
New Window option. A new window will open, containing the web page
for the link you clied.
‣ Press-and-hold the Shift key while cliing a link. is will also open the
web page in a new window.

Tabbed browsing
If you would like to visit more than one web page at a time, you can use
Tabbed Browsing to navigate the web.
Tabbed browsing lets you open several web pages within a single Firefox
window, ea displaying in its own tab. is frees up space on your desktop since you don’t have to have a window open for every web page you’re
currently visiting. You can open, close, and reload web pages in one place
without having to swit to another window.
Opening a new blank tab
ere are three ways to create a new blank tab:
‣ Cli on the New Tab buon on the right side of the last tab.
‣ On the menubar, open the File menu, and then oose New Tab.
‣ Press Ctrl+T.
When you create a new tab, it will contain a blank page with the Location
Bar focused. Start typing a web address () or other sear term to open a
website in the new tab.

You can alternate quickly between diﬀerent tabs by using the keyboard shortcut
Ctrl+Tab.

  

Opening a link in its own tab
Sometimes, you may want to cli on a link to navigate to another web page,
but do not want the original page to close. To do this, you can open the link
you’d like to cli in its own tab.
ere are many ways to open a link in its own tab:
‣ If your mouse has a middle buon, or a wheel, cli on the link with the
middle mouse buon or wheel. A new tab should open, containing the web
page for the link you clied.
‣ Cli on the link with the le mouse buon, and keep holding down the
mouse buon. Drag the link up to a blank space on the tab bar, and release
the mouse buon. A new tab should open, containing the web page for the
link you dragged.
‣ Press-and-hold the Ctrl key while cliing the le mouse buon on the
link. A new tab should open, containing the web page for the link you
clied.
‣ Right-cli on a link to open its popup menu. Choose the Open Link in
New Tab option. A new tab will open, containing the web page for the link
you clied.
‣ Cli on a link, holding both le and right mouse buons.
Closing a tab
Once you have ﬁnished viewing a web page in a tab, you can close that tab.
ere are various ways to close a tab:
‣ Cli on the Close buon on the right side of the tab you want to close.
‣ On the menubar, open the File menu, and then oose Close Tab.
‣ Cli on the tab you want to close with the middle mouse buon, or the
mouse wheel, if you have one.
‣ Press Ctrl+W.
‣ Cli on the tab with both mouse buons.
Restoring a closed tab
Sometimes, you may close the wrong tab by accident, or want to bring ba a
tab that you’ve recently closed.
To bring ba a tab you’ve closed, do one of the following:
‣ On the menubar, open the History menu, oose Recently Closed Tabs,
and then oose the name of the tab you want to restore.
‣ Press Ctrl+Shift+T to re-open the most recently closed tab.
Changing the tab order
To move a tab to a diﬀerent location on the tab bar, drag it there using your
mouse. Cli-and-hold on the tab and drag the tab to a new place on the tab
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bar. While you are dragging the tab, Firefox will display a small indicator to
show where the tab will be moved.

When moving a tab to a new window it
may reload the page. Remember to save
your work before doing this.

Moving a tab between windows
If you have more than one Firefox window open, you can move an open tab to
a diﬀerent window. You can also split a tab oﬀ to become its own window.
To move a tab from one Firefox window to another already open window,
cli-and-hold on the tab and drag it to the tab bar on the other Firefox window. When you release the mouse buon, the tab will be aaed to the new
window.
To move a tab from one window into its own window, cli-and-hold
on the tab and drag the tab below the tab bar. When you release the mouse
buon, the tab will become a new window.

Searching
You can sear the web, or other collections, from within Firefox without ﬁrst
visiting the home page of the sear engine.
By default, Firefox will sear the web using the Google sear engine.
Searching the web
To sear the web in Firefox, type a few words into the Firefox sear Bar.
For example, if you want to ﬁnd information about the Ubuntu:
. Cli on the Sear Bar.
. Type the phrase “Ubuntu.” Your typing replaces any text currently in the
Sear Bar.
. Press Enter to sear.
Sear results from Google for “Ubuntu” should appear in the Firefox
window.
Selecting search engines
Figure .: These are the other search
engines you can use—by default—from the
Firefox search bar.

  

If you do not want to use Google as your sear engine in the Sear Bar,
you can ange the sear engine that Firefox uses.
To ange the sear engine, cli on the icon on the le side of the Sear
Bar. Choose one of the other sear engines in the list. Some sear engines,
like Google, sear the whole web; others, like Amazon.com, only sear
speciﬁc sites.

The Ubuntu home page’s search bar uses
Google by default, but will automatically
use Yahoo if Yahoo is selected in the Search
Bar.

Searching the web for words selected in a web page
Sometimes, you may want to sear for a phrase that appears on a diﬀerent
web page. Instead of copying and pasting the phrase into the Sear Bar,
Firefox allows you to sear the web for words you select within a web page.
. Highlight any words in a web page using your le mouse buon.
. Right-cli on the text you’ve highlighted to open a popup menu. Choose
the option Sear [Sear Engine] for “[your selected words]”.
Firefox should open a new tab containing sear results for your highlighted words, found using the currently selected sear engine.
Searching within a page

You may want to look for speciﬁc text within the web page you are viewing. To ﬁnd text within the current page in Firefox:
. Press Ctrl+F or oose Edit ‣ Find to open the Find Toolbar at the boom
of Firefox.
. Enter the text you want to ﬁnd into the Find ﬁeld in the Find Toolbar. e
sear automatically begins as soon as you type something into the ﬁeld.
. Once some text has been mated on the web page, you can:
‣ Cli Next to ﬁnd text in the page that is below the current cursor
position.
‣ Cli Previous to ﬁnd text that is above the current cursor position.
‣ Cli on the Highlight all buon to highlight occurrences of your
sear words in the current page.
‣ Select the Mat case option to limit the sear to text that has the
same capitalization as your sear words.
To ﬁnd the same word or phrase again, press F3 or oose Edit ‣ Find
Again from the menubar.



Figure .: You can search within web
pages using the Find Toolbar.
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Viewing web pages full screen
To display more web content on the screen, you can use Full Screen mode.
Full Screen mode condenses the Firefox’s toolbars into one small toolbar. To
enable Full Screen mode, simply oose View ‣ Full Screen or press F11.

Copying and saving pages
With Firefox, you can copy part of a page so that you can paste it elsewhere,
or save the page or part of a page as a ﬁle on your computer.
Copying part of a page
To copy text from a page:
. Highlight the text and/or images with your mouse.
. Choose Edit ‣ Copy from the menubar or press Ctrl+C.
You can paste the text into other applications.
To copy a text or image link () from a page:
. Position the pointer over the link or image.
. Right-cli on the link or image to open a popup menu.
. Choose Copy Link Location.
You can paste the link into other applications or into Firefox’s Location Bar.
Saving all or part of a page
To save an entire page in Firefox:
. Choose File ‣ Save Page As from the menubar. Firefox should open the
“Save As” window.
. Choose a location for the saved page.
. Type a ﬁle name for the page, and cli Save.
To save an image from a page:
.
.
.
.
.

Position the mouse pointer over the image.
Right-cli on the image to display a popup menu.
Choose Save Image As. Firefox should open the “Save Image” window.
Choose a location for the saved image.
Enter a ﬁle name for the image and cli Save.

Changing your homepage
By default, Firefox will show the Ubuntu Start Page when you start Firefox.
If you prefer to view another page when you start Firefox, you will need to
ange your homepage preference.
To ange your homepage:

  



Figure .: You can change Firefox seings
in this window.

. Navigate to the page that you would like to become your new homepage.
. Choose Edit ‣ Preferences from the menubar.
. In the “Startup” section on the General tab, whi is shown by default,
cli on the Use Current Page buon. If you had more than one tab open
then all the tabs will be opened when Firefox starts. If you prefer to have
one page open, close the other tabs and repeat steps –.
. Cli Close.

The homepage can also be set by entering
the addresses that should be open in the
Home Page, with a pipe—|—separating
pages to be opened in a new tab

Download seings
In Edit ‣ Preferences you can ange how Firefox behaves with downloads.
You can tell Firefox where to place downloaded ﬁles, or to ask where ea
time. You can also set the behavior of Firefox’s Downloads window. e
Downloads window can be hidden entirely, or set to hide when downloads
ﬁnish.

Bookmarks
When browsing the web you may want to come ba to certain web pages
again without having to remember the .
In Firefox, you can create bookmarks, whi are saved in the web browser
and whi you can use to navigate ba to your pied web pages.
Bookmarking a page
Aer navigating to a web page you can save its location by bookmarking it.
ere are two ways to bookmark a page:
‣ From the menubar, oose Bookmarks and then Bookmark is Page. A
window will open. Provide a descriptive name for the bookmark, and cli
on the Done buon.

The Downloads window shows the progress
of currently downloading files, and lists files
downloaded in the past. It can be used to
open or re-download files.
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‣ Press Ctrl+D. A pop-up will appear. Provide a descriptive name for the
bookmark, and cli on the Done buon.
Navigating to a bookmarked page
To navigate to a bookmarked page, open the Bookmarks menu from the
menubar, and then oose your bookmark’s name. Firefox should open the
bookmark in the current tab.
You can also press Ctrl+B to display bookmarks in a sidebar on the le side of
the browser window. Press Ctrl+B again to hide the sidebar.

Deleting a bookmark
If you would like to delete a bookmark that you have previously made, open
the Bookmarks menu from the menubar, and then right-cli on your bookmark’s name. Firefox should open a popup menu for your bookmark. Choose
the Delete option from the menu. Your bookmark should then be deleted.

History
Whenever you are browsing the web, Firefox is saving your browsing history.
is allows you to come ba to a web page that you have recently visited,
without needing to remember the page’s , or even bookmarking it.
To see your most recent history, open the History menu from the menubar.
e menu should then display several of the most recent web pages that you
were viewing. Choose one of the pages to return to it.
To see the web pages you have visited recently, press Ctrl+H. Firefox will
open a “sidebar” on the le side of the browser window, that contains your
browsing history, categorized as “Today,” “Yesterday,” “Last  days,” “is
month,” the past  months (listed month by month), and ﬁnally “Older than
 months.” If history for a category does not exist, that category will not be
listed.
Cli on one of the date categories in the sidebar to expand it. en it will
reveal the pages you visited during that period. en, once you ﬁnd the page
you need, cli on its title to return to it.
You can also sear for a page by its title. Enter a few leers, or a word,
in the Sear ﬁeld at the top of the history sidebar. e sidebar should then
display a list of web pages whose titles mat your sear words. Cli on the
title of the page you need to return to it.
If you would like to hide the history sidebar again, press Ctrl+H again.

Clearing private data
At times, you may want to delete all private data that Firefox stores about
your browsing history. While this data is stored only on your computer, you
may want to remove it if you share access to your computer.

  

To delete your private data, open the Tools menu from the menubar, and
oose Clear Recent History. In the drop down list for the Time range to
clear, oose how far ba you would like Firefox to delete.
If you would like more control over what you clear, cli on the Details
text to display a list of options.
When done, cli on the Clear Now buon.

Using a diﬀerent web browser
Figure .: You can change the default
browser with the “Preferred Applications” utility. To use it, open the System ‣
Preferences ‣ Preferred Applications.

If you install a diﬀerent web browser on your computer, you may want
to use it as the default browser when you cli on links from emails, instant
messages, and other places.
To ange your preferred web browser, open the System menu from
Ubuntu’s main menubar. en, oose System ‣ Preferences ‣ Preferred Applications. Ubuntu should then open the “Preferred Applications” window.
In the “Web Browser” section, oose your new preferred web browser, and
cli Close.

Reading and composing email
To send and receive email in Ubuntu, you can use the Evolution mail application. To start Evolution, open the Applications menu, then oose Oﬃce and
then Evolution Mail and Calendar.
In addition to email, Evolution also can help manage your contact list, your
calendar, and a list of tasks.
Although Evolution can be used with many webmail systems, su as Yahoo!
Mail, Hotmail, and Gmail, you may prefer to use the Firefox web browser to
access them.

Running Evolution for the first time
When you start Evolution for the ﬁrst time, you will need to conﬁgure it to
connect to your email account.
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When Evolution starts, you should see the “Evolution Setup Assistant”
window, welcoming you to Evolution. Cli Forward to continue with the
setup.
Next, on the “Restore from baup” screen, Evolution may ask you to
restore from a previous baup. Since this is the ﬁrst time you are running
Evolution, you can cli Forward to skip this step.
On the next screen, “Identity”, you need to enter your name and the email
address you wish to use with Evolution. Enter your full name in the Full
Name ﬁeld, and the full email address in the Email Address ﬁeld. You can
ﬁll in the optional information, or leave it unanged if you desire. Cli
Forward when you are done.
Next, you should see the “Receiving Email” screen. On this screen, you
need to provide Evolution with the details of your email servers. If you do not
know these details, you will need to ask your network administrator or e
with your email provider.
ere are two common types of Internet email connections: , and
. ese are described below. In work environments there are sometimes
other types, su as Microso Exange or Novell GroupWise—for more
information on those types of connections, please see the documentation for
Evolution located in the Help ‣ Contents menu.
Seing up an IMAP connection
 connections allow you to manage your email remotely—the actual email
and folders reside on your email server, while Evolution allows you to view,
edit, and delete the messages and folders as needed.
If your email provider recommends an  connection, oose IMAP
from the Server Type drop-down list. In the Server ﬁeld, enter the Internet
address or  of your mail server. for example imap.example.com. In the
Username ﬁeld; enter the username that you use to log into your email system, for example joe.x.user or joe.x.user@example.com, as speciﬁed by
your email provider.
Your email provider may specify the security seings you will need to use
in order to receive email. If your connection does not use security, leave the
Use Secure Connection drop-down list set to No encryption. Otherwise,
oose either  encryption or  encryption, as speciﬁed by your email
provider.
Aer oosing these options, cli Forward to proceed to the “Receiving Options” screen. While it is normal to leave all options unselected, you
may want to select the Che for new messages option to have Evolution
automatically e email on a regular basis.
When you are ﬁnished seing the options, cli Forward to continue to
the next screen.

  

Seing up a POP connection
 connections let you manage your email locally—Evolution will connect to
your email provider and download any new messages you may have received,
and store them in folders on your computer. e messages will be deleted
from the server.
If your email provider recommends a  connection, oose POP from
the Server Type drop-down list. In the Server ﬁeld, enter the Internet address
or  of your mail server; for example pop.example.com. In the Username
ﬁeld, enter the username that you use to log into your email system, for
example joe.x.user, or joe.x.user@example.com.
Your email provider may specify the security seings you will need to use
in order to receive email. If your connection does not use security, leave the
Use Secure Connection drop-down list set to No encryption. Otherwise,
oose either  encryption or  encryption, as speciﬁed by your email
provider.
Aer oosing these options, cli Forward to proceed to “Receiving Options” screen. While it is normal to leave all options unselected, you may
want to select the Che for new messages option to have Evolution automatically e email on a regular basis.
You may also wish to adjust the Message Storage options, whi determine
what Evolution does aer downloading email to your computer. Select the
Leave messages on server option to have Evolution keep the messages on
your email system aer downloading them. is will allow you to use another
computer to re-download all of your new messages. Select the Delete aer 
days option to have Evolution keep the messages for a few days, and delete
them aer a while. You can adjust the number of days that Evolution keeps
the messages.
When you are ﬁnished seing the options, cli Forward to continue to
the next screen.
Seing up your sending options
e next screen should be the “Sending Email” screen. Here, you will need to
conﬁgure your connection for sending email through your email provider.
e most common type of sending connection is , whi is the default
server type selected.
In the Server ﬁeld, type in the name of the outbound mail server (also
known as the  server), as described by your email provider. For example,
mail.example.com.
If your email provider requires authentication, select the Server requires
authentication option. is is common for commercial email providers.
In the “Authentication” section of the screen, oose the type of authentication from the Type drop-down list—the most common authentication
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type is “.” Below that, enter your username, for example, joe.x.user, or
joe.x.user@example.com, in the Username ﬁeld.
Your email provider may specify the security seings you will need to use
in order to send email. If your connection does not use security, leave the Use
Secure Connection drop-down list set to No encryption. Otherwise, oose
either  encryption or  encryption, as speciﬁed by your email provider.
Aer oosing these options, cli Forward to proceed to the next screen.
Finalizing your account options
On the next screen, “Account Management”, enter a descriptive name for this
account. If you set up more email accounts with Evolution the name provided
here will help distinguish those accounts.
When ﬁnished, cli Forward. is should open the “Done” screen. If you
believe that you’ve entered the correct options, cli Apply to ﬁnish setup.
Otherwise, cli Ba to go ba one or more screens to correct your seings,
or cli Cancel to abort setup and discard your account seings.
Aer you ﬁnish setup, Evolution may ask you if you would like to make it
your default email client. Cli Yes if you plan on reading and sending email
only with Evolution. Cli No if you plan on installing or using a diﬀerent
email program.

Around the Evolution workspace
Figure .: Evolution allows you to manage
your mail, contacts and tasks.

e Evolution window is divided into four parts. At the top are the
menubar and toolbar. e menubar lets you access most of the functional-

  

ity of Evolution, while the toolbar provides convenient shortcuts to some of
the most frequently used features.
On the le side of the window is the folder list. Every message that you
send or receive will reside in one of the folders in this list.
Below the folder list on the le side of the window are the Mail, Contacts,
Calendars, Tasks, and Memos buons. When working with email, the Mail
buon is selected. e other buons take you to those other parts of Evolution.
On the right side of the window are the message list, and the message
preview beneath it. e message list shows all of the messages in the currently
selected folder, or mating your sear request. If a message is selected in
this list, its contents are shown in the message preview pane below.
Understanding the folder list
e folder list is the way that Evolution separates and categorizes your email.
e ﬁrst group of folders in the list is titled “On is Computer.” ese are
your local folders—they reside on your computer only. If you use  servers
to retrieve your email, any new message will be placed in the Inbox local
folder.
You can cli on any folder to see its contents appear in the message list on
the right side of the window.
Ea of the initial folders in the list is special:
‣ Inbox stores your incoming messages.
‣ Dras stores messages that you’ve worked on, but have not yet sent.
‣ Junk stores messages that have been identiﬁed as unsolicited email that
you did not want. Junk mail is also known as “spam.”
‣ Outbox contains messages that you’ve ﬁnished composing, but whi
have not been sent yet. For example, if you are in an airplane or another
location without an Internet connection, you can still cli the Send buon
once you’ve ﬁnished writing an email. e message will be moved to the
Outbox, and will remain there until the next time you are able to send
and receive messages. Once you can send and receive messages, all email
messages in the Outbox will be sent out.
‣ Sent contains copies of messages that have been sent successfully. Once a
message from an Outbox is sent, it is copied to the Sent folder.
‣ Templates stores any email message templates you have saved. A template
is a partial message, for example, a blank invoice, that can be used as the
starting point for other messages.
‣ Trash contains messages that you have deleted. By default, the trash will
be emptied every time you exit Evolution.
If a folder contains any unread messages, the folder’s name will be displayed in bold, and the number of unread messages will be displayed in
parentheses following the folder name.
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If you use an  server to retrieve your email, then your remote 
folders will also be shown in the folder list, below the “On is Computer”
section. e heading for ea folder list uses the name you gave to that account. Ea -enabled account has its own Inbox for new messages.
Towards the boom of the folder list, Evolution will show a list of “Sear
Folders.” ese are special folders that represent certain messages that mat
sear rules. Please see the section on Finding Messages for more on sear
folders.
Managing folders
In addition to the initial folders, you can create your own folders to manage
your email.
To create a new folder, open the Folder menu, and then oose New. Enter
a name for the folder that you would like to create. en, from the list of
folders below, select the parent folder. For example, if you would like your
new folder to be placed under the Inbox then select the Inbox folder. If you
select “On is Computer,” then your new folder will be placed under “On
is Computer” in the folder list.
Once you’ve made your selection, cli on the Create buon to create the
folder. Your new folder should now be in the folder list.
You can move folders that you have created. To do so, cli on the folder
that you would like to move, hold down the mouse buon, and drag the folder
to a new parent folder. Once the mouse cursor highlights a new parent folder,
release the mouse buon to ﬁnish the move.
You can also right-cli on a folder, and oose the Move… option. en,
select the new parent folder, and cli on the Move buon.
To delete a folder, right-cli on the folder and oose the Delete option.
To conﬁrm that you want to delete the folder, cli on the Delete buon.

Checking and reading messages
Checking mail
When you ﬁnish setup, or when you start Evolution in the future, Evolution
will ﬁrst try to connect to your email provider to e your email. In order to
connect, Evolution will need to know your email account password, and will
ask you for it.
Figure .: You need to enter your password to authenticate your account.

  

In the “Enter Password” window, enter your password and cli OK. If you
wish for Evolution to remember this password and not ask you in the future,
you can select the Remember this password option.
Evolution will then show a “Send & Receive Mail” window, showing the
progress of the operation su as how many messages are being retrieved.
Listing messages
e top right portion of the Evolution window is the message list. Here, you
can see email messages for your currently selected folder, or mating your
sear terms.
By default, the message list shows six columns of information for ea
message. e ﬁrst column is a read/unread indicator. If a message has been
read, the column shows an icon of an open envelope. If a message has not
been read, the icon will show a closed envelope.
e second column is an aament indicator. If a message contains an
aaed ﬁle, Evolution will show an icon of a paperclip in this column. Otherwise, the column will be blank.
e third column is an importance indicator. If someone sends you a
message marked with high importance, Evolution will show an exclamation
mark in this column. Otherwise, this column will be blank.
e fourth column contains the sender of the message. Both the name and
email, or just the email address, may be displayed in this column.
e ﬁh column contains the subject of the email message.
Finally, the sixth column is the date that the email was sent.
When you cli on a message, its contents will be displayed in the preview
pane below the message list. Once you select a message by cliing it, you can
cli on the Reply buon in the toolbar to begin composing a reply message
to be sent to the sender, or cli on the Reply to All buon to begin composing a reply message to be sent to the sender and other recipients of your
selected message.
You can also cli on the Trash buon in the toolbar to put the message
in the Trash folder, or on the Junk buon to move the message into the Junk
folder. Note that Evolution, or your mail server, may automatically classify
some mail as Junk.
In addition to the buons on the toolbar, you can right-cli on a message
in the list. Evolution will open a menu with actions that you can perform for
the message.
Sometimes, you may wish to take an action on multiple email messages
(for example, delete multiple messages, or forward them to a new recipient).
To do this in Evolution, press-and-hold the Ctrl key while cliing on multiple messages—the messages you cli on will be selected. You can also cli
on one message to select it, then press-and-hold the Shift key and cli on
another message in the list. All messages in the list between the original selec-
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tion and the one you just clied on will be selected. Once you have multiple
messages selected, right-cli on one of them to perform your desired action.
Directly above the message list are the Show drop-down list, and the
sear options. You can use the Show drop-down list to ﬁlter your view to
show only unread messages, or only messages with aaments, etc.
e sear options will be covered in a later section.
Previewing messages
When you select an email message, its contents will be shown in the preview
pane below the message list.
e top of the preview pane will show the message header, whi contains
the sender, recipients, and subject of the message, as well as the date the
message was sent. Below the header, Evolution shows the contents of the
message itself.
If a message was sent with  formaing, some of the images may not
be displayed when a message is previewed. To display the missing images,
open the View menu from the menubar, then Load Images, or press Ctrl+I.
If your Internet connection is active, the missing images should then load.
Opening messages
At times, you may want to display multiple messages at the same time. To do
so, you can open ea message in a separate window instead of just viewing it
in the preview pane.
To open a message in its own window, double cli a message in the message list. e message should then open in a separate window. You can go
ba to the message list and open another message, if needed.
In the open message window, you can use the options in the menubar or on
the toolbar to reply to the message, categorize it, delete it, as well as perform
other message actions.
Finding messages
ere are three ways to sear for messages in Evolution: you can use the
sear option at the top of the message list, use the Advanced Sear function,
or create a sear folder.
To use message list sear, enter the text you want to ﬁnd in the Sear
ﬁeld at the top right of the message list, and press Enter. e list of messages
will ange to show only those messages containing the text you entered.
To the right of the sear ﬁeld you should be able to see a drop-down list
of options su as “Current Folder,” “Current Account,” and “All Accounts.”
By default, Evolution will use the “Current Folder” option and will only
show you results within the folder you’ve got selected in the folder list on
your le. If you oose the “Current Account” option, Evolution will sear
for messages in all folders within the current email account—su as all the

Note that loading images may provide a
way for the sender to track your receipt of
the message. We do not recommend loading
images in messages that you suspect are
Junk.

  

folders “On is Computer” or in your  folders, depending on your email
setup. If you have multiple email accounts added to Evolution, oosing the
“All Accounts” option lets you sear for messages in all of your accounts.
If no messages mat the text you’ve entered, you can edit the text and
try searing again. To return to the folder display, open the Sear menu
from the menubar and then oose Clear, or instead erase all the text you’ve
entered in the Sear ﬁeld and press Enter.
In some cases, you may want to sear for messages using multiple criteria.
For example, you may want to ﬁnd a message from a particular user with
some speciﬁc words in the subject of the message. In Evolution, you can
perform this sear using the Advanced Sear function.
Figure .: To use more search terms you
can use the advanced search window.

To use Advanced Sear, oose Sear ‣ Advanced Sear. Evolution
should open the “Advanced Sear” window. In the middle section of the
window, specify your sear criteria. For our example, to ﬁnd messages from
myfriend@example.com that contained “boat” in the subject, you would enter
myfriend@example.com in the text ﬁeld to the right of the drop-down list with
“Sender” selected, and would enter boat in the text ﬁeld to the right of the
drop-down list with “Subject” selected. en, cli on Remove to the right of
all lines that are unused, and cli OK to perform the sear. e message list
should then only display messages that mat your advanced sear criteria.
When specifying the criteria for advanced sear, you can cli on the Add
Condition buon to add additional lines. You can also ange the selection
in the drop-down list at the beginning of ea line to specify a diﬀerent ﬁeld
to be eed, or ange the drop-down with “contains” selected by default
in order to have a diﬀerent type of a mat. Please refer to the Evolution help
documents for more information.
In some cases, you may want to perform the same sear request on a regular basis. For example, you may want to always be able to see all messages
from myfriend@example.com regardless of whi folder you’ve used to store
the message. To help with this type of a sear, Evolution allows you to create
Sear Folders.
To create a sear folder, oose Sear ‣ Create Sear Folder From
Sear from the menubar. Give the folder a name by entering it in the Rule
name ﬁeld at the top. en, specify sear criteria in the same way as in





    .

Advanced Sear. Below the criteria, pi whi folders should be seared by
this sear folder—for example, you can oose “All local and active remote
folders” to sear in all of your account’s folders. When you are ﬁnished, cli
OK.
e new sear folder should now be added to the list of sear folders
towards the boom of the message list. If you cli on the sear folder to
select it, you should be able to see a list of messages that mat your sear
criteria.
Subscribing to IMAP folders
If you use  to retrieve your email, you should see a set of folders in the
folder list on the le side of the window that is titled with the name of your
 account. Folders like Inbox, Dras, Junk and others should be displayed
in the folder list.
If you have other folders in your  account, you will need to subscribe
to them. If you subscribe to a folder, Evolution will download messages for
that folder whenever you e your email.
To subscribe to a folder select Folder ‣ Subscriptions from the menubar.
Evolution should open the “Folder Subscriptions” window. From the Server
drop-down list oose your account name. Evolution should then show a list
of folders in the list below.
Choose the folders you would like to subscribe to by selecting the e
box to the le of the folder name. When you are ﬁnished, cli Close. e
folders will be updated the next time you e your email.

Composing and replying to messages
In addition to reading email, you will likely want to reply to the email you
read, or compose new messages.
Composing new messages
To compose a new message, cli on the New buon on the toolbar. Evolution
should open a “Compose message” window.
In the To: ﬁeld, enter the email address of the destination—the contact to
whom you are sending this email. If there is more than one contact to whom
you are writing, separate multiple recipients with commas.
If a contact that you are addressing is in your address book, you can address them by name. Start typing the name of the contact; Evolution will
display the list of mating contacts below your text. Once you see the contact you intend to address, cli on their email address or use the down arrow
key and then Enter to select the address.
If you would like to carbon-copy some contacts, enter their email addresses
in the Cc: ﬁeld in the same manner as the To: recipients. Contacts on the To:

  

and Cc: lines will receive the email, and will see the rest of the contacts to
whom an email was sent.
If you would like to send an email to some contacts without disclosing
to whom your email was sent, you can send a blind carbon-copy, or Bcc. To
enable Bcc, select View ‣ Bcc Field from the menubar. A Bcc: ﬁeld should
appear below the Cc: ﬁeld. Any contacts entered in the Bcc: ﬁeld will receive the message, but none of the recipients will see the names or emails of
contacts on the Bcc: line.
Instead of typing the email addresses, or names, of the contacts you are
addressing in the message, you can also select the contacts from your address
book. To do so, cli on the To:, Cc: or Bcc: buons to the le of the text
ﬁelds. Evolution should open the “Select Contacts from Address Book” window. Use the list on the le side of the window to select your contact, or type
a few leers from your contact’s ﬁrst or last name in the Sear ﬁeld to ﬁlter
the list to only show mating contacts.
Once you identify the contact you would like to address, cli on their
name in the list. en, cli on the Add buon to the le of either the To:,
Cc:, or Bcc: ﬁelds located on the right of the screen. Your selected contact will
be added to that list. If you’ve added the contact in error, cli their name in
the list on the right, and cli on the Remove buon. When you are ﬁnished
piing contacts, cli Close to return to the composing screen.
Enter a subject for your email. Messages should have a subject to help the
recipient to identify the email while glancing at their message list; if you do
not include a subject, Evolution will warn you about this.
Enter the contents of your message in the big text ﬁeld below the subject.
ere is no practical limit on the amount of text you can include in your
message.
By default, new messages will be sent in “Plain Text” mode. is means
that no formaing or graphics will be shown to the recipient, but the message
is least likely to be rejected or displayed illegibly to the recipients. If you
know that your recipient uses a contemporary computer and a modern email
program, you can send them messages that include formaing. To swit to
this mode, cli the drop-down list buon on the le side directly above the
text ﬁeld for the message contents. Change the selection from “Plain Text”
to “” to enable advanced formaing. When using  mode, a new
toolbar should appear right under the mode selection that will allow you to
perform advanced font styling and message formaing.
When you have ﬁnished composing your email, cli on the Send buon
on the window’s toolbar. Your message will be placed in the Outbox, and will
be sent when you next e your email.
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Aaching files
At times, you may want to send ﬁles to your contacts. To send ﬁles, you will
need to aa them to your email message.
To aa a ﬁle to an email you are composing, cli on the Add Attament buon at the boom right of the email message window. Evolution
should show the “Add aament” window.
Select the ﬁle you would like to include in your message and cli on the
Atta buon. Evolution will return you to the email message window, and
your selected ﬁle should be listed in a section below the Add Attament
buon.
Replying to messages
In addition to composing new messages, you may want to reply to messages
that you receive.
ere are three types of email replies:
‣ Reply (or “Reply to Sender”)—sends your reply only to the sender of the
message to whi you are replying.
‣ Reply to All—sends your reply to the sender of the message, as well as
anyone else on the To or Cc lines.
‣ Forward—allows you to send the message, with any additional comments
you may add, to some other contacts.
To use any of these methods, cli on the message to whi you want
to reply and then cli the Reply, Reply to All, or Forward buon on the
toolbar.
Evolution should open the reply window. is window should look mu
like the window for composing new messages, but the To, Cc, Subject, and
main message content ﬁelds should be ﬁlled in from the message to whi you
are replying. Ea line in the message should be preﬁxed with a “>” aracter.
Edit the To, Cc, Bcc, Subject or main body as you see ﬁt. When your reply
is ﬁnished, cli on the Send buon on the toolbar. Your message will be
placed in the Outbox, and will be sent when you next e your email.
Using signatures
In order to give your messages a footer, Evolution allows you to use a “signature.” Signatures in email are a bit of standard text that is added to the boom
of any new messages or replies.
When composing of replying to a message, cli on the Signature dropdown list below the toolbar just above the To: ﬁeld. is list should contain
any signatures that you have created, as well as an “Autogenerated” signature.
If you select Autogenerated, Evolution will add two dashes, and then your
name and email address to the boom of the email message.

  

You can also specify some custom signatures. To create a signature, open
the “Evolution Preferences” window by selecting Edit ‣ Preferences from
the menubar. On the le side of the Evolution Preferences window, select
Composer Preferences and then select the Signatures tab.
Cli on the Add to add a new signature. Evolution should then open
the “Edit Signature” window. Give your signature a name, and enter the
contents of your signature in the big text ﬁeld below. When ﬁnished, cli
on the Save buon on the toolbar (the buon’s icon looks like a ﬂoppy disk).
Your new signature’s name should appear in the list in preferences. Close the
preferences window.
Your signature should now show up in the drop-down list in the compose/reply window.



Note that the two dashes are added automatically by Ubuntu, so there is no need to
include them in your custom signature.

Staying organized
e Evolution application in Ubuntu can let you keep and manage a list of
your contacts, maintain a calendar, and a task list.
If you have already set up Evolution with an email account, you do not
need to do any further setup to use these features. If you do not wish to
use Evolution for email, you can still use it for managing your contacts or
maintaining a sedule, as well as keep tra of tasks and memos that you can
create for yourself.
To start Evolution, open the Applications menu, then oose Oﬃce and
then Evolution Mail and Calendar.

Managing your contacts
If you would like to keep a list of your contacts—personal or professional
contact information for people and organizations—you can manage these
contacts in Evolution.
To view contacts, cli on the Contacts buon below the folder list on
the le side of the Evolution window. e folder list on the le will be replaced by a list of address book types. Cli on an address book, for example
“Personal.”
e right side of the window will display a list of contacts. Cli a contact
to show the contact’s details in the lower portion of the right side of the
window.
If you use Ubuntu One, you may have two address books—a “Personal”
address book stored on your computer, and an “Ubuntu One” address book.
You can add contacts to either address book, though only the “Ubuntu One”
address book is synronized to your Ubuntu One account.

An address book is a collection of contacts
and contact lists. It can either be stored on
your computer, or on a remote server.
Ubuntu One is a free service you can use
to sync and store contacts, as well as other
information. For more information on
Ubuntu One see the dedicated section later
in this chapter.
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Figure .: You can view, edit, and add
contacts.

Searching for contacts
To ﬁnd a contact, type in a few a few leers from the contact’s ﬁrst or last
name in the sear text box on the upper right of the window, and press
Enter. e list below should ange to only show contacts whose name
mates your sear term.
Adding or editing a contact
To make anges to an existing contact, ﬁnd the contact in the list and doublecli on the entry. Evolution should open a “Contact Editor” window for the
contact.
Swit between the diﬀerent tabs in the contact editor to make anges to
the contact. Cli OK when you have ﬁnished making your anges.
To add a new contact, cli on the New on the toolbar. Evolution should
open the “Contact Editor” window. Enter the contact’s details in the contact
editor window, and cli OK when ﬁnished.

Managing your schedule
If you like to manage your sedule with a computer, you can maintain this
sedule in Ubuntu using Evolution.
To view your calendar, cli on the Calendars buon below the folder
list on the le side of the Evolution window. e folder list on the le will
be replaced by a list of calendars, and a mini-calendar showing the current
month.
Evolution allows you to manage more than one calendar. For example, you

  

could have a personal calendar and a sool or work calendar. You can also
subscribe to the calendar of a friend or family member who may oose to
share their calendar with you.
Cli on one of the calendars in the list. By default, you should have a
“Personal” calendar in the list. e middle of the window should now show a
view of the current day, showing all the hours of the current day.
If the calendar already has some events, Evolution will show the event in
the day view between the hours when the event starts and ﬁnishes. You can
double-cli on the event to open its details, or drag the event to a diﬀerent
time or date to resedule it.
In the day view, you can cli on a diﬀerent day on the mini-calendar on
the le side of the screen. Evolution will then display that day in the day
view.
You may also wish to see more than one day at a time. is will allow you
to compare sedules on diﬀerent days, or ﬁnd a free day for an event you
wish to sedule. In Evolution, you can cli on the Work Week or Week
buons on the toolbar to see an entire week at the same time. Cli on the
Month buon on the toolbar to see a view of the entire month—if an event
is diﬃcult to read due to the small space alloed to ea day, you can hover
your mouse over the event to have Evolution show the full title of the event.
Finally, the List buon on the toolbar shows upcoming appointments in a list,
allowing you to see all of your upcoming appointments at a glance.
On the right side of the window, Evolution displays a list of tasks and
memos. You can add a new task or memo to Evolution
Adding a new event
e simplest way to add a new task is to cli a time in the day view, and
begin typing. An event “bubble” will appear, containing the text that you are
typing. If you want to add a longer event, drag your mouse from the ﬁrst time
slot to the last before starting to type.
Figure .: You can stay organized by
adding events to your calendar.

To add a new event without using the day view, cli on the New buon
on the toolbar. Evolution should open the “Appointment” window. In the
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Summary ﬁeld, enter a short title for the event as you want it to appear on
the calendar. Optionally specify the location and enter a longer description if
you would like. Make sure that the time and date, as well as the duration, are
as you want them. Finally, cli on the Save buon on the toolbar to save this
new event (the buon looks like a hard drive, and is the ﬁrst buon on the
toolbar).
Scheduling a meeting
If you would like to sedule a meeting with one of your contacts, Evolution
can assist you in sending out an invitation and processing replies.
To create a meeting invitation, oose File ‣ New ‣ Meeting from the
menubar. Specify the subject, location, time and duration, and description as
when you create a regular event.
You will then need to add aendees to this meeting. To add an aendee,
cli on the Add buon. In the list of aendees, Evolution will add a new row
—type the aendee’s email address or contact name.
When you are ﬁnished adding aendees, cli on the Save buon on the
toolbar. Evolution should then ask you if you would like to send meeting invitations to your selected participants. Cli Send to send out these invitations.
e invitations will be sent the next time you e email in Evolution.
If your contact ooses to reply to the meeting invitation, Evolution will
show you a new email message. In the body of the email message, Evolution
will display an Update Attendee Status buon. Cli on that buon to mark
your contact as aending the meeting.

Using instant messaging
Instant messaging allows you to communicate with people you know in real
time. Ubuntu includes the Empathy application that lets you use instant
messaging features to keep in tou with your contacts. To start Empathy,
open the Applications menu from the menubar, then oose Internet and
then Empathy Internet Messaging.
Empathy lets you connect to many instant messaging networks. You can
connect to: Facebook Chat, Google Talk, Jabber, People Nearby, , GaduGadu, Groupwise, , , , mxit, myspace, , sametime, silc, , ,
Yahoo!, and Zephyr.

Running Empathy for the first time
When you open Empathy for the ﬁrst time you will need to conﬁgure it with
the details of your instant messaging accounts.
When Empathy starts you will see the “Welcome to Empathy” window.
Choose the option corresponding to your situation.

  



You have an account
If you have an account that you have used previously with another instant
messaging program then select the Yes, I’ll enter my account details now
option. en, cli Forward to continue.
On the next screen, oose your account type from the drop-down list
below What kind of at account do you have?. en, enter your account
details in the ﬁeld below.
Depending on the account type that you oose, Empathy may request that
you enter a username, or an  for your account, followed by a password.
Figure .: Creating a new instant messenger account in Empathy.

If you do not remember your account information, you will need to visit
the website of the instant messaging network to retrieve that information.
If you have another account to add then select the Yes option, and cli
Forward to repeat the above process. When you have entered all the accounts
leave the No, that’s all for now option selected, and cli Apply to ﬁnish the
setup process.
Next, Empathy should display the “Please enter personal details” screen. If
you oose to ﬁll out this information, you will be able to communicate with
people who are on your local network either at home or in an oﬃce.
Enter your ﬁrst name in the First name ﬁeld, and your last name in the
Last name ﬁeld. Type in a way that you would like to be identiﬁed on your
local network in the Niname ﬁeld. When you have ﬁlled all of the information, cli Apply.
If you don’t want to communicate with people on your local network,
select the I don’t want to enable this feature for now option and cli
Apply.
You would like an account
If you don’t have an account that you can use, then you can create one by
selecting the No, I want a new account option. Cli Forward to display the
next set of options.
Choose the account type that you would like to create from the drop-down
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list below What kind of at account do you want to create? You can
create either a Jabber or a Google Talk account.
Next, enter the account name that you would like in the text ﬁeld, and in
the proceeding text ﬁeld enter a password of your oice. If you would like
to set up another account then select the Yes option, and repeat the above
process.
When you have entered all the accounts leave the No, that’s all for now
option selected, and cli Forward.
Empathy should display the “Please enter personal details” window. Providing this information allows you to communicate with people who are on
your local network either at home or in the workplace.
Enter your First name in the text ﬁeld, and enter your Last name in the
next ﬁeld. In the Niname ﬁeld enter a niname by whi you would like
to be identiﬁed. When you have ﬁlled all of the text ﬁelds cli Apply to save
your seings.
If you don’t want to talk to people on your local network then select the I
don’t want to enable this feature for now option and cli Apply.

Note: If you wish to create another account
type then you will need to visit the relevant
website and create the account. Then follow
the “You have an account” section.

You want to talk to people nearby
If you would only like to communicate with people on your local network
either at home or in the workplace, then you should select the No, I just want
to see people online nearby for now option.
Cli Forward to display the next set of options. en enter your First
name in the text ﬁeld, and enter your Last name in the next ﬁeld. In the
Niname ﬁeld enter a niname by whi you would like to be identiﬁed.
When you have ﬁlled all of the text ﬁelds, cli Forward.
Figure .: You can talk to people nearby
by entering your information.

Changing account seings
If you need to add more accounts aer the ﬁrst laun, then open the Edit
menu, then oose Accounts. Empathy will then display the “Accounts”
window.

  

Adding an account
To add an account cli on the Add buon. Empathy should display some
options on the right hand side of the window. Choose your account type from
the Protocol drop-down list. Next, enter your account name in the ﬁrst text
ﬁeld. en enter your password in the Password text ﬁeld. Finally cli on
the Log in buon to save and verify your seings.
Editing an account
You might need to edit an account if you ange the password or get the
password wrong. Select the account you want to ange on the le side of
the “Accounts” window. Empathy should show the current seings for the
account. Once you have made your anges, cli Save.
Removing an account
To remove an account select the account on the le hand side of the window
and cli on the Remove buon. Empathy should open the “Do you want to
remove” window. Cli on the Remove buon to conﬁrm that you want to
remove the account, or cli Cancel to keep the account.

Editing contacts
Adding a contact
To add a contact open the Chat menu, then oose Add contact. Empathy
should open the “New Contact” window.
In the Account drop-down list oose the account that you want to add
the contact to. When creating a contact you must select a service that mates
the service your contact is using.
For example if your contact’s address ends in “@googlemail.com” then you
will need to add it to an account that ends in “@googlemail.com.” Likewise if
the contact’s email ends in “@hotmail.com” then you would need to add it to
an account ending in “@hotmail.com.”
Aer oosing the account you wish to add the contact to, you will need to
enter their login , their username, their screen name or their email address
in the Identiﬁer text ﬁeld.
en, in the Alias text ﬁeld, enter the name that you would like to see it in
your contact list. Cli Add to add the contact to your list of contacts.
Removing a contact
Cli on the contact that you want to remove and then open the Edit menu,
then oose Contact, then Remove. is will open the “Remove contact”
window.
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Cli on the Remove buon to conﬁrm that you want to remove a contact,
or cli Cancel to keep the contact.

Communicating with contacts
Text
To communicate with a contact, select the contact in Empathy’s main window
and double-cli their name. Empathy should open a new window where you
can type messages to your contact, and see a record of previously exanged
messages.
To send a message to the contact, type your message in the text ﬁeld below
the conversation history.
When you have typed your message press the Enter key to send the message to your contact. If you are communicating with more than one person
then all of the conversations will be shown in tabs within the same window.
Audio
If your contact has audio capabilities then there will be an icon of a microphone next to their name. Cli on the microphone icon to open a popup
menu. Choose the Audio call option from the menu. Empathy should then
open the “Call” window.
is window shows your picture on the right and your contact’s picture
on the le. Ensure that your microphone and speakers are connected, and
proceed with the audio conversation. You can ﬁnish the conversation by
cliing on the Hang up buon.
Video
If your contact has video at capabilities then there will be an icon of a
webcam next to their name. Cli on the icon to open a popup menu. Choose
the Video call option from the menu. Empathy should then open the “Call”
window.
is window shows your webcam view in the top right and your contact’s
webcam will be in the middle.
If you don’t have a webcam then your picture will be shown instead. You
can ﬁnish the call by cliing on the Hang up buon.

Sending and receiving files
Sending a file
When you are in a conversation with a contact and you would like to send
them a ﬁle, open the Contact menu and then oose Send ﬁle.
Empathy should open the “Select ﬁle” window. Find the ﬁle that you wish

  

to send and cli on the Send buon. A “File Transfers” window will open
showing the osen ﬁle and its transfer progress.
When the ﬁle transfer is complete, you can close the “File Transfers” window.
Receiving a file
When a contact wants to send you a ﬁle, the status icon to the le of the
contact’s name will ﬂash with an icon of a paper plane.
To receive the ﬁle double-cli the contact’s name. Empathy will open
the “Select a destination” window. Choose a location where you would like
Empathy to save the ﬁle, and cli Save. Empathy should open the “File
Transfers” window.
e “File Transfers” window shows you the progress of current ﬁle transfers. You can stop ﬁle transfers by cliing on the Stop buon, open transferred ﬁles by cliing on the Open buon, and clear the list of completed
transfers by cliing on the Clear buon.

Changing your status
You can use your status to show your contacts how busy you are or what you
are doing. You can use the standard statuses, whi are “Available,” “Busy,”
“Away,” “Invisible,” and “Oﬀ-line.” ese can be anged in the main Empathy
window from the drop-down list at the top of the window.
e same drop-down list lets you set a custom status by oosing “Custom
Message…” next to the icon that mates your status. Type what you would
like your status to say, and cli on the green e mark.

Changing your picture
Your picture is what your contacts will see next to your name in their contact
list. e default picture is the outline of a person. You can ange your picture
by opening the Edit menu, then oosing Personal Information.
Empathy should open the “Personal Information” window. From the Account drop-down list oose the account that you want to ange, then cli
on the picture on the right hand side of the window.
Empathy should open the “Select Your Avatar Image” window. Find the ﬁle
containing your picture, and cli Open. If you would like to return it to the
default avatar, cli on the No Image buon instead.

Desktop Sharing
Desktop sharing is a very niy feature available with Ubuntu. It can be used
for a lot of purposes like troubleshooting, online meetings or just showing oﬀ
your cool desktop to your friend. It is very easy to get remote desktop sharing
working between two Ubuntu maines.
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. Cli on System ‣ Preferences ‣ Remote Desktop and ti Allow remote desktop. It is recommended you add a password, for security reasons.
. Open Empathy and login using your Google/Jabber client 
. Double cli on the user whom you want to share your desktop with
. From the new window, cli on Contact ‣ Share your desktop.

Microblogging
You can connect several microblogging services by opening the Applications
menu, then oosing Internet and then Gwibber Social Client. Until you add
accounts, the “Social Accounts” window will open.
Aer you have added accounts you will see the “Social broadcast messages” window.
In this window in the Add new drop-down list you can oose from Digg,
Twier, StatusNet, Ping.fm, Qaiku, Facebook, FriendFeed, Buzz, Flir, and
Identi.ca.
Figure .: Gwibber lets you add many
diﬀerent account types.

MeMenu
If you cli your name in the top panel, you will see the “MeMenu,” in the box
below your name you can type a message to post on the sites that you have
set up with Gwibber.
You can also ange your account seings by cliing Broadcast Accounts…, this opens the “Broadcast Accounts” window.

Changing accounts
To add more accounts aer you have already added some. Cli Edit then
Accounts, the “Social Accounts” window will open.
Adding accounts
In the “Social Accounts” cli Add…, ea account will need you to enter your
account details. e details that you require for ea account is detailed as
follows:

  

Digg: A login  is all that is required for Digg.
Twitter: Requires a user name and password.
StatusNet: A login , domain and password are needed.
Ping.fm: A login  and a remote key are required. You can ﬁnd your key
at http://ping.fm/key.
Qaiku: You will need your login  and an  key. Instructions are provided in the Gwibber window.
Facebook: Cli Authorize, then enter your email address and password
and cli Connect.
If you want to be able to post on Facebook from Gwibber, cli Allow
publishing, otherwise cli Don’t allow.
If you want Gwibber to show your news feed, cli Allow access, otherwise cli Don’t allow.
If you want status updates, cli Allow status updates, otherwise, cli
Don’t allow.
In order for Gwibber to interact with Facebook ea time it is used, it will
need to have constant authorization. If not, you will have to authorize it ea
time you use it. To allow constant authorization cli Allow.
FriendFeed: You will need a login  and a remote key for friend feed.
Gwibber provides information on where to get one.
Buzz: Cli Authorize, then enter your email address and password and
cli Add.
Flir: All you need is your account login .
Identi.ca: A login  and password are required for Identi.ca.
Removing accounts
In the “Broadcast Accounts” window cli the account that you want to remove and cli Remove.

How Gwibber displays accounts
Gwibber allows you to post to either all, one or a selection of accounts. is
can be set at the boom of the “Social broadcast message” window—ea of
the accounts that you can post with will have an icon. Cliing on an icon so
that it is disabled (appears gray) means that you will not post to that account.
Once you have decided on whi accounts you want to post to you can
type your message in the text ﬁeld above the icons, then cli Send.
Ea one of your accounts will have a set of icons to go with it. ese icons
are displayed on the le hand size of the “Social broadcast message” window.
e set of icons that goes with an account has a baground color. Selecting
ea one of these icons allows you to do tasks for that speciﬁc account.
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Viewing and Editing Photos
To view and edit photos in Ubuntu, you can use the Shotwell Photo Manager
application. To start Shotwell, open the Applications menu, then oose
Graphics, then Shotwell Photo Manager. When you start Shotwell for the
ﬁrst time, you will see the “Import” window—how to use this is covered in
‘Importing’.
By default, Shotwell displays your photos by date. You can view photos
from a speciﬁc month or year by cliing in the sidebar on the le.
You can also play slide shows of your pictures by cliing on the Slideshow
buon on the toolbar at the boom of the screen.
Figure .: Shotwell lets you store, tag, and
edit your photos.

Importing
When you laun Shotwell for the ﬁrst time you will see the “Import” window. Aer the ﬁrst laun you can import more photos by cliing File, then
Import from folder.
You can also import photos from F-Spot, whi was the default photo
manager in Ubuntu .. To do this, cli File and then Import from FSpot. Browse to the F-Spot database ﬁle (usually /home/<user>/.gnome/fspot/photos.db) and cli OK.
Choosing where Shotwell saves photos
When importing pictures in the “Import” window, you will be given the
option to copy photographs across to your Pictures folder, or just create links
so the actual photos aren’t duplicated.

  



If you have your photos stored on your hard drive then the option Create
Links will be suitable so photos aren’t duplicated. If you are importing photos
from an external source, su as a portable hard drive,  memory sti
or a , you should select Copy into Library so the photos are saved on
your computer—otherwise they won’t appear when you remove the external
source.
From digital camera
To import photos from a digital camera, plug your camera into the  port of
your computer, and turn your camera on. If your camera is detected, Ubuntu
should open a new window prompting you to import photos. Ensure that
Open Shotwell Photo Manager is osen in the drop-down list and cli OK.
is will show the “Import” window.
When Shotwell opens, it will be focused on the Camera view, as denoted
by the sidebar. To import your photos, select individual photos by pressing
and holding Control and cliing on ea photo you want to import, and then
cliing Import Selected. Or, you can oose to import all photos by cliing
Import All.

Organizing photos
Shotwell makes ﬁnding photos of the same type easier by using tags. You can
apply as many tags to a photo as you like.
To apply tags to photos, ﬁrst select the photos. en right-cli on the
photos and oose Add Tags. Type the tags you want into the text ﬁeld,
separated by commas. If you are adding new tags, these will appear in the
side bar on the right underneath the heading “Tags.”

Editing images
You may want to edit some of the photos you import into Shotwell. For example, you may want to remove something at the edge, some discoloring, ﬁx red
eyes, or straighten a photo. To edit a photo, double-cli on the photo that you
want to edit and then cli on one of the following buons.
Rotate
Cli Rotate to rotate the image clowise  degrees. You can cli the button more than once and it will rotate the image a further  degrees for ea
cli.
Crop
You might want to crop a photo to ange the framing or remove part of the
edge of the photo. Cli Crop on the boom toolbar. A selection will appear

Select Always perform this action to
have Shotwell automatically selected in the
future.
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on the main photo. To move the selection around, cli and drag it. To resize
the selection, cli and drag a corner or side.
You can select an aspect ratio constraint by using the drop-down list that
appears near the boom of the photo. It’s also possible to set your own custom ratio. To do this, select Custom from the drop-down list and enter your
desired ratio into the two text ﬁelds that appear.
Once you are happy with the selection, cli OK to apply the crop or
Cancel to discard it.
Red-eye reduction
If you have taken a photo and the ﬂash caused the subject to have red eyes,
you can ﬁx this problem in Shotwell.
. Cli the Red-eye buon. A circle will appear.
. Drag this circle over one of the subjects eyes and then use the slider at the
boom of the screen to adjust the circle size.
. When the circle is over the eye, cli Apply to ﬁx the red eye.
You will need to repeat this for ea individual eye.
Adjust
Cliing Adjust will bring up a window that lets you edit a few things:
‣
‣
‣
‣
‣
‣

Levels: similar to contrast
Exposure: how bright the image is
Saturation: how colorful the image is
Tint: the overall color
Temperature: whether the image is warm or cool
Shadows: how dark the shadows are

To ange these values, drag the sliders until you are happy with the image. Cli OK to apply the anges, Reset to undo the anges and start over,
or Cancel to discard the anges.
Enhance
If you cli Enhance, Shotwell will aempt to automatically adjust the color,
levels, exposure, contrast and temperature to make a more pleasing image.
Reverting an edited photo to the original
When you edit a photo, Shotwell automatically creates a new version so that
the original is not lost.
You can revert to the original version of photos by right-cliing on the
photo that you wish to view, then selecting Revert to Original. is option is
only available for photos you have edited.

  



Further information
We’ve only just toued on the features of Shotwell. To get more help, cli
Help and oose Contents or User Manual. e User Manual option will
take you to http://trac.yorba.org/wiki/UsingShotwell. whi gives detailed
instructions on how to use Shotwell eﬀectively.

Watching videos and movies
To wat videos or s in Ubuntu, you can use the Movie Player application.
To start the Movie Player, open the Applications menu, then oose Sound &
Video, then oose Movie Player. is will open the “Movie Player” window.
Figure .: Totem plays music and videos.

Codecs
Wating s may require Ubuntu to install a “codec,” whi is a piece of
soware that allows your computer to understand the contents of the ,
and display the video.
Legal Notice: Patent and copyright laws operate diﬀerently depending on whi
country you are in. Please obtain legal advice if you are unsure whether a particular patent or restriction applies to a media format you wish to use in your
country.

So that you can play all videos and s, you will need to install some
codecs. ese are located within the Multiverse repository. is is now
enabled by default.
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To install the codecs, open the Applications menu, then oose Ubuntu
Soware Center. When the “Ubuntu Soware Center” window opens, use
the sear box in the top right and sear for the following:
‣
‣
‣
‣
‣
‣
‣
‣
‣

gstreamer.-ﬀmpeg
gstreamer.-plugins-bad
gstreamer.-plugins-bad-multiverse
gstreamer.-plugins-ugly
gstreamer.-plugins-ugly-multiverse
gstreamer.-plugins-base
gstreamer.-plugins-good
libdvdread
libdvdnav

When you ﬁnd ea one, select it with a double-cli and then cli the
Install buon. is may open an “Authenticate” window. If so, enter your
password then cli Authenticate to start the installation process.
To ﬁnish codec installation, you also need to run a command in the terminal. Open the Applications menu, then oose Accessories and then oose
Terminal. is will open the “Terminal” window.
Type the command as shown below.
$ sudo /usr/share/doc/libdvdread4/install-css.sh

Once you have typed the command, press Enter. You will be asked for
your password—to authorize this action, type in you password and press
Enter. Wait for the process to ﬁnish. Once it has ﬁnished you can close the
“Terminal” window.

Playing videos from file
Open the Movie menu, then oose Open…. is will open the “Select Movies
or Playlists” window. Find the ﬁle or ﬁles that you want to play and cli on
the Add buon. e video or videos will start playing.

Playing a DVD
When you insert a  in the computer, Ubuntu should open the “You have
just inserted a Video . Choose what application to laun” window. Make
sure that Open Movie Player is osen in the drop-down list and then cli
OK. e “Movie Player” window will open and the movie will start.
If the “Movie Player” window is already open, open Movie menu, then
oose Play Disc… and the movie will start.

For more information on the terminal see
Chapter : Advanced Topics.

Sudo is a way to gain temporary administrative rights to perform certain tasks, such
as installing new soware. Usually, sudo is
presented in a window for you to enter your
password. When you enter your password
in a terminal, it will not be shown.

  

Listening to audio and music
Ubuntu comes with the Rhythmbox Music Player for listening to your music,
streaming Internet radio, managing playlists and podcasts, and purasing
songs.

Starting Rhythmbox
To start Rhythmbox, open the Applications menu, then oose Sound &
Video, then Rhythmbox Music Player. Ubuntu . comes with an updated
indicator menu for sound-related devices. is new menu includes a link to
start Rhythmbox as well as playba and volume controls.
To quit Rhythmbox, oose Music ‣ it or press Ctrl+Q. Rhythmbox will
continue to run if you oose Music ‣ Close or close the window.

Playing music
Figure .: Rhythmbox with a  in.

In order to play music, you must ﬁrst import music into your library.
Choose Music ‣ Import Folder or press Ctrl+O on your keyboard to import a
folder of songs or Import File for single songs.
e Rhythmbox toolbar contains most of the controls that you will use for
browsing and playing your music.
If you want to play a song, select a tra and cli on the Play buon on
the toolbar (you can also oose Control ‣ Play from the menubar or press
Ctrl+Space). Cliing on the Play buon again will pause the song.
Next and Previous buons are next to the Play buon. You can cli on
these buons to play the next and previous songs in your library.
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e Rhythmbox toolbar also has options to enable or disable Repeat
(Control ‣ Repeat or Ctrl+R), Shuﬄe (Control ‣ Shuﬄe or Ctrl+U), the
Artist/Album browser (View ‣ Browse or Ctrl+B), and Visualization.
When you insert a  into your computer, it will appear in the list of
Devices in the Side Pane. Select the  in the Devices list. Enable and disable
the Side Pane by oosing View ‣ Side Pane or F9. Rhythmbox will aempt
to ﬁnd the correct artist, album, and tra names. To play the songs on the ,
oose the tra and press Play.
To import the songs into your library, select the  in the Devices list. You
can review information about the , make any anges if needed, or deselect
songs that you do not want to import. e toolbar will display additional
options to reload album information, eject the , and copy the tras to
your library. Press the Copy buon to import the songs.

Listening to streaming radio
Rhythmbox is preconﬁgured to enable you to stream radio from various
sources. ese include Internet broadcast stations (Radio from the Side Pane)
as well as Last.fm. To listen to an Internet radio station, oose a station
from the list and cli Play. To listen to music from Last.fm, conﬁgure your
Account Settings.

Streaming radio are radio stations that are
broadcast over the Internet.

Connect digital audio players
Rhythmbox can connect with many popular digital audio players. Connected
players will appear in the Devices list. Features will vary depending on the
player but common tasks like transferring songs and playlists should be supported.

Listen to shared music
If you are on the same network as other Rhythmbox users (or any music
player soware with  support), you can share your music and listen to
their shared music. Choose Shared from the Side Pane for a list of shared libraries on your network. Usually shares will be listed automatically but sometimes you will be required to add the IP manually. To do this cli Music ‣
Connect to DAAP share…. en enter the IP address and the port number.
en cli Add. Cliing a shared library will enable you to browse and play
songs from other computers.

Manage podcasts
Rhythmbox can manage all of your favorite podcasts. Select Podcasts from
the Side Pane to view all added podcasts. e toolbar will display additional
options to Subscribe to a new Podcast Feed and Update all feeds. Choose
Music ‣ New Podcast Feed, Ctrl+P, or press the Subscribe buon in the

 stands for “Digital Audio Access
Protocol,” and is a method designed by
Apple Inc. to let soware share media
across a network.

  

toolbar to import a podcast . Podcasts will be automatically downloaded
at regular intervals or you can manually update feeds. Select an episode and
cli Play. You can also delete episodes.
Figure .: You can add and play your
podcasts in Rhythmbox.

Rhythmbox preferences
e default conﬁguration of Rhythmbox may not be exactly what you want.
Choose Edit ‣ Preferences to alter the application seings. e Preferences
tool is broken into four main areas: General, Playba, Music, and Podcasts.
‣ General options include music ﬁltering and sorting options and a conﬁguration seing for toolbar buon labels.
‣ Playba options allow you to customize the crossfading feature and
deﬁne the buﬀer seing for streamed music from sources su as Internet
radio and shared libraries.
‣ Music options deﬁne the Library Location on your computer where
imported music is added, the Library Structure of how folders are created
based on your imported music, and the Preferred format for imported
music.
‣ Podcasts options deﬁne the Download location podcast episodes and the
frequency to Che for new episodes.

Managing your music
Rhythmbox supports creating playlists. Playlists are either static lists of songs
that are played in order or can be automatic playlists based on your speciﬁc
ﬁlter criteria. Playlists contain references to songs in your library. ey do
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not contain the actual song ﬁle. If you remove a song from a playlist (Remove
from Playlist), it will remain in your library.
To create a playlist, oose Music ‣ Playlist ‣ New Playlist or Ctrl+N and
give the new playlist a name. You can then either drag songs from you library
to the new playlist in the side pane or right-cli on songs and oose Add to
Playlist and pi the playlist.
Automatic Playlists are created almost the same way as static playlists
—oose Music ‣ Playlist ‣ New Automatic Playlist. Next, deﬁne the ﬁlter criteria. You can add multiple ﬁlter rules. Finally, cli Close and give
the new automatic playlist a name. Automatic Playlists will appear in your
side pane with a diﬀerent icon than any static playlists. You can update any
playlist by right-cliing on the name and oosing Edit….
Rhythmbox supports seing song ratings. Select a song in your library and
oose Music ‣ Properties, Alt+Enter, or right-cli on the ﬁle and oose
Properties. Select the Details tab and set the rating by piing the number
of stars. Other song information su as Title, Artist, and Album can be
anged from the Basic tab. Cli Close to save any anges.
To delete a song, select it in your library and oose Edit ‣ Move to Trash
or right-cli on the song and oose Move to Trash. is will move the song
ﬁle to your trash.
If you ever want to move a song (for example to another computer), oose
the song (or group of songs) from your library and drag it to a folder or to
your desktop. is will make a copy in the new location.

Rhythmbox plugins
Rhythmbox comes with a variety of plugins. ese are tools that you can
enable and disable that add more features to Rhythmbox. Examples include
Cover art, Song Lyrics, and various music stores. A few plugins are enabled
by default.
To view the list of available plugins, oose Edit ‣ Plugins. e Conﬁgure
Plugins window allows you to enable or disable individual plugins, view
descriptions, and conﬁgure additional options if they are available for the
plugin.

Music stores
Rhythmbox has three music stores whi give you access to an extremely
large catalog of music with a variety of licensing options.
e Jamendo store sells free, legal and unlimited music published under
the six Creative Commons licenses. You can browse the catalog and play
songs by oosing Jamendo in the Stores list in the side pane. More information about their catalog can be found at http://www.jamendo.com/.
e Magnatune store sells music from independent musicians. ey work
directly with artists and hand-pi the songs available. eir catalog is com-

  

posed of high quality, non- (no copy protection) music and covers a
variety of genres from Classical and Jazz to Hip Hop and Hard Ro. You
can browse the catalog and play songs by oosing Magnatune in the Stores
list in the side pane. More information about their catalog and subscription
service can be found at http://www.magnatune.com/.
e Ubuntu One Music Store sells music from major and minor music
labels around the world. e store oﬀers non- (no copy protection) songs
encoded in either high quality  or  format. Ubuntu does not come
with support for  playba, but the store will install the proper codecs
automatically for free. You can browse the catalog, play previews, and buy
songs by oosing Ubuntu One in the Stores list in the side pane.
e Ubuntu One Music Store integrates with the Ubuntu One service. All
purases are transferred to your personal cloud storage and then automatically copied to all of your computers so an Ubuntu One account is required.
e catalog of music available for purase will vary depending on where you
live in the world. More information about the Ubuntu One Music Store can be
found at http://one.ubuntu.com/.

Audio codecs
Diﬀerent audio ﬁles (e.g., , , ) require unique tools to decode them
and play the contents. ese tools are called codecs. Rhythmbox will aempt
to detect any missing codecs on your system so you can play all of your audio
ﬁles. If a codec is missing, it will try to ﬁnd the codec in online resources and
guide you through installation.

Rhythmbox support
Rhythmbox is used by many users throughout the world. ere are a variety
of support resources available in many languages.
‣ Choose the Help buon for a variety of support options and information
about reporting Rhythmbox bugs.
‣ e Rhythmbox website: http://projects.gnome.org/rhythmbox/
‣ e Multimedia & Video category of Ubuntu Forums: http://ubuntuforums.
org/forumdisplay.php?f=

Working with documents, spreadsheets, and presentations
ite oen, you may need to use your computer for work. You may have a
need to use a word processor to write a document. You may need to work on
a spreadsheet, do calculations on a table of data or create a data art. You
may want to work on slides for a presentation.
In Ubuntu, you can use the OpenOﬃce.org suite of applications for these
tasks.
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Working with documents
If you need to work with documents, you can use the OpenOﬃce.org Word
Processor. To start the word processor, open the Applications menu, oose
Oﬃce, and then oose OpenOﬃce.org Word Processor. Ubuntu should
then open the main window for the word processor.

Working with spreadsheets
If you need to work with spreadsheets, you can use the OpenOﬃce.org
Spreadsheet. To start the spreadsheet application, open the Applications
menu, oose Oﬃce, and then oose OpenOﬃce.org Spreadsheet.

Working with presentations
If you need to work with slides for a presentation, you can use the OpenOfﬁce.org Presentation. To start the presentation application, open the Applications menu, oose Oﬃce, and then oose OpenOﬃce.org Presentation.

Geing more help
Ea of these applications comes with a comprehensive set of help screens. If
you are looking for more assistance with these applications, press the F1 key
aer starting the application.

Taking notes
You can take notes in a program called Tomboy Notes. You can use it to make
a shopping or a to do list. Cli Applications, then cli Accessories and cli
Tomboy Notes.
You can sear all of your notes by typing a word in the Sear: text ﬁeld
in the main tomboy window.

Making notes
To create a new note cli File, then cli New. e “New Note” window will
open.
e “New Note” window will contain a blue title “New Note”—this can
be deleted and anged to a title that makes the note more memorable. e
main content of the note can be typed where it says “Describe your new note
here.” Once you have entered your text just close your note as all anges are
automatically saved.
To delete the note cli the red delete note buon. is will open a “Really
delete this note?” window. If you do want to delete the note cli the Delete
buon, otherwise cli the Cancel buon.
You can add a note to a notebook by cliing the Notebook buon and
cliing the option next to the notebook that you want to move the note to.

The OpenOﬀice.org Word Processor is
also known as the OpenOﬀice.org Writer.
Spreadsheet is also known as Calc, and
Presentation is known as Impress.

  



Figure .: You can record information that
you need to remember.

Organizing notes
You can organize your notes in Tomboy using “Notebooks.” is makes ﬁnding you notes quier and in a more logical location. To create a new note
book cli File, then Notebooks, and cli New Notebook….
e “Create a new notebook” window will open, type the name of the
notebook in the Notebook name: text ﬁeld. Once you have typed the notebook name cli the Create buon.
e notebook will now show up in the sidebar of Tomboy Notes. You can
cli and hold on the note of your oice and drag it on top of the notebook
that you want to move it to.

Synchronizing
You can synronize your notes with your Ubuntu One account, whi means
that you can access them across all of your Ubuntu computers. You can also
access them from https://one.ubuntu.com/.
To synronize your notes cli the Edit. en cli Preferences. is will
open the “Tomboy Preferences” window. Cli the Synronization tab and
then in the Service drop down cli Tomboy Web.
Next cli the Connect to Server buon. is will open a web page in
Firefox you will need to enter the email address that you use for Ubuntu One
and your password. en cli the Continue buon, then in the Computer
Name text ﬁeld enter a name that reminds you of that computer and cli
the Add is Computer buon. Firefox will then display a page that says
something similar to “Tomboy Web Authorization Successful.”
Ba at the “Tomboy Preferences” window cli the Save buon. A new
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window will pop up asking if you want to “synronize your notes now.”
Cli the Yes buon and the “Synronizing Notes…” window will show.
Once the synronization is complete cli the Close buon.
If you want to synronize the notes again cli Tools and cli Synronize Notes. Your notes will start synronizing. When they are done, cli the
close buon.

Ubuntu One
Ubuntu One is your personal cloud. Synronizing your ﬁles between your
computer and the cloud is only one part of the service. Ubuntu One also includes a variety of other features that will help bring your digital life together.
ese include a cloud integrated music store included in Rhythmbox - the
Ubuntu One Music Store - and paid services su as streaming your music
from your personal cloud to iPhone and Android mobile phones.
A key aspect of Ubuntu One is synronization or ‘sync’. is means that
anges made on the computer you are currently using are copied up to your
personal cloud storage. If you start using another one of your computers,
these anges are automatically copied down from your personal cloud.
Whenever you make more anges, the updated ﬁle is copied up to the cloud
and then down to your other computers.
You should be conﬁdent that you always have the most recent copy of
a document or note. You also don’t have to be dependent on an alwayson Internet connection. Since a copy of the ﬁle is always kept on the local
computer, you have the ability to work on anything while you are oﬄine.
If you have an Internet connection but are away from your computer, the
Ubuntu One website (http://one.ubuntu.com/) provides some helpful tools.
In addition to uploading, sharing, and deleting ﬁles, you can manage your
contacts, notes, and soon, bookmarks that are stored in your personal cloud.
In addition to things like documents, spreadsheets, music and photos,
Ubuntu One can synronize your Evolution address book contacts, Tomboy
notes, and Firefox bookmarks. Whether you have one computer or many,
Ubuntu One simpliﬁes the frequently diﬃcult task of staying organized with a
solution that gives you greater access to your important information.
As part of the Ubuntu One Basic plan, Ubuntu One provides all Ubuntu
users with   of storage for free. is can be used for any combination of
ﬁles, notes, address book contacts, and bookmarks. Aer you set up Ubuntu
One, you can continue to use your computer as you normally would. In the
baground, the Ubuntu One soware will take care of synronizing all of
your data.
Other add-ons like more storage capacity are available for a monthly fee
from the Ubuntu One website. Refer to http://one.ubuntu.com/ for more
information.

  

Seing up Ubuntu One
To set up Ubuntu One, ﬁrst open the System menu, then oose Preferences,
then Ubuntu One. If this is your ﬁrst time running the Ubuntu One Preferences application, it will guide you through the process of adding your
computer to sync with your Ubuntu One personal cloud.
Ubuntu One uses the Ubuntu Single Sign On () service for user accounts. An Ubuntu  account is the same thing as an Launpad account. If
you already have an Ubuntu  account, follow the instructions to log-in. If
you don’t already have an Ubuntu  account, the setup process will let you
create one. When you’re ﬁnished, you will have an Ubuntu  account, a free
Ubuntu One subscription, and your computer will be setup for synronization.
Ea time you would like to add another one of your computers to sync
with your personal cloud just laun the Ubuntu One application and oose
to log-in using your Ubuntu  account when prompted.

Ubuntu One Preferences
e Ubuntu One Preferences application shows how mu of your storage capacity you are currently using as well as provides some account management
tools and links to website resources.
e Account tab displays your account information like name and email
address and links to more account management and tenical support resources.
e Devices tab lists all of the devices that are currently added to synronize with your account. For the computer that you are currently using, you
can adjust how mu of your bandwidth is used by synronization and connect or reconnect to Ubuntu One. You can also remove computers from your
Ubuntu One account in this area.
e Services tab is where you manage whi aspects of your computer you
would like to synronize with your cloud storage and other computers. You
can enable or disable the synronization of ﬁles, purased music, contacts,
and bookmarks.

More information
For more information about Ubuntu One, its services, and support resources,
visit the Ubuntu One website at http://one.ubuntu.com/. You can also follow
the Ubuntu One blog at http://one.ubuntu.com/blog to get the latest news.





Hardware

Using your devices
Ubuntu supports a wide range of hardware, and support for new hardware
improves with every release.

Hardware identification
To identify your hardware you can install the following application: Cli
Applications, scroll down to Ubuntu Soware Center. When the “Ubuntu
Soware Center” window opens, use the sear box in the top right and
sear for the following: “sysinfo.” Now select the Application cli Install
and enter your password to install the application.
To run the application, oose Applications ‣ System Tools ‣ Sysinfo.
e Sysinfo program will then open a window with information about the
hardware that is part of your system.

Displays
Hardware drivers
A driver consists of code that is paaged in a ﬁle, whi tells your computer
how to communicate with a piece of hardware. Every component in a computer requires a driver to function, whether it’s the printer,  player, hard
disk, or graphics card.
A majority of graphics cards are manufactured by three well known companies: Intel, /, and  Corp. You can ﬁnd your video card manufacturer by referring to your computer’s manual, looking for the speciﬁcations
of your particular model on the Internet, or by using the command lspci in
a terminal. e Ubuntu Soware Center houses a number of applications that
can tell you detailed system information. SysInfo is one su program that
you can use to ﬁnd relevant information about your System devices. Ubuntu
comes with support for graphics devices manufactured by the above companies, and many others, out of the box. at means you don’t have to ﬁnd and
install any drivers by yourself, Ubuntu takes care of it all.
Keeping in line with Ubuntu’s philosophy, the drivers that are used by
default for powering graphics devices are open source. is means that the
drivers can be modiﬁed by the Ubuntu developers and problems with them
can be ﬁxed. However, in some cases a proprietary driver (restricted driver)
provided by the company may provide beer performance or features that are
not present in the open source driver. In other cases, your particular device

Your graphics card is the component
in your computer that outputs to the
display. When you’re watching videos on
YouTube, viewing s, or simply enjoying
the smooth transition eﬀects when you
maximize/minimize your windows, your
graphics device is doing the hard work
behind the scenes.
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may not be supported by any open source drivers yet. In those scenarios, you
may want to install the restricted driver provided by the manufacturer.
For both philosophical and practical reasons, Ubuntu does not install
restricted drivers by default but allows the user to make an informed oice.
Remember that restricted drivers, unlike the open source drivers for your
device, are not maintained by Ubuntu. Problems caused by those drivers will
be resolved only when the manufacturer wishes to address them. To see if
restricted drivers are available for your system, cli System in the top panel,
go to Administration and ﬁnd Additional Drivers. If a driver is provided by
the company for your particular device, it will be listed there. You can simply
cli Activate to enable the driver. is process requires an active Internet
connection and it will ask for your password. Once installation is complete
you may have to reboot your computer to ﬁnish activating the driver.
e Ubuntu developers prefer open source drivers because they allow
any problem to be identiﬁed and ﬁxed by anyone with knowledge in the
community. Ubuntu development is extremely fast and it is likely that your
device will be supported by open source drivers. You can use the Ubuntu Live
 to e your device’s compatibility with Ubuntu before installing, or go
online to the Ubuntu forums to ask about your particular device.

Seing up your screen resolution
One of the most common display related tasks is seing your screen resolution.
Ubuntu correctly identiﬁes your native screen resolution by itself and sets
it for you. However, due to a wide variety of devices available, sometimes it
can’t properly identify your resolution.
To set or e your screen resolution, go to System ‣ Preferences ‣
Monitors. e Monitors application shows you your monitor’s name, size,
screen resolution, and refresh rate. Cliing on the displayed resolution (e.g.,
“× (:)”) would open a drop-down menu where you can select the
resolution of your oice.

Adding an extra display
You may like to add more than one display device to your computer, doing
this is quite simple. Whether it’s an extra monitor, LCD TV, or a projector,
Ubuntu can handle it. Ubuntu supports the addition of multiple displays by
default, whi is as easy as plug and play. Ubuntu recognizes almost all the
latest monitors, TVs and projectors by default. Sometimes it may happen that
your additional display is not detected when you connect it to the maine.
To resolve this, go to System ‣ Preferences ‣ Monitors and cli on Detect
Monitors. is will detect the displays connected to the maine. Now, there
are two modes whi you can enable for your displays. One option is to
spread your desktop across two or more monitors. is is particularly useful if

Another useful resource is the oﬀicial online
documentation (http://help.ubuntu.com),
which contains detailed information
about various graphics drivers and known
problems. This same documentation can be
found by going to System and clicking Help
and Support.

Displays are made up of thousands of
tiny pixels. Each pixel displays a diﬀerent
color, and when combined they all display
the image that you see. The native screen
resolution is a measure of the amount of
actual pixels on your display.

 

you are working on multiple projects and need to keep an eye on ea of them
at the same time. e second option is to mirror the desktop onto ea of the
displays. is is particularly useful when you are using a laptop to display
something on a larger screen or a projector. To enable this option just e
the box beside Same image in all monitors ‣ Cli apply to save the seings.
You will get a pop-up notiﬁcation asking if you want to keep the current
seing or revert to the previous seing. Cli to keep current seing.

Connecting and using your printer
You can add, remove, and ange printer properties by navigating to System ‣
Administration ‣ Printing. is will display the “Printing-localhost” window.
When you want to add a printer, you will need to make sure that it
swited on, and plugged into your computer with a  cable or connected to
your network.

Adding a local printer
If you have a printer that is connected to your computer with a  cable then
this is termed a local printer. You can add a printer by cliing on the Add
Printer buon.
In the le hand pane of the “New Printer” window any printers that you
can install will be listed. Select the printer that you would like to install and
cli Forward.
You can now specify the printer name, description and location. Ea of
these should remind you of that particular printer so that you can oose the
right one to use when printing. Finally, cli Apply.

Adding a network printer
Make sure that your printer is connected to your network with an Ethernet
cable and is turned on. You can add a printer by cliing Add Printer. e
“New Printer” window will open. Cli the “+” sign next to Network Printer.
If your printer is found automatically it will appear under Network Printer.
Cli the printer name and then cli Forward. In the text ﬁelds you can
now specify the printer name, description and location. Ea of these should
remind you of that particular printer so that you can oose the right one to
use when printing. Finally cli Apply.
You can also add your network printer by entering the  address of the
printer. Select Find Network Printer, type in the  address of the printer
in the box that reads Host: and press the Find buon. Ubuntu will ﬁnd the
printer and add it. Most printers are detected by Ubuntu automatically. If
Ubuntu cannot detect the printer automatically, it will ask you to enter the
make and model number of the printer.

If your printer can automatically do double
sided printing it will probably have a
duplexer. Please refer to the instructions
that came with the printer if you are unsure.
If you do have a duplexer you will need to
make sure the Duplexer Installed option is
checked and then click the Forward buon.

The default printer is the one that is automatically selected when you print a file.
To set a printer as default, right-click the
printer that you want to set as default and
then click Set As Default.
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Changing printer options
Printer options allow you to ange the printing quality, paper size and media
type. ey can be anged by right-cliing a printer and oosing Properties. e “Printer Properties” window will show, in the le pane oose
Printer Options.
You can now specify seings by anging the drop-down entries. Some of
the options that you might see are explained.
Media Size
is is the size of the paper that you put into your printer tray.
Media source
is is the tray that the paper comes from.
Color Model
is is very useful if you want to print in Grayscale to save on ink, or to print
in Color, or Inverted Grayscale.
Media type
Depending on the printer you can ange between:
‣
‣
‣
‣
‣

Plain Paper
Automatic
Photo Paper
Transparency Film
 or  Media

Print quality
is speciﬁes how mu ink is used when printing, Fast Dra using the least
ink and High-Resolution Photo using the most ink.

Sound
Ubuntu usually detects the audio hardware of the system automatically during installation. e audio in Ubuntu is provided by a sound server named
PulseAudio. e audio preferences are easily conﬁgurable with the help of a
very easy to use  whi comes preinstalled with Ubuntu.
A volume icon, siing on the top right corner of the screen, provides
qui access to diﬀerent audio related functions. Le cliing on the volume icon shows up a slider buon whi you can move horizontally to increase/decrease volume. Le cliing on the volume icon also allows you to

 

oose between muting the sound, and accessing the Sound Preferences. Selecting Sound Preferences opens up another window whi provides access to
sound themes, hardware, input and output preferences. Sound Preferences can
also be found if you go to System ‣ Preferences ‣ Sound.
e ﬁrst tab whi shows up by default is Sound Eﬀects. You can disable
the existing sound theme or conﬁgure it with the options available.
e Hardware tab will have a list of all the sound cards available in your
system. Usually there is only one listed; however, if you have a graphics card
whi supports  audio, it will also show up in the list.
e third tab is for conﬁguring audio Input. You will be able to use this
section when you have an inbuilt microphone in your system or if you add an
external microphone.
You can increase/decrease and mute/unmute input volume from this tab. If
there is more than one input device, you will see them listed in the white box
whi reads Choose a device for sound input.
e Output tab is used for conﬁguring the output of audio. You can increase/decrease and mute/unmute output volume and select your preferred
output device.
If you have more than one output device, it will be listed in the section
whi reads “Choose a device for sound output.” e default output hardware,
whi is automatically detected by Ubuntu during installation will be selected.
e Applications tab is for anging the volume for running applications.
is comes in handy if you have multiple audio applications running, for
example, if you have Rhythmbox, Totem Movie Player and a web-based
video playing at the same time. In this situation, you will be able to increase/decrease, mute/unmute volume for ea application from this tab.
Until the last release, the icon’s functionality was limited to controlling
various aspects of the system and application volume. In this release, the icon
can control music players like Rhythmbox and Banshee. e volume indicator
icon can now be easily be referred to as the sound menu, given the diverse
functionality of the icon.
Once the player starts you can control the player from this menu. Functionalities available include play/pause, previous tra, and next tra. You
can also swit between diﬀerent playlists from the Choose Playlist option.
ere is also a seek bar whi you can manually drag to skip some portions of
any song. If the current playing song has album art, it will show up beside the
name of the current tra, otherwise you will see only the details of the song.
It displays the tra name, the artist name and the album name of the current
tra.

You can add new sound themes by installing
them from Soware Center (e.g., Ubuntu
Studio’s GNOME audio theme.) You will get
the installed sound themes from the drop
down menu. You can also enable window
and buon sounds.
A microphone is used for making audio/video calls which are supported by
applications like Skype or Empathy. It can
also be used for sound recording.
You should note that by default in any
Ubuntu installation, the input sound is
muted. You will have to manually unmute
to enable your microphone to record sound
or use it during audio/video calls.
By default, the volume in Ubuntu is set to
maximum during installation.
If you change your sound output device, it
will remain as default.

The Ubuntu Design Team have made a few
changes to the volume icon in this release of
Ubuntu ..

You can start the default music player,
Rhythmbox, by simply le clicking on the
sound menu and selecting Rhythmbox from
the list.
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Burning CDs and DVDs
To create a  or  go to Applications ‣ Sound and Video ‣ Brasero Disc
Burner. is opens Brasero, whi gives you ﬁve options to oose from.
Ea one of these is explained below.
Figure .: Brasero burns music, video, and
data s and s.

Universal options
ese options apply for all projects except Disc copy and Burn Image.

Geing Started
Before you can get started with Brasero, you need to “Create a new project.”
ere are three types of projects that are available to you: “Audio Project,”
“Data Project,” and “Video Project.” Make your selection based on whi you
require. Please note that at the moment Brasero does not support Blu-Ray.
Adding files to a project
To add ﬁles to the list, cli the Green + buon, whi opens the “Select Files”
window. en navigate your way to the ﬁle you want to add, cli it, and then
cli the Add buon. Repeat this process for ea ﬁle that you want to add.
Saving a project
To save a project so that you can ﬁnish it later, oose Project ‣ Save. e
“Save Current Project” window will be opened. Choose where you would like

 

to save the project. en, in the Name: text ﬁeld, enter a name for the project
so that you will remember it. Now cli the Save buon.
Removing files
If you want to remove a ﬁle from the project, cli the ﬁle in the list and cli
on the Red - buon. To remove all the ﬁles in the list cli on the Broom
shaped buon.

Icons of a broom are oen used in Ubuntu
to represent clearing a text field or returning
something to its default state.

Burning the disc
When you cli the burn buon you will see the “Properties of …” window.
You can specify the burning speed in the Burning speed drop down. It is
best to oose the highest speed.
To burn your project directly to the disc, select the Burn the image directly without saving it to disc option. With this option selected, no image
ﬁle is created and no ﬁles are saved to the hard disk.
e Simulate before burning option is useful if you encounter problems
burning discs. Selecting this option allows you to simulate the disc burning
process without actually writing data to a disc—a wasteful process if your
computer isn’t writing data correctly. If the simulation is successful, Brasero
will burn the disc aer a ten second pause. During that ten second pause, you
have the option to cancel the burning process.

Temporary files are saved in the /tmp folder
by default. Should you wish to save these
files in another location, you will need to
change the seing in the Temporary files
drop down menu. Under normal conditions,
you should not need to change this seing.

Blanking a disk
If you are using a disc that has  wrien on it and you have used it before,
then you can blank it so that you can use it again. Doing this will cause you
to lose all of the data currently on the disc. To blank a disc, open the Tools
menu, then oose Blank. e “Disc Blanking” window will be open. In the
Select a disc drop down oose the disc that you would like to blank.
You can enable the Fast blank option if you would like to shorten the
amount of time to perform the blanking process. However, selecting this
option will not fully remove the ﬁles; if you have any sensitive data on your
disc, it would be best not to enable the Fast blank option.
Once the disc is blank the you will see e disc was successfully blanked.
Cli the Close buon to ﬁnish.

Audio project
If you record your own music, then you may want to transfer this music onto
an audio  so your friends and family can listen. You can start an audio
project by cliing Project, then New Project and then New Audio Project.
So that ea ﬁle does not play straight aer ea other you can add a
two second pause aer a ﬁle. is can be done by cliing the ﬁle and then
cliing the || buon.

 stands for Re-Writable which means that
disc can be used more than once.
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You can slice ﬁles into parts by cliing the Knife buon. is opens a
“Split Tra” window. e Method drop down gives you four options ea
one of these lets you split the tra in a diﬀerent way. Once you have split the
tra cli OK.
In the drop down at the boom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the ﬁles to. en cli
the Burn buon.

Data project
If you want to make a ba up of your documents or photos it would be best
to make a data project. You can start a data project by cliing Project then
cliing New Project and then New Data Project.
If you want to add a folder you can cli the Folder picture, then type the
name of the folder.
In the drop down at the boom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the ﬁles to. en cli
the Burn buon.

Video project
If you want to make a  of your family videos it would be best to make
a video project. You can start a video project by cliing Project, then New
Project and then New Video Project.
In the drop down at the boom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the ﬁles to. en cli
the Burn buon.

Disc copy
You can copy a disc cliing Project, then New Project and then Disc copy.
is opens the “Copy /” window.
If you have two / drives you can copy a disc from one to the other,
the disc that you want to copy to must be in the / drive. If you
have only one drive you will need to make an image and then burn it to a
disc. In the Select disc to copy drop-down oose the disc to copy. In the
Select a disc to write to drop-down either oose image ﬁle or the disc that
you want to copy to.
Image file
You can ange where the image ﬁle is saved by cliing Properties, this
shows the “Location for Image File”. You can edit the name of the ﬁle in the
Name: text ﬁeld.
e default save location is your home folder, you can ange this by

 

cliing the + next to Browse for other folders . Once you have osen
where you want to save it cli Close.
Ba in the “Copy /” window cli Create Image. Brasero will open
the “Creating Image” and will display the job progress. When the process is
complete cli Close.

Burn image
To burn an image, open the Project ‣ New Project, and then Burn Image.
Brasero will open the “Image Burning Setup” window. Cli on the Cli here
to select a disc image drop-down and the “Select Disc Image” window will
appear. Navigate your way to the image you wish to burn, cli on it, and
then cli Open.
In the Select a disc to write to drop-down menu, cli on the disc to
whi you’d like to write, then cli Create Image.

Using a webcam
Webcams oen come built into laptops and netbooks. Some computers, su
as Apple desktops, have a webcam built into their display. If you purase a
webcam because your computer doesn’t have its own, it will most likely have
a  connection. To use a  webcam, plug it into an empty  port on
your computer.
Almost all new webcams are detected by Ubuntu automatically. You can
conﬁgure webcams for individual applications su as Skype and Empathy
from the application’s setup menu. For webcams whi do not work right
away with Ubuntu, visit https://wiki.ubuntu.com/Webcam for help.

Scanning text and images
Most of the time, Ubuntu will simply detect your scanner and you should just
be able to use it. To scan a document, follow these steps:
.
.
.
.
.

Place what you want to scan on the scanner.
Go to Applications ‣ Graphics ‣ Simple Scan.
Cli Scan.
Cli the Paper Icon to add a another page.
Cli Save to save.

Does my scanner work with Ubuntu?
ere are three ways to see if your scanner works in Ubuntu:
. Simply plug it in. If it is a newer  scanner, it is likely that it will just
work.

There are several applications which are
useful if you have a webcam. Cheese can
capture pictures with your webcam and
VLC media player can capture video from
your webcam. You can install these from the
Ubuntu Soware Center.
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. Che https://wiki.ubuntu.com/HardwareSupportComponentsScanners to
ﬁnd out whi scanners work with Ubuntu.
.  project listing of supported scanners. e  (Scanner Access Now
Easy) project provides most of the ba-ends to the scanning soware on
Ubuntu.

Ubuntu can’t find my scanner
ere are a few reasons why Ubuntu may give you a “No devices available
message”:
‣ Your scanner is not supported in Ubuntu. e most common type of scanner not supported is old parallel port or Lexmark All-in-One printer/scanner/faxes.
‣ e driver for your scanner is not being automatically loaded.

Other devices
USB
USB ports are available as standard on almost all computers available now.
ey are used to connect a multitude of devices to your computer. ese
could include portable hard drives, ﬂash drives, removable //Blu-ray
drives, printers, scanners and mobile phones. When connected, ﬂash drives
and portable hard drives are automatically detected—the ﬁle manager will
open and display the contents of the drive. You can then use the drives for
copying data to and from the computer. All new cameras, camcorders and
mobile phone SD cards are automatically detected by Ubuntu. ese SD cards
have diﬀerent types of data, so a window will appear with a drop down menu
to oose between video, audio import and the ﬁle manager—you can oose
your desired action from this menu.

Firewire
Firewire is a connection on some computers that allows you to transfer data
from devices. is port is generally used by camcorders and digital cameras.
If you want to import video from your camcorder you can do so by connecting your camcorder to the Firewire port. You will need to install a program called Kino whi is available in the Ubuntu Soware Center.

Bluetooth
Bluetooth is a wireless tenology that is widely used by diﬀerent types of devices to connect to ea other. It is common to see a mouse or a keyboard that
supports Bluetooth. You can also ﬁnd  devices, mobile phones, headsets,
music players and many other devices that can connect to your desktops or
laptop and let you transfer data, listen to music, or play games as an example.

Firewire is oﬀicially known as IEEE . It
is also known as the Sony i.LINK and Texas
Instruments Lynx
To find out more about Kino, visit http://
www.kinodv.org/.

 

If your computer has Bluetooth support then you should see a Bluetooth
icon in the top panel, usually near the volume icon. Cli on the Bluetooth
icon to open a popup menu with several oices, su as an option to Turn oﬀ
Bluetooth.
Figure .: The Bluetooth applet menu.

e Bluetooth preferences can also be accessed from System ‣ Preferences ‣
Bluetooth. If you want to connect a new device—for example, to have a mobile phone send pictures or videos to your computer—oose Setup new
device….
Ubuntu will open a window for new device setup. When you cli Forward, Ubuntu will show you how many Bluetooth devices are present near
your computer. e list of available devices might take a minute or so to appear on the screen as your system scans for these devices. Ea device will
be displayed as soon as it is found by Ubuntu. Once a device you’d like to
connect with appears in the list, cli on it. en, oose a  number by
selecting PIN options.
ree predeﬁned  numbers are available but you can also create a
custom . You will need to enter this  on the device you will be pairing
with Ubuntu.
Once the device has been paired, Ubuntu will open the “Setup completed”
screen. In Ubuntu, your computer is hidden by default for security reasons.
is means that your Ubuntu system can sear other Bluetooth devices, but
others cannot ﬁnd your Ubuntu system when they perform a sear on their
own computer. If you would like to let another device ﬁnd your computer,
you will have to explicitly allow your computer to be found. To allow your
computer to be found, select “Make computer discoverable” in Bluetooth
preferences. You can also cli on the Bluetooth icon and select Visible to
make your computer discoverable.
You can also add a fancy name for your Bluetooth-enabled Ubuntu system
by anging the text under Friendly Name.
Another feature present in the Bluetooth icon menu is “Send ﬁles to device.” Use this option to send a ﬁle to a mobile phone without pairing with the
computer.

When you pair two Bluetooth devices,
you are leing each device trust the other
one. Aer you pair two devices, they will
automatically connect to each other in the
future without requiring a PIN.

Android devices need to be paired at all
times, even while transferring files.



Soware Management

Soware management in Ubuntu
As discussed in Chapter : Working with Ubuntu, a range of default applications are available in Ubuntu that are suitable for many everyday tasks. At
some point you may decide to test out an alternative web browser, set up a
diﬀerent email client, edit an audio ﬁle, or try some new games (for example), and to do any of these you will need to install new soware. Ubuntu
keeps tra of many diﬀerent soware paages, and ﬁnding and installing
what you are aer is designed to be as qui and easy as possible. Alternatively, you may prefer to browse through the extensive library of available
applications, and try any that cat your interest.

Diﬀerences from other operating systems
Most other operating systems generally require a user to purase commercial
soware (online or through a physical store), or otherwise sear the Internet
for a free alternative (if one is available). e correct installation ﬁle must
then be veriﬁed for integrity, downloaded and located on the computer, followed by the user proceeding through a number of installation prompts and
options.
While at times a similar process may be used for installing soware in
Ubuntu, the quiest and easiest way to ﬁnd and install new applications is
through the Ubuntu Soware Center. is is a central location for accessing
new soware, and is based on the concept of repositories. A repository can be
thought of as a catalog of paages that are available for downloading from a
single location. You automatically have access to the oﬃcial Ubuntu repositories when the operating system is installed; however, additional repositories
can be added later in order to access more soware.

Using the Ubuntu Soware Center
e Soware Center can be used to install most applications that are available
in the oﬃcial Ubuntu repositories.
To start the Soware Center, open the Applications menu and oose
Ubuntu Soware Center.
e Soware Center window has two parts—a list of sections on the le,
and a set of departments on the right. Ea department is a category of soware. For example, the “Internet” department contains “Firefox Web Browser.”
Below the departments list there are  carousels, the Featured Soware
carousel on the le and the What’s New carousel on the right. e carousels

Some soware packages have more advanced purposes, such as programming or
running a server, and cannot be installed
using the Soware Center. You will need
to use the Synaptic Package Manager (discussed towards the end of this chapter) to
install these packages.
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Figure .: You can install and remove
applications from your computer using the
Soware Center.

keep rotating and showing diﬀerent application icons. Just cli an icon to get
more information on the application or to install it. To see all soware the
carousel contains, cli All.
e sections on the le side of the window represent your current view of
the Soware Center’s catalog. Cli the Get Soware buon on the le to see
soware that is available to install, Installed Soware to see a list of soware
that is already installed on your computer, or History to see previous soware
management.

Finding soware
ere are diﬀerent sources that the Soware Center displays in the Get Soware section. Cliing the arrow next to Get Soware will show a list of
individual sections. Selecting Ubuntu will show free oﬃcial soware, For
Purase will show soware for purasing, and any third party s will
also be shown. Selecting Get Soware will show all soware available, sorted
by category. is view is the default, and generally the most useful.
If you are looking for an application, you may already know a speciﬁc
name (for example, “underbird” is a popular email client), or otherwise you
may just have a general category in mind (for example, the “sound and video”
category includes a number of diﬀerent soware applications su as video
converters, audio editors, and music players).
To help you ﬁnd the right application, you can browse the Soware Center
catalog by cliing on the department that reﬂects the category of soware
you are aer, or alternatively use the built-in sear at the top-right of the
window to look for speciﬁc names or keywords.

  

When you select a department, you will be shown a list of applications
that ﬁt within that category. Some departments have sub-categories—for
example, the “Games” department has subcategories for “Simulation” and
“Card Games.”
To move through categories you can use the ba and forward buons at
the top of the window, as well as the navigational buons (oen referred to as
“breadcrumbs”) next to these.

Check out the Featured Applications department to see a list of highly recommended
applications.

Installing soware
Installing applications is practically only one cli away. Once you have found
an application that you would like to try:
. Cli the Install buon to the right of the selected paage. If you would
like to read more about the soware paage before installing it, ﬁrst cli
on More Info. is will take you to a short description of the application,
as well as a screenshot and a web link when available. If you wish to
proceed, you can also cli Install from this page.
. Type your password into the authentication window that appears. is is
the same password you use to log in to your account. You are required to
enter it whenever installing new soware, in order to prevent someone
without administrator access from making unauthorized anges to your
computer.
. Wait until the paage is ﬁnished installing. During the installation (or
removal) of soware, you will see an animated icon of rotating arrows to
the le of the In Progress buon in the sidebar. If you like, you can now
go ba to the main browsing window and queue additional soware paages to be installed by following the steps above. At any time, cliing the
In Progress buon on the le will take you to a summary of all operations
that are currently processing. Here you can also cli the X icon to cancel
any operation.
Once the Soware Center has ﬁnished installing an application, it is now
ready to be used. Ubuntu will usually place an entry in your Applications
menu under the relevant sub-menu—its exact location will depend on the
purpose of the application. In some cases an application will appear in one of
the System ‣ Preferences or System ‣ Administration menus instead. If you
aren’t sure where to ﬁnd it, the application’s information page will show you
how to laun it.

Removing soware
Removing applications is very similar to installing them. First, cli on the
Installed Soware buon in the Soware Center’s sidebar. Scroll down to the
application you wish to remove (or use the sear ﬁeld to quily ﬁnd it), and
then:

Note that you must be an administrator and
will need to be connected to the Internet for
the Soware Center to work. To learn how
to set up your connection, see Chapter :
Working with Ubuntu.

Related addons can be found listed below
the application’s description.
If you use the Gwibber micro-blogging
application, you can hit the Share… link
below the description to tell your friends
about it.

If you receive an “Authentication Failure”
message aer typing in your password,
check that you typed it correctly by trying
again. If the error continues, this may mean
that your account is not authorized to install
soware on the computer.
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. Cli the Remove buon to the right of the selected application.
. Type your password into the authentication window that appears. Removing soware also requires that you enter your password to help protect
your computer against unauthorized anges. e paage will then be
queued for removal, and will appear under the In Progress section in the
sidebar.

To completely remove a package and all
its configuration, you will need to purge it.
You can do this with the more advanced
Synaptic Package Manager, which is
discussed further in the Synaptic Package
Manager section below.

Removing a paage will also update your menus accordingly.

Soware history
e Ubuntu Soware Center keeps tra of past soware management in the
History section. is is useful if you wish to revert installations or removals
and do not remember the application’s name.
ere are  buons in the history section—All Changes, Installations,
Updates and Removals. Cliing one will show a list of days that action occurred. If you cli the arrow next to a day, a list of individual paages will
be shown, along with what was done with them and at what time. e history
section shows all soware history, not just from the Soware Center. For
example, paages updated through the Update Manager will also be listed.

Managing additional soware
Although the Soware Center provides a large library of applications to
oose from, initially only those paages available within the oﬃcial Ubuntu
repositories are listed. At times, a particular application you are aer may not
be available in these repositories. If this happens, it is important to understand
some alternative methods for accessing and installing soware in Ubuntu,
su as downloading an installation ﬁle manually from the Internet, or adding
extra repositories. First, we will look at how to manage your repositories
through Soware Sources.

Soware Sources
e Soware Center lists only those applications that are available in your
enabled repositories. Repositories can be added or removed through the Soware Sources application. To open this, cli System ‣ Administration ‣
Soware Sources in the top panel. You will be asked to enter your password,
then the “Soware Sources” window will open. ere are ﬁve tabs at the top
of this window: Ubuntu Soware, Other Soware, Updates, Authentication, and Statistics.

You can also open Soware Sources from
the Soware Center. Simply go to Edit ‣
Soware Sources.

  

Managing the oﬀicial repositories
e Ubuntu Soware tab lists the ﬁve oﬃcial Ubuntu repositories, ea
containing diﬀerent types of paages. When Ubuntu is ﬁrst installed, four of
these are enabled—main, universe, restricted, and multiverse.
‣ Canonical-supported open source soware (main): is repository
contains all the open-source paages that are maintained by Canonical.
‣ Community-maintained open source soware (universe): is repository contains all the open-source paages that are developed and maintained by the Ubuntu community.
‣ Proprietary drivers for devices (restricted): is repository contains
proprietary drivers, whi may be required to utilize the full capabilities of
some of your devices or hardware.
‣ Soware restricted by copyright or legal issues (multiverse): is
repository contains soware that may be protected from use in some states
or countries by copyright or licensing laws. By using this repository you
assume responsibility for the usage of any paages that you install.
‣ Source code: is repository contains the source code that is used to build
the soware paages from some of the other repositories.
e Source code option should not be selected unless you have experience
with building applications from source.
Selecting the best soware server
Ubuntu grants permission to many servers all across the world to act as mirrors. at is, they host an exact copy of all the ﬁles contained in the oﬃcial
Ubuntu repositories. In the Ubuntu Soware tab, you can select the server
that will give you the best possible download speeds.
When selecting a server, you may want to consider the following:
‣ Connection speed. Depending on the physical distance between you and a
server, the connection speed may vary. Ubuntu provides a tool for selecting
the server that provides the fastest connection with your computer.
First, cli the dropdown box next to “Download from:” in the “Soware Sources” window, and select Other from the menu. In the “Server
Selection” window that appears, cli the Select Best Server buon in
the upper right. Your computer will now aempt a connection with all
the available servers, then select the one with the fastest speed. If you are
happy with the automatic selection, cli Choose Server to return to the
“Soware Sources” window.
‣ Location. Choosing a server that is close to your location will oen provide the best connection speed.
To select a server by country, oose your location in the “Server Selection” window. If there are multiple servers available in your location, select
one then cli Choose Server when you are ﬁnished.

Closed-source packages are sometimes
referred to as non-free. This is a reference
to freedom of speech, rather than monetary
cost. Payment is not required to use these
packages.

Building applications from source is an
advanced process for creating packages,
and usually only concerns developers. You
may also require source files when using
a custom kernel, or if trying to use the
latest version of an application before it
is released for Ubuntu. As this is a more
advanced area, it will not be covered in this
manual.
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Finally, if you do not have a working Internet connection, Ubuntu can
install some soware paages straight from your installation . To do this,
insert the disc into your computer’s  drive, then select the e box next to
Installable from the /. Once this e box is tied, the disc will
be treated just like an online repository, and applications will be installable
straight from the  through the Soware Center.

Adding more soware repositories
Ubuntu makes it easy to add additional, third-party repositories to your list of
soware sources. e most common repositories added to Ubuntu are called
s. ese allow you to install soware paages that are not available in the
oﬃcial repositories, and automatically be notiﬁed whenever updates for these
paages are available.
Providing you know the web address of a ’s Launpad site, adding it to
your list of soware sources is relatively simple. To do so, you will need to use
the Other Soware tab in the “Soware Sources” window.
On the Launpad site for a , you will see a heading to the le called
“Adding this PPA to your system.” Underneath will be a short paragraph
containing a unique  in the form of ppa:test-ppa/example. Highlight this
 by selecting it with your mouse, then right-cli and oose copy.

A  is a Personal Package Archive. These
are online repositories used to host the
latest versions of soware packages, digital
projects, and other applications.

Figure .: This is an example of the Launchpad page for the Lifesaver PPA. Lifesaver
is an application that is not available in
the oﬀicial Ubuntu repositories. However,
by adding this PPA to your list of soware
sources, it would then be easy to install and
update this application through the Soware
Center.

Return to the “Soware Sources” window, and in the Other Soware tab
cli Add… at the boom. A new window will appear, and you will see the
words “Apt line:” followed by a text ﬁeld. Right-cli on the empty space in
this text ﬁeld and select Paste, and you should see the  appear that you
copied from the s Launpad site earlier. Cli Add Source to return to the

  

“Soware Sources” window. You will see a new entry has been added to the
list of sources in this window, with a tied e box in front meaning it is
enabled.
If you cli Close in the boom right corner of this window, a message will
appear informing you that “e information about available soware is outof-date.” is is because you have just added a new repository to Ubuntu, and
it now needs to connect to that repository and download a list of the paages
that it provides. Cli Reload, and wait while Ubuntu refreshes all of your
enabled repositories (including this new one you just added). When it has
ﬁnished, the window will close automatically.
Congratulations, you have just added a  to your list of soware sources.
You can now open the Soware Center and install applications from this
, in the same way you previously installed applications from the default
Ubuntu repositories.

Synaptic Package Manager
e Synaptic Paage Manager is a more advanced tool for managing soware in Ubuntu. It can be used to perform the same tasks as the Ubuntu
Soware Center, su as installing and removing applications, but also allows
for more control over your paages. For example, it provides the following
options:
‣ Install any paage in your repositories. In many cases you can even select
whi version of a paage to install, although this option is only available
if there are multiple versions in the repository.
‣ Reinstall a paage. is may be useful if you wish to revert a paage to
its default state, or repair any conﬂicts or damaged ﬁles.
‣ Update a paage when a newer version is released.
‣ Remove any paage you no longer need.
‣ Purge a paage to completely remove it, including any stored preferences or conﬁguration ﬁles (whi are oen le behind when a paage is
removed).
‣ Fix broken paages.
‣ Che properties of any paage, su as the version number, contained
ﬁles, paage size, dependencies, and more.
To open the Synaptic Paage Manager, navigate to System ‣ Administration ‣
Synaptic Paage Manager. As explained above, Synaptic is a more complex
tool than the Soware Center, and generally not essential for a new user just
geing started with Ubuntu. If you want to read more information on how
to use this program, or require more support managing the soware on your
system, head to https://help.ubuntu.com/community/SynapticHowto.
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Manual soware installation
Although Ubuntu has extensive soware available, on some occasions you
may want to manually install soware paages that are not available in the
repositories. If there is not a  for the soware, you will need to install it
manually. Before you oose to do so, make sure you trust the paage and its
maintainer.
Paages in Ubuntu have a .deb extension. Double cliing a paage will
open an overview page in the Soware Center, whi will give you more
information about that paage.
e overview gives some tenical information about that paage, a
website link (if applicable) and the option to install. Cliing Install will
install the paage just like any other installation in the Soware Center.

Updates and upgrades
Ubuntu also allows you to decide how to manage paage updates through the
Updates tab in the Soware Sources window.

Ubuntu updates
In this section, you are able to specify the kinds of updates you wish to install
on your system, and usually depends on your preferences around stability,
versus having access to the latest developments.
‣ Important security updates: ese updates are highly recommended to
ensure your system remains as secure as possible. ese are enabled by
default.
‣ Recommended updates: ese updates are not as important for keeping
your system secure, but will mean your paages always have the most
recent bug ﬁxes or minor updates that have been tested and approved. is
option is also enabled by default.
‣ Pre-released updates: is option is for those who would rather remain
up-to-date with the very latest releases of applications, at the risk of installing an update that has unresolved bugs or conﬂicts. Note that it is
possible that you will encounter problems with these updated applications,
therefore this option is not enabled by default. However, if this happens it
is possible to “roll-ba” to a previous version of a paage through Synaptic Paage Manager.
‣ Unsupported updates: ese are updates that have not yet been fully
tested and reviewed by Canonical. Some bugs may occur when using these
updates, and so this option is also not enabled by default.

  

Automatic updates
e middle section of this window allows you to customize how your system manages updates, su as the frequency with whi it es for new
paages, as well as whether it should install important updates right away
(without asking for your permission), download them only, or just notify you
about them.

Release upgrade
Here you can decide whi system upgrades you would like to be notiﬁed
about.
‣ Never: Choose this if you would rather not be notiﬁed about any new
Ubuntu releases.
‣ Normal releases: Choose this if you always want to have the latest
Ubuntu release, regardless of whether it is a Long Term Support release
or not. is option is recommended for normal home users.
‣ Long Term Support releases only: Choose this option if you need a
release that will be more stable and have support for a longer time. If you
use Ubuntu for business purposes, you may want to consider selecting this
option.

Every  months, Canonical will release
a new version of the Ubuntu operating
system. These are called normal releases.
Every four normal releases—or  months
—Canonical releases a Long Term Support
(LTS) release. Long Term Support releases
are intended to be the most stable releases
available, and are supported for a longer
period of time.



Advanced Topics

Ubuntu for advanced users
By now, we hope you understand how using Ubuntu can make your computing experience easier, safer, and more eﬃcient. So far, we’ve provided
detailed instructions on geing the most from Ubuntu’s basic features. In this
apter, we’ll detail some of Ubuntu’s more advanced features—like the terminal, a powerful utility that can help you accomplish tasks without the need
for a graphical user interface (). We’ll also discuss some advanced security measures you can implement to make your computer even safer. We’ve
wrien this apter with advanced users in mind. If you’re new to Ubuntu,
don’t feel as though you’ll need to master these topics to get the most out of
your new soware (you can quite easily skip to the next apter without consequence). However, if you’re looking to expand your knowledge of Ubuntu,
we encourage you to keep reading.

Introduction to the terminal
roughout this manual, we have focused primarily on the graphical desktop
user interface. However, in order to fully realize the power of Ubuntu, you
may want to learn how to use the terminal.

What is the terminal?
Most operating systems, including Ubuntu, have two types of user interfaces.
e ﬁrst is a graphical user interface (). is is the desktop, windows,
menus, and toolbars that you cli to get things done. e second, and mu
older, type of interface is the command-line interface ().
e terminal is Ubuntu’s command-line interface. It is a method of controlling some aspects of Ubuntu using only commands that you type on the
keyboard.

Why would I want to use the terminal?
You can perform most day-to-day activities without ever needing to open the
terminal. However, the terminal is a powerful and invaluable tool that can be
used to perform many useful tasks you might not be able to accomplish with a
. For example:
‣ Troubleshooting any diﬃculties that may arise when using Ubuntu sometimes requires you to use the terminal.
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‣ A command-line interface is sometimes a faster way to accomplish a task.
For example, it is oen easier to perform operations on many ﬁles at once
using the terminal.
‣ Learning the command-line interface is the ﬁrst step towards more advanced troubleshooting, system administration, and soware development skills. If you are interested in becoming a developer or an advanced
Ubuntu user, knowledge of the command-line will be essential.

Opening the Terminal
You can open the terminal by cliing Applications ‣ Accessories ‣ Terminal.
When the terminal window opens, it will be largely blank apart from some
text at the top le of the screen, followed by a blinking blo. is text is your
prompt—it displays your login name and your computer’s name, followed by
the current directory. e tilde (~) means that the current directory is your
home directory. Finally, the blinking blo is the cursor—this marks where
text will be entered as you type.
To test a terminal command, type pwd and press Enter. e terminal
should display /home/yourusername. is text is called the “output.” You
have just used the pwd (print working directory) command, whi outputs
(displays) the current directory.

The terminal gives you access to what is
called a shell. When you type a command
in the terminal the shell interprets this
command, resulting in the desired action.
Diﬀerent types of shells accept slightly
diﬀerent commands. The most popular is
called “bash,” and is the default shell in
Ubuntu.
In  environments the term “folder” is
commonly used to describe a place where
files are stored. In  environments the
term “directory” is used to describe the same
thing and this metaphor is exposed in many
commands (i.e., cd or pwd) throughout this
chapter.
Figure .: The default terminal window
allows you to run hundreds of useful
commands.

All commands in the terminal follow the same approa: Type a command,
possibly followed by some parameters, and press Enter to perform the speciﬁed action. Oen some output will be displayed that conﬁrms the action was
completed successfully, although this depends on the command. For example, using the cd command to ange your current directory (see below) will
ange the prompt, but will not display any output.
e rest of this apter covers some very common uses of the terminal.
However, it cannot address the nearly inﬁnite possibilities available to you
when using the command-line interface in Ubuntu. roughout the second
part of this manual, we will continue to refer to the command line, par-

Parameters are extra segments of text,
usually added at the end of a command,
that change how the command itself is
interpreted. These usually take the form of
-h or –help, for example. In fact, –help can
be added to most commands to display a
short description of the command, as well
as a list of any other parameters that can be
used with that command.

  

ticularly when discussing steps involved in troubleshooting and the more
advanced management of your computer.

Ubuntu file system structure
Ubuntu uses the Linux ﬁle system, whi is based on a series of folders in
the root directory. Ea of these folders contains important system ﬁles that
cannot be modiﬁed unless you are running as the root user or use sudo. is
restriction exists for both security and safety reasons: computer viruses will
not be able to ange the core system ﬁles, and ordinary users should not be
able to accidentally damage anything vital.
Below are some of the most important directories.
Figure .: Some of the most important
directories in the root file system.

e root directory—denoted by /—contains all other directories and ﬁles.
Here are the contents of some essential system directories:
‣
‣
‣
‣
‣
‣
‣
‣

& /sbin: Many essential system applications
System-wide conﬁguration ﬁles
/home: Ea user will have a subdirectory to store personal ﬁles (for example /home/your-username)
/lib: Library ﬁles, similar to .dll ﬁles on Windows
/media: Removable media ( and  drives) will be mounted in
this directory
/root: is contains the root user’s ﬁles (not to be confused with the root
directory)
/usr: Pronounced ‘user’, it contains most program ﬁles (not to be confused
with ea user’s home directory)
/var/log: Contains log ﬁles wrien by many applications
/bin

/etc:
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Every directory has a path. e path is a directory’s full name—it describes
a way to navigate the directory from anywhere in the system.
For example, the directory /home/your-username/Desktop contains all the
ﬁles that are on your Ubuntu desktop. e path, /home/your-username/Desktop,
can be broken down into a few pieces:
. /—indicates that the path starts at the root directory
. home/—from the root directory, the path goes into the home directory
. your-username/—from the home directory, the path goes into the yourusername directory
. Desktop—from the your-username directory, the path ends up in the Desktop directory
Every directory in Ubuntu has a complete path that starts with the / (the
root directory) and ends in the directory’s own name.
Directories and ﬁles that begin with a period are hidden directories. ese
are usually only visible with a special command or by selecting a speciﬁc option. In the Nautilus you can show hidden ﬁles and directories by selecting
View ‣ Show Hidden Files, or by pressing Ctrl+H. ere are many hidden directories in your home folder used to store program preferences. For example,
/home/your-username/.evolution stores preferences used by the Evolution
mail application.

Mounting and unmounting removable devices
Any time you add storage media to your computer—an internal or external
hard drive, a  ﬂash drive, a —it needs to be mounted before it is
accessible. Mounting a device means to associate a directory name with the
device, allowing you to navigate to the directory to access the device’s ﬁles.
When a device su as a  ﬂash drive or a media player is mounted in
Ubuntu, a folder is automatically created for it in the media directory and
you are given the appropriate permissions to be able to read and write to the
device.
Most ﬁle managers will automatically add a shortcut to the mounted
device in the side bar of your home folder, so the device is easy for you to
access. You shouldn’t have to physically navigate to the media directory in
Ubuntu, unless you oose to do so from the command line.
When you’ve ﬁnished using a device, you can unmount it. Unmounting a
device disassociates the device from its directory, allowing you to eject it.

Securing Ubuntu
Now that you know a bit more about using the command line, we can use it
to make your computer more secure. e following sections discuss various
security concepts, along with procedures for keeping your Ubuntu running
smoothly, safely, and securely.

  

Why Ubuntu is safe
Ubuntu is secure by default for a number of reasons:
‣ Ubuntu clearly distinguishes between normal users and administrative
users.
‣ Soware for Ubuntu is kept in a secure online repository, whi contains
no false or malicious soware.
‣ Open-source soware like Ubuntu allows security ﬂaws to be easily detected.
‣ Security pates for open-source soware like Ubuntu are oen released
quily.
‣ Many viruses designed to primarily target Windows-based systems do not
aﬀect Ubuntu systems.

Basic security concepts
e following sections discuss basic security concepts—like ﬁle permissions,
passwords, and user accounts. Understanding these concepts will help you
follow the remaining procedures for securing your computer.

Permissions
In Ubuntu, ﬁles and folders can be set up so that only speciﬁc users can view,
modify, or run them. For instance, you might wish to share an important
ﬁle with other users, but do not want those users to be able to edit the ﬁle.
Ubuntu controls access to ﬁles on your computer through a system of “permissions.” Permissions are seings that you can conﬁgure to control exactly
how ﬁles on your computer are accessed and used.
To learn more about modifying permissions, visit https://help.ubuntu.com/
community/FilePermissions.
Passwords
You can use a strong password to increase the security of your computer. Your
password should not contain names, common words or common phrases. By
default, the minimum length of a password in Ubuntu is four aracters. We
recommend a password with more than the minimum number of aracters.
Locking the screen
When you leave your computer unaended, you may want to lo the screen.
Loing your screen prevents anyone from using your computer until your
password is entered. To lo the screen:
‣ Cli the session menu icon in the right corner of the top panel, then select
Lo Screen, or
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‣ press Ctrl+Alt+L to lo the screen. is keyboard shortcut can be
anged in System ‣ Preferences ‣ Keyboard Shortcuts.

User accounts
When Ubuntu is installed, it is automatically conﬁgured for a single person
to use. If more than one person will use the computer with Ubuntu, ea
person should have her or his own user account. is way, ea user can
have separate seings, documents, and other ﬁles. If necessary, you can also
protect ﬁles from being viewed or modiﬁed by users without administrative
privileges. See Users and groups to learn more about creating additional users
accounts.

Users and groups
Like most operating systems, Ubuntu allows you to create separate user accounts for ea person that uses the computer. Ubuntu also supports user
groups, whi allow you to administer permissions for multiple users at the
same time.
Every user in Ubuntu is a member of at least one group—the group’s name
is the same as the name of the user. A user can also be a member of additional
groups. You can conﬁgure some ﬁles and folders to be accessible only by a
user and a group. By default, a user’s ﬁles are only accessible by that user;
system ﬁles are only accessible by the root user.
Figure .: Add, remove and change the user
accounts.

Managing users
You can manage users and groups using the Users and Groups administration application. To ﬁnd this application, cli System ‣ Administration ‣
Users and Groups.
To adjust the user and group seings, ﬁrst select the user that you want to
modify from the list. en cli “Change…” next to the element that you want

  

to make anges to. You will need to input your password in order to make
anges to user and group seings.
Adding a user Cli the Add buon whi appears underneath a list of the
current user accounts that have already been created. A window will appear
that has two ﬁelds. e “Name“ ﬁeld ﬁeld is for a friendly display name. e
“Username“ ﬁeld is for the actual username. Fill in the requested information,
then cli OK. A new dialog box will appear asking you to enter a password
for the user you have just created. Fill out the ﬁelds, then cli OK. Privileges
you grant to the new user can be altered in “Users Seings”.
Modifying a user Cli on the name of a user in the list of users, then cli
on the Change… buon, whi appears next to ea of following options:
‣ Account type:
‣ Password:
For more advanced user options cli on the Advanced Settings buon.
Change the details as required in the dialog that appears. Cli OK to save the
anges.
Deleting a user Select a user from the list and cli Delete. Ubuntu will
deactivate the user’s account, and you can oose whether remove the user’s
home folder or leave it.

Managing groups
Cli on the Manage Groups buon to open the group management dialog.
Adding a group To add a group, cli Add. In the dialog that appears, enter
the group name and select the names of users you would like to add to the
group.
Modifying a group To alter the users in an existing group, select a group and
cli on the Properties buon. Select and deselect the users as required, then
cli OK to apply the anges.
Deleting a group To delete a group, select a group and cli Delete.

Applying groups to files and folders
To ange the group associated with a ﬁle or folder, open the Nautilus ﬁle
browser and navigate to the appropriate ﬁle or folder. en, either select the
folder and oose File ‣ Properties from the menubar, or right-cli on the ﬁle
or folder and oose Properties. In the Properties dialog that appears, cli on
the Permissions tab and select the desired group from the Groups drop-down
list. en close the window.
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Using the command line
You can also modify user and group seings via the command line. We
recommend that you use the graphical method above unless you have a
good reason to use the command line. For more information on using the
command line to modify users and groups, see the Ubuntu Server Guide at
hps://help.ubuntu.com/./serverguide/C/user-management.html

System updates
Good security depends on an up-to-date system. Ubuntu provides free soware and security updates. You should apply these updates regularly. See
Chapter : Soware Management to learn how to update your Ubuntu computer with the latest security updates and pates.
Trusting third party sources
Normally, you will add applications to your computer via the Soware Center,
whi downloads soware from the Ubuntu repositories as described in
Chapter : Soware Management. However, it is occasionally necessary to
add soware from other sources. For example, you may need to do this when
an application is not available in the Ubuntu repositories, or when you need a
newer version of the one available in the Ubuntu repositories.
Additional repositories are available from sites su as getdeb.net and
Launpad s, whi can be added as described in Chapter : Soware
Management. You can download the  paages for some applications
from their respective project sites on the Internet. Alternately, you can build
applications from their source code (an advanced method of installing and
using applications).
Using only recognized sources su as a project’s site, , or various
community repositories (su as getdeb.net) is more secure than downloading
applications from an arbitrary (and perhaps less reputable) source. When
using a third party source, consider its trustworthiness, and be sure you know
exactly what you’re installing on your computer.

Firewall
A ﬁrewall is an application that protects your computer against unauthorized
access by people on the Internet or your local network. Firewalls blo connections to your computer from unknown sources. is helps prevent security
breaes.
Uncomplicated Firewall () is the standard ﬁrewall conﬁguration program in Ubuntu. It is a program that runs from the command line, but a
program called Gufw allows you to use it with a graphical interface. See

  

Chapter : Soware Management to learn more about installing the Gufw
paage.
Once it’s installed, start Gufw by cliing System ‣ Administration ‣
Firewall conﬁguration. To enable the ﬁrewall, select the Enable option. By
default, all incoming connections are denied. is seing should be suitable
for most users.
If you are running server soware on your Ubuntu system (su as a web
server, or an  server), then you will need to open the ports these services
use. If you are not familiar with servers, you will likely not need to open any
additional ports.
To open a port cli on the Add buon. For most purposes, the Preconﬁgured tab is suﬃcient. Select Allow from the ﬁrst box and then select the
program or service required.
e simple tab can be used to allow access on a single port, and the Advanced tab can be used to allow access on a range of ports.

Encryption
You may wish to protect your sensitive personal data—for instance, ﬁnancial
records—by encrypting it. Encrypting a ﬁle or folder essentially “los” that
ﬁle or folder by encoding it with an algorithm that keeps it scrambled until it
is properly decoded with a password. Encrypting your personal data ensures
that no one can open your personal folders or read your private data without
your private key.
Ubuntu includes a number of tools to encrypt ﬁles and folders. is apter will discuss two of these. For further information on using encryption
with either single ﬁles or email, see Ubuntu Community Help documents at
hps://help.ubuntu.com/community.
Home folder
When installing Ubuntu, it is possible to encrypt a user’s home folder. See
Chapter : Installation for more on encrypting the home folder.
Private folder
If you have not osen to encrypt a user’s entire home folder, it is possible to
encrypt a single folder—called Private—in a user’s home folder. To do this,
follow these steps:
. Install the ecryptfs-utils soware paage from the Ubuntu Soware
Center. (For more information about the Soware Center, review Using the
Ubuntu Soware Center.)
. Use the terminal to run ecryptfs-setup-private to set up the private
folder.
. Enter your account’s password when prompted.



    .

. Either oose a mount passphrase or generate one.
. Record both passphrases in a safe location. ese are required if you ever
have to recover your data manually.
. Log out and log ba in to mount the encrypted folder.
Aer the Private folder has been set up, any ﬁles or folders in it will automatically be encrypted.
If you need to recover your encrypted ﬁles manually see https://help.
ubuntu.com/community/EncryptedPrivateDirectory.



Troubleshooting

Resolving problems
Sometimes, things simply do not work as they should. Luily, problems
encountered while working with Ubuntu are easily ﬁxed. Below, we oﬀer
a guide to resolving basic problems that users may encounter while using
Ubuntu. If you exhaust the troubleshooting advice below, see Geing more
help to learn about seeking support from the Ubuntu community.

Troubleshooting guide
e key to eﬀective troubleshooting is to work slowly, methodically, and to
document the anges that you make to your Ubuntu system throughout
every step. is way, you will always be able to roll ba your work—and give
fellow users information about your previous aempts, in the unlikely event
that you should need to turn to the community for support.

Ubuntu fails to start aer I’ve installed Windows
Occasionally you may install Ubuntu and then decide to install Microso
Windows as a second operating system running side-by-side with Ubuntu.
While this is supported by Ubuntu, you might ﬁnd that aer installing Windows you will no longer be able to start Ubuntu.
When you ﬁrst turn on your computer, a program called a “bootloader”
must start Ubuntu or another operating system. When you installed Ubuntu,
you installed an advanced bootloader called  that allowed you to oose
between the various operating systems on your computer, su as Ubuntu,
Windows and others. However, when you installed Windows, it replaced
 with its own bootloader, thus removing the ability to oose whi
operating system you’d like to use. You can easily restore —and regain
the ability to oose your operating system—by using the same  you used to
install Ubuntu.
First, insert your Ubuntu  into your computer and restart it, making sure
to have your computer start the operating system that is on the  itself (see
Chapter : Installation). Next, oose your language and select Try Ubuntu.
Wait while the soware loads. You will need to type some commands to
restore your bootloader. On the Applications menu, cli Accessories, and
then cli the Terminal item. Enter the following:
$ sudo fdisk -l
Disk /dev/hda: 120.0 GB, 120034123776 bytes

A bootloader is the initial soware that
loads the operating system when you turn
on the computer.
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255 heads, 63 sectors/track, 14593 cylinders
Units = cylinders of 16065 * 512 = 8225280 bytes
Device Boot

Start

End

1

1224

/dev/sda1
/dev/sda2

1225

2440

/dev/sda3

*

2441

14593

/dev/sda4

14532

14593

Blocks
64228+
9767520
97618972+
498015

Id

System

83

Linux

a5

Windows

5
82

Extended
Linux swap

Partition table entries are not in disk order

is output means that your system (Linux, on whi Ubuntu is based)
is installed on device /dev/sda, but your computer is booting to /dev/sda
(where Windows is located). We need to rectify this by telling the computer to
boot to the Linux device instead.
To do this, ﬁrst create a place to manipulate your Ubuntu installation:
$ sudo mkdir /media/root

Next, link your Ubuntu installation and this new folder:
$ sudo mount /dev/sda1 /media/root

If you’ve done this correctly, then you should see the following:
$ ls /media/root
bin dev home lib mnt root srv usr
boot etc initrd lib64 opt sbin sys var
cdrom initrd.img media proc selinux tmp vmlinuz

Now, you can reinstall :
$ sudo grub-install –root-directory=/media/root /dev/sda
Installation finished. No error reported.
This is the contents of the device map /boot/grub/device.map.
Check if this is correct or not. If any of the lines is incorrect,
fix it and re-run the script grub-install.
(hd0) /dev/sda

Finally, remove the Ubuntu disc from your  drive, reboot your
computer, and enjoy your Ubuntu system once again.
is guide may not work for all Ubuntu users due to diﬀerences in system conﬁguration. Still, this is the recommended method, and the most successful method, for restoring the  bootloader. If following this guide
does not restore  on your computer, please consider trying some of
the other troubleshooting methods at https://help.ubuntu.com/community/
RecoveringUbuntuAfterInstallingWindows. When following the instructions,
please note that your Ubuntu installation uses Grub. is guide replicates
the method described in the ﬁrst section of the referenced web page. Please
consider starting with the third section, https://help.ubuntu.com/community/
RecoveringUbuntuAfterInstallingWindows.

The device (/dev/sda, /dev/sda, etc) we
are looking for is identified by the word
“Linux” in the System column. Modify the
instructions below if necessary, replacing
/dev/sda with the name of your Linux
device.

 

Ubuntu doesn’t present the login screen when my computer boots
e simplest and easiest way to correct this issue is to order Ubuntu to reset
the graphics conﬁguration. Press and hold Control, Alt and F. You should
now see a bla and white screen with a prompt for your username and
password.
Enter your username, press Enter, and then enter your password. (Characters will not appear on the screen as you enter your password. Don’t worry
—this behavior is normal and was implemented for security purposes). Next,
enter the following commands. Your password will be needed again.
$ sudo cd /etc/X11
$ sudo mv ./xorg.conf ./xorg.conf_old
$ sudo service gdm stop
$ sudo X -configure
$ sudo mv ./xorg.conf.new ./xorg.conf
$ sudo reboot now

Ubuntu will reboot, and your login screen should be restored.

I forgot my password
If you forget your password in Ubuntu, you will need to reset it using “Recovery mode.”
To start Recovery mode, shut down your computer, then power it up.
As the computer starts up, press Shi (Grub) Esc (Grub) when you see
the white-on-bla screen with a countdown (the  prompt). Select the
Recovery mode option using the arrow keys on your keyboard. Recovery
mode should be the second item in the list.
Wait while Ubuntu starts up—this may take a few minutes. Once booted,
you will not see a normal login screen. Instead, you will be presented with a
terminal prompt that looks something like:
root@ubuntu:~#

To reset your password, enter:
# passwd username

Replace “username” above with your username. Ubuntu will prompt you
for a new password. Enter your desired password, press enter and then type
your password again, pressing enter aer you are done. (Ubuntu asks for your
password twice to make sure you did not make a mistake while typing). Once
you have restored your password, return to the normal system environment
by entering:
# init 2

Login as usual and continue enjoying Ubuntu.
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Figure .: This is the grub screen in which
you can choose recovery mode.

I accidentally deleted some files that I need
If you’ve deleted a ﬁle by accident, you may be able to recover it from
Ubuntu’s trash folder. is is a special folder where Ubuntu stores deleted
ﬁles before they are permanently removed from your computer.
To access the trash folder, select Places ‣ Computer from the top panel,
then oose Trash from the list of places in the le-hand sidebar of the window that appears (alternatively, cli on the trash applet at the far right of
the boom panel). To remove items from this folder and restore them to your
computer, right-cli on the items you want and select Restore, or otherwise
drag them wherever you would like (we recommend a memorable location,
su as your home folder or desktop).

How do I clean Ubuntu?
Over time, Ubuntu’s soware paaging system can accumulate unused paages or temporary ﬁles. ese temporary ﬁles, also called caes, contain
paage ﬁles from all of the paages that you have ever installed. Eventually, this cae can grow quite large. Removing them allows you to reclaim
space on your computer’s hard drive for storing your documents, music,
photographs, or other ﬁles.
To clear the cae, you can use either the clean, or the autoclean option
for a command-line program called apt-get. e clean command will remove every single caed item, while the autoclean command only removes
caed items that can no longer be downloaded (these items are oen unnecessary). To run clean, open Terminal and type:

The Trash folder is called diﬀerent things
in various parts of the desktop. This could
cause confusion. This is a known issue
and will be resolved in the next version of
. The Trash folder could also be know
as the “Wastebasket” or “Deleted Items
Folder.”

 

$ sudo apt-get clean

Paages can also become unused over time. If a paage was installed to
assist with running another program—and that program was subsequently
removed—you no longer need the supporting paage. You can remove it with
apt-get autoremove.
Load Terminal and type:
$ sudo apt-get autoremove

to remove the unnecessary paages.

I can’t play certain audio or video files
Many of the formats used to deliver ri media content are proprietary,
meaning they are not free to use, modify and distribute with an open-source
operating system like Ubuntu. erefore, Ubuntu does not include the capability to use these formats by default; however, users can easily conﬁgure
Ubuntu to use these proprietary formats. For more information about the
diﬀerences between open source and proprietary soware, see Chapter :
Learning More.
If you ﬁnd yourself in need of a proprietary format, you may install the
ﬁles necessary for using this format with one command. Before initiating this
command, ensure that you have Universe and Multiverse repositories enabled.
See the Synaptic Paage Manager section to learn how to do this.
Open the Ubuntu Soware Center by selecting it from Applications.
Sear for ubuntu-restricted-extras by typing “ubuntu restricted extras”
in the sear box on the right-hand side of the Ubuntu Soware Center’s
main window. When the Soware Center ﬁnds the appropriate soware, cli
the arrow next to its title. Cli Install, then wait while Ubuntu installs the
appropriate soware.
One program that can play many of these formats, is VLC media player,
it can be downloaded from the Ubuntu Soware Center. Once Ubuntu has
successfully installed soware, your ri media content should work properly.

How can I change my screen resolution?
e image on every monitor is composed of millions of lile colored dots
called pixels. Changing the number of pixels displayed on your monitor is
called “anging the resolution.” Increasing the resolution will make the displayed images sharper, but will also tend to make them smaller. e opposite
is true when screen resolution is decreased. Most monitors have a “native resolution,” whi is a resolution that most closely mates the number of pixels
in the monitor. Your display will usually be sharpest when your operating
system uses a resolution that mates your display’s native resolution.
e Ubuntu conﬁguration utility Monitors allows users to ange the



    .

resolution. Open it by oosing System from the Main Menu, then oosing
Preferences and then Monitors. e resolution can be anged using the
drop down list within the program. Piing options higher up on the list (for
example, those with larger numbers) will increase the resolution.
Figure .: You can change your display
seings.

You can experiment with various resolutions by cliing Apply at the bottom of the window until you ﬁnd one that’s comfortable for you. Typically
the highest resolution will be the native resolution. Selecting a resolution
and cliing Apply will temporarily ange the screen resolution to the selected value. A dialog box will also be displayed. It allows you to revert to
the previous resolution seing or keep the new resolution. e dialog box
will disappear in  seconds, restoring the old resolution.is feature was
Figure .: You can revert back to your old
seings if you need to.

implemented to prevent someone from being loed out of the computer by
a resolution that distorts the monitor and makes it unusable. When you have
ﬁnished seing the screen resolution, cli Close.

Ubuntu is not working properly on my Apple MacBook or MacBook
Pro
When installed on notebook computers from Apple—su as the MacBook or
MacBook Pro—Ubuntu does not always enable all of the computer’s built-in
components, including the iSight camera and the Airport wireless Internet
adapter. Luily, the Ubuntu community oﬀers documentation on ﬁxing these
and other problems. If you are having trouble installing or using Ubuntu on
your Apple notebook computer, please follow the instructions at https://help.
ubuntu.com/community/MacBook. You can select the appropriate guide aer
identifying your computer’s model number. For instructions on doing this,
visit the web page above.

 

Ubuntu is not working properly on my Asus EeePC
When installed on netbook computers from Asus—su as the EeePC—
Ubuntu does not always enable all of the computer’s built-in components,
including the keyboard shortcut keys and the wireless Internet adapter.
e Ubuntu community oﬀers documentation on enabling these components and ﬁxing other problems. If you are having trouble installing
or using Ubuntu on your Asus EeePC, please follow the instructions at
https://help.ubuntu.com/community/EeePC. is documentation page contains information pertaining speciﬁcally to EeePC netbooks.

My hardware is not working properly
Ubuntu occasionally has diﬃculties running on certain computers, generally
when hardware manufacturers use non-standard or proprietary components. e Ubuntu community oﬀers documentation to help you troubleshoot
many common issues that may arise from this situation, including problems with wireless cards, scanners, mice and printers. You can ﬁnd the complete hardware troubleshooting guide on Ubuntu’s support wiki, accessible
at https://wiki.ubuntu.com/HardwareSupport. If your hardware problems
persist, please see Geing more help for more troubleshooting options or
information on obtaining support or assistance from an Ubuntu user.

Geing more help
is guide does not cover every possible workﬂow, task or issue in Ubuntu. If
you require assistance beyond the information in the manual, you can ﬁnd a
variety of support opportunities online.
More details about the many support options available to you can be found
at Finding additional help and support later in this book.



Learning More

What else can I do with Ubuntu?
By now, you should be able to use your Ubuntu desktop for all your daily
activities—su as browsing the web and editing documents. But you may
be interested in learning about other versions of Ubuntu you can integrate
into your digital lifestyle. In this apter, we’ll provide you with more detail
about versions of Ubuntu that are specialized for certain tasks. But ﬁrst, we’ll
discuss the tenologies that make Ubuntu a powerful collection of soware.

Open Source soware
Ubuntu is open source soware. Open source soware diﬀers from proprietary soware—soware whose source code is patented and is therefore not
freely available for modiﬁcation or distribution by anyone but the rightsholder. Microso Windows and Adobe Photoshop are examples of proprietary
soware.
Unlike proprietary soware applications, Ubuntu is speciﬁcally licensed
to promote sharing and collaboration. e legal rules governing Ubuntu’s
production and distribution ensure that anyone can obtain, run, or share it
for any purpose they wish. Computer users can modify open source soware
to suit their individual needs, share it, improve it, or translate it into other
languages—provided they release these modiﬁcations so others can do the
same. In fact, the terms of many open source licensing agreements make it
illegal not to do so.
Because open source soware is developed by large communities of programmers distributed throughout the globe, it beneﬁts from rapid development cycles and speedy security releases (in the event that someone discovers
bugs in the soware). In other words, open source soware is updated, enhanced, and made more secure every day as programmers all over the world
continue to improve it.
Aside from these tenical advantages, open source soware also has
economic beneﬁts. While users must adhere to the terms of an open source
licensing agreement when installing and using Ubuntu, for instance, they
needn’t pay to obtain this license. While not all open source soware is free of
monetary costs, mu is.
To learn more about open source soware, see the Open Source Initiative’s open source deﬁnition, available at http://www.opensource.org/docs/
definition.php.

The source code of a program is the
collection files that have been wrien in a
computer language to make the program.
Proprietary soware is soware that
cannot be copied, modified, or distributed
freely.
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Distribution families
Ubuntu is one of several popular operating systems based on Linux (an open
source operating system). While other versions of Linux, or “distributions,”
may look diﬀerent from Ubuntu at ﬁrst glance, they share similar aracteristics because of their common roots.
Linux distributions can be divided into two broad families: the Debian
family and the Red Hat family. Ea family is named for a distribution on
whi subsequent distributions are based. For example, “Debian” refers to
both the name of a distribution as well as the family of distributions derived
from Debian. Ubuntu is part of the Debian family of distributions, as are
Linux Mint, Xandros, and CrunBang Linux. Distributions in the Red Hat
family include Fedora, openSUSE, and Mandriva.
e most signiﬁcant diﬀerence between Debian-based and Red Hat-based
distributions is the system ea uses for installing and updating soware.
ese systems are called “paage management systems.” Debian soware
paages are  ﬁles, while Red Hat soware paages are  ﬁles. For
more information about paage management, see Chapter : Soware Management.
You will also ﬁnd distributions that have been specialized for certain tasks.
Next, we’ll describe these versions of Ubuntu and explain the uses for whi
ea has been developed.

Choosing amongst Ubuntu and its derivatives
Just as Ubuntu is based on Debian, several distributions are subsequently
based on Ubuntu. Some of these are made for general use, and ea diﬀers
with respect to the soware included as part of the distribution. Others are
designed for specialized uses.
Four derivative distributions are oﬃcially recognized and supported by
both Canonical and the Ubuntu community. ese are:
‣ Ubuntu Netbook Edition, whi is optimized for netbook computers.
‣ Kubuntu, whi uses the  graphical environment instead of the 
environment found in Ubuntu;
‣ Edubuntu, whi is designed for use in sools; and
‣ Ubuntu Server Edition, whi is designed for use on servers, and typically is not used as a desktop operating system because it doesn’t have a
graphical interface.
Several other derivatives of Ubuntu are available. ese include:
‣ Xubuntu, whi uses the  graphical environment instead of the
 environment found in Ubuntu;
‣ Lubuntu, whi uses the  graphical environment instead of the
 environment found in Ubuntu;

A distribution, or “distro,” is a operating
system made from open source applications,
bundled together to make them easier to
install and use.

Package management systems are
the means by which users can install,
remove, and organize soware installed
on computers with open source operating
systems like Ubuntu.

 



‣ Ubuntu Studio, whi is designed for creating and editing multimedia;
‣ Mythbuntu, whi is designed for creating a home theater  with
MythTV (an open source digital video recorder).
For more information about these derivative distributions, see http://www.
ubuntu.com/project/derivatives.

Ubuntu Netbook Edition
Ubuntu Netbook Edition is a version of Ubuntu designed speciﬁcally for
netbook computers. It is optimized for computing devices with small screens
and limited resources (like the energy-saving processors and smaller hard
disks common among netbooks). Ubuntu Netbook Edition sports a unique
interface and features a collection of soware applications particularly useful
to on-the-go users.
Because many netbooks do not contain  drives, Ubuntu Netbook
Edition allows users to install it on their computers using  ﬂash drives.
To learn more about using a ﬂash drive to install Ubuntu Netbook Edition on
a netbook computer, visit https://help.ubuntu.com/community/Installation/
FromImgFiles.

Netbooks are low-cost, low-power notebook computers designed chiefly for
accessing the Internet.

Ubuntu Server Edition
e Ubuntu Server Edition is an operating system optimized to perform
multiuser tasks when installed on servers. Su tasks include ﬁle sharing and
website or email hosting. If you are planning to use a computer to perform
tasks like these, you may wish to use this specialized server distribution in
conjunction with server hardware.
is manual does not explain the process of running a secure web server
or performing other tasks possible with Ubuntu Server Edition. For details on
using Ubuntu Server Edition, refer to the manual at http://www.ubuntu.com/
server.

Ubuntu Studio
is derivative of Ubuntu is designed speciﬁcally for people who use computers to create and edit multimedia projects. For instance, it features applications to help users manipulate images, compose music, and edit video.
While users can install these applications on computers running the desktop
version of Ubuntu, Ubuntu Studio makes them all available immediately upon
installation.
If you would like to learn more about Ubuntu Studio (or obtain a copy for
yourself), visit http://ubuntustudio.org/home.

A server is a computer that’s been configured to manage, or “serve,” files many
people wish to access.
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Mythbuntu
Mythbuntu allows users to turn their computers into entertainment systems.
It helps users organize and view various types of multimedia content su as
movies, television shows, and video podcasts. Users with  tuners in their
computers can also use Mythbuntu to record live video and television shows.
To learn more about Mythbuntu, visit http://www.mythbuntu.org/.

-bit or -bit?
As mentioned earlier in this manual, Ubuntu and its derivatives are available
in two versions: -bit and -bit. is diﬀerence refers to the way computers
process information. Computers capable of running -bit soware are able to
process more information than computers running -bit soware; however,
-bit systems require more memory in order to do this. Nevertheless, these
computers gain performance enhancements by running -bit soware.
Why oose one over another? Pay aention to the version you select in
the following cases:
‣ If your computer is fairly old (made before ), then you may want to
install the -bit version of Ubuntu. is is also the case for most netbooks.
‣ If your computer has more than   of memory (), then you may need
to install the -bit version in order to use all the installed memory.

Finding additional help and support
is guide is not intended to be an all-encompassing resource ﬁlled with everything you’ll ever need to know about Ubuntu. Because Geing Started
with Ubuntu . could never answer all your questions, we encourage you
to take advantage of Ubuntu’s vast community when seeking further information, troubleshooting tenical issues, or asking questions about your computer. Below, we’ll discuss a few of these resources—located both inside the
operating system and on the Internet—so you can learn more about Ubuntu or
other Linux distributions.

System help
If you need additional help when using Ubuntu or its applications, cli
the Help icon on the top panel, or navigate to System ‣ Help and Support.
Ubuntu’s built-in help guide covers a broad range of topics in great detail.

Online Ubuntu help
e Ubuntu Documentation team has created and maintains a series of wiki
pages designed to help both new and experienced users learn more about
Ubuntu. You can access these at http://help.ubuntu.com.

 



The Ubuntu Forums
e Ubuntu Forums are the oﬃcial forums of the Ubuntu community. Millions of Ubuntu users use them daily to seek help and support from one
another. You can create an Ubuntu Forums account in minutes. To create
an account and learn more about Ubuntu from community members, visit
http://ubuntuforums.org.

Launchpad Answers
Launpad, an open source code repository and user community, provides a
question and answer service that allows anyone to ask questions about any
Ubuntu-related topic. Signing up for a Launpad account requires only a few
minutes. Ask a question by visiting Launpad at https://answers.launchpad.
net/ubuntu/+addquestion.

Live chat
If you are familiar with Internet relay at (), you can use at clients su
as XChat or Pidgin to join the annel #ubuntu on irc.freenode.net. Here,
hundreds of user volunteers can answer your questions or oﬀer you support in
real time.

LoCo teams
Within the Ubuntu community are dozens of local user groups called “LoCo
teams.” Spread throughout the world, these teams oﬀer support and advice, answer questions and promote Ubuntu in their communities by hosting regular events. To locate and contact the LoCo team nearest you, visit
http://loco.ubuntu.com/.

Community support
If you’ve exhausted all these resources and still can’t ﬁnd answers to your
questions, visit Community Support at http://www.ubuntu.com/support/
community.

Ask Ubuntu
Ask Ubuntu is a free community driven estion and Answer website for
Ubuntu users and developers. It is part of the Sta Exange network of
websites. is is one of the best Ubuntu support resources available for free.
Visit http://www.askubuntu.com to get started.

In addition to oﬀicial Ubuntu and community help, you will oen find third-party
help available on the Internet. While these
documents can oen be great resources,
some could be misleading or outdated. It’s
always best to verify information from
third-party sources before taking their
advice.
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Commercial Support (Non Free)
If all of these options fail. Whi I don’t believe they will. ere is always
commercial paid support. is is provided by Canonical directly. Visit http://
www.ubuntu.com/business/services/overview for more information.

A

License

Creative Commons Aribution–ShareAlike . Legal Code
  (  )        
    (“”  “”).    
   /   .     
           
.
        ,  
          .    
       ,    
         
   .
. Deﬁnitions
(a) “Adaptation” means a work based upon the Work, or upon the Work
and other pre-existing works, su as a translation, adaptation, derivative work, arrangement of music or other alterations of a literary or
artistic work, or phonogram or performance and includes cinematographic adaptations or any other form in whi the Work may be recast,
transformed, or adapted including in any form recognizably derived
from the original, except that a work that constitutes a Collection will
not be considered an Adaptation for the purpose of this License. For the
avoidance of doubt, where the Work is a musical work, performance
or phonogram, the synronization of the Work in timed-relation with
a moving image (“syning”) will be considered an Adaptation for the
purpose of this License.
(b) “Collection” means a collection of literary or artistic works, su as
encyclopedias and anthologies, or performances, phonograms or broadcasts, or other works or subject maer other than works listed in Section (f) below, whi, by reason of the selection and arrangement of
their contents, constitute intellectual creations, in whi the Work is
included in its entirety in unmodiﬁed form along with one or more
other contributions, ea constituting separate and independent works
in themselves, whi together are assembled into a collective whole. A
work that constitutes a Collection will not be considered an Adaptation
(as deﬁned below) for the purposes of this License.
(c) “Creative Commons Compatible License” means a license that is listed
at http://creativecommons.org/compatiblelicenses that has been approved by Creative Commons as being essentially equivalent to this



(d)

(e)

(f)
(g)

(h)

(i)
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License, including, at a minimum, because that license: (i) contains
terms that have the same purpose, meaning and eﬀect as the License
Elements of this License; and, (ii) explicitly permits the relicensing of
adaptations of works made available under that license under this License or a Creative Commons jurisdiction license with the same License
Elements as this License.
“Distribute” means to make available to the public the original and
copies of the Work or Adaptation, as appropriate, through sale or other
transfer of ownership.
“License Elements” means the following high-level license aributes as
selected by Licensor and indicated in the title of this License: Aribution, ShareAlike.
“Licensor” means the individual, individuals, entity or entities that
oﬀer(s) the Work under the terms of this License.
“Original Author” means, in the case of a literary or artistic work, the
individual, individuals, entity or entities who created the Work or if
no individual or entity can be identiﬁed, the publisher; and in addition
(i) in the case of a performance the actors, singers, musicians, dancers,
and other persons who act, sing, deliver, declaim, play in, interpret or
otherwise perform literary or artistic works or expressions of folklore;
(ii) in the case of a phonogram the producer being the person or legal
entity who ﬁrst ﬁxes the sounds of a performance or other sounds;
and, (iii) in the case of broadcasts, the organization that transmits the
broadcast.
“Work” means the literary and/or artistic work oﬀered under the terms
of this License including without limitation any production in the literary, scientiﬁc and artistic domain, whatever may be the mode or form
of its expression including digital form, su as a book, pamphlet and
other writing; a lecture, address, sermon or other work of the same nature; a dramatic or dramatico-musical work; a oreographic work or
entertainment in dumb show; a musical composition with or without
words; a cinematographic work to whi are assimilated works expressed by a process analogous to cinematography; a work of drawing,
painting, aritecture, sculpture, engraving or lithography; a photographic work to whi are assimilated works expressed by a process
analogous to photography; a work of applied art; an illustration, map,
plan, sket or three-dimensional work relative to geography, topography, aritecture or science; a performance; a broadcast; a phonogram; a
compilation of data to the extent it is protected as a copyrightable work;
or a work performed by a variety or circus performer to the extent it is
not otherwise considered a literary or artistic work.
“You” means an individual or entity exercising rights under this License
who has not previously violated the terms of this License with respect to

 

the Work, or who has received express permission from the Licensor to
exercise rights under this License despite a previous violation.
(j) “Publicly Perform” means to perform public recitations of the Work and
to communicate to the public those public recitations, by any means
or process, including by wire or wireless means or public digital performances; to make available to the public Works in su a way that
members of the public may access these Works from a place and at a
place individually osen by them; to perform the Work to the public
by any means or process and the communication to the public of the
performances of the Work, including by public digital performance;
to broadcast and rebroadcast the Work by any means including signs,
sounds or images.
(k) “Reproduce” means to make copies of the Work by any means including without limitation by sound or visual recordings and the right of
ﬁxation and reproducing ﬁxations of the Work, including storage of a
protected performance or phonogram in digital form or other electronic
medium.
. Fair Dealing Rights. Nothing in this License is intended to reduce, limit, or
restrict any uses free from copyright or rights arising from limitations or
exceptions that are provided for in connection with the copyright protection under copyright law or other applicable laws.
. License Grant. Subject to the terms and conditions of this License, Licensor
hereby grants You a worldwide, royalty-free, non-exclusive, perpetual (for
the duration of the applicable copyright) license to exercise the rights in the
Work as stated below:
(a) to Reproduce the Work, to incorporate the Work into one or more Collections, and to Reproduce the Work as incorporated in the Collections;
(b) to create and Reproduce Adaptations provided that any su Adaptation, including any translation in any medium, takes reasonable steps to
clearly label, demarcate or otherwise identify that anges were made
to the original Work. For example, a translation could be marked “e
original work was translated from English to Spanish,” or a modiﬁcation
could indicate “e original work has been modiﬁed.”;
(c) to Distribute and Publicly Perform the Work including as incorporated
in Collections; and,
(d) to Distribute and Publicly Perform Adaptations.
(e) For the avoidance of doubt:
i. Non-waivable Compulsory License Semes. In those jurisdictions
in whi the right to collect royalties through any statutory or compulsory licensing seme cannot be waived, the Licensor reserves the
exclusive right to collect su royalties for any exercise by You of the
rights granted under this License;
ii. Waivable Compulsory License Semes. In those jurisdictions in
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whi the right to collect royalties through any statutory or compulsory licensing seme can be waived, the Licensor waives the
exclusive right to collect su royalties for any exercise by You of the
rights granted under this License; and,
iii. Voluntary License Semes. e Licensor waives the right to collect
royalties, whether individually or, in the event that the Licensor is a
member of a collecting society that administers voluntary licensing
semes, via that society, from any exercise by You of the rights
granted under this License.
e above rights may be exercised in all media and formats whether
now known or hereaer devised. e above rights include the right to
make su modiﬁcations as are tenically necessary to exercise the
rights in other media and formats. Subject to Section (f), all rights not
expressly granted by Licensor are hereby reserved.
. Restrictions. e license granted in Section  above is expressly made
subject to and limited by the following restrictions:
(a) You may Distribute or Publicly Perform the Work only under the terms
of this License. You must include a copy of, or the Uniform Resource
Identiﬁer (URI) for, this License with every copy of the Work You Distribute or Publicly Perform. You may not oﬀer or impose any terms on
the Work that restrict the terms of this License or the ability of the recipient of the Work to exercise the rights granted to that recipient under
the terms of the License. You may not sublicense the Work. You must
keep intact all notices that refer to this License and to the disclaimer of
warranties with every copy of the Work You Distribute or Publicly Perform. When You Distribute or Publicly Perform the Work, You may not
impose any eﬀective tenological measures on the Work that restrict
the ability of a recipient of the Work from You to exercise the rights
granted to that recipient under the terms of the License. is Section
(a) applies to the Work as incorporated in a Collection, but this does
not require the Collection apart from the Work itself to be made subject to the terms of this License. If You create a Collection, upon notice
from any Licensor You must, to the extent practicable, remove from the
Collection any credit as required by Section (c), as requested. If You
create an Adaptation, upon notice from any Licensor You must, to the
extent practicable, remove from the Adaptation any credit as required
by Section (c), as requested.
(b) You may Distribute or Publicly Perform an Adaptation only under the
terms of: (i) this License; (ii) a later version of this License with the
same License Elements as this License; (iii) a Creative Commons jurisdiction license (either this or a later license version) that contains the
same License Elements as this License (e.g., Aribution-ShareAlike .
US)); (iv) a Creative Commons Compatible License. If you license the

 

Adaptation under one of the licenses mentioned in (iv), you must comply with the terms of that license. If you license the Adaptation under
the terms of any of the licenses mentioned in (i), (ii) or (iii) (the “Applicable License”), you must comply with the terms of the Applicable
License generally and the following provisions: (I) You must include
a copy of, or the URI for, the Applicable License with every copy of
ea Adaptation You Distribute or Publicly Perform; (II) You may not
oﬀer or impose any terms on the Adaptation that restrict the terms of
the Applicable License or the ability of the recipient of the Adaptation
to exercise the rights granted to that recipient under the terms of the
Applicable License; (III) You must keep intact all notices that refer to the
Applicable License and to the disclaimer of warranties with every copy
of the Work as included in the Adaptation You Distribute or Publicly
Perform; (IV) when You Distribute or Publicly Perform the Adaptation, You may not impose any eﬀective tenological measures on the
Adaptation that restrict the ability of a recipient of the Adaptation from
You to exercise the rights granted to that recipient under the terms of
the Applicable License. is Section (b) applies to the Adaptation as
incorporated in a Collection, but this does not require the Collection
apart from the Adaptation itself to be made subject to the terms of the
Applicable License.
(c) If You Distribute, or Publicly Perform the Work or any Adaptations
or Collections, You must, unless a request has been made pursuant to
Section (a), keep intact all copyright notices for the Work and provide,
reasonable to the medium or means You are utilizing: (i) the name of
the Original Author (or pseudonym, if applicable) if supplied, and/or if
the Original Author and/or Licensor designate another party or parties
(e.g., a sponsor institute, publishing entity, journal) for aribution
(“Aribution Parties”) in Licensor’s copyright notice, terms of service
or by other reasonable means, the name of su party or parties; (ii) the
title of the Work if supplied; (iii) to the extent reasonably practicable,
the URI, if any, that Licensor speciﬁes to be associated with the Work,
unless su URI does not refer to the copyright notice or licensing
information for the Work; and (iv) , consistent with Ssection (b), in
the case of an Adaptation, a credit identifying the use of the Work
in the Adaptation (e.g., “Fren translation of the Work by Original
Author,” or “Screenplay based on original Work by Original Author”).
e credit required by this Section (c) may be implemented in any
reasonable manner; provided, however, that in the case of a Adaptation
or Collection, at a minimum su credit will appear, if a credit for all
contributing authors of the Adaptation or Collection appears, then
as part of these credits and in a manner at least as prominent as the
credits for the other contributing authors. For the avoidance of doubt,
You may only use the credit required by this Section for the purpose
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of aribution in the manner set out above and, by exercising Your
rights under this License, You may not implicitly or explicitly assert or
imply any connection with, sponsorship or endorsement by the Original
Author, Licensor and/or Aribution Parties, as appropriate, of You
or Your use of the Work, without the separate, express prior wrien
permission of the Original Author, Licensor and/or Aribution Parties.
(d) Except as otherwise agreed in writing by the Licensor or as may be
otherwise permied by applicable law, if You Reproduce, Distribute or
Publicly Perform the Work either by itself or as part of any Adaptations
or Collections, You must not distort, mutilate, modify or take other
derogatory action in relation to the Work whi would be prejudicial to
the Original Author’s honor or reputation. Licensor agrees that in those
jurisdictions (e.g. Japan), in whi any exercise of the right granted in
Section (b) of this License (the right to make Adaptations) would be
deemed to be a distortion, mutilation, modiﬁcation or other derogatory
action prejudicial to the Original Author’s honor and reputation, the
Licensor will waive or not assert, as appropriate, this Section, to the
fullest extent permied by the applicable national law, to enable You to
reasonably exercise Your right under Section (b) of this License (right
to make Adaptations) but not otherwise.
. Representations, Warranties and Disclaimer
         ,
         
      , , ,
  , ,  , 
 , ,     , 
,        , ,
      ,    
.         
,        .
. Limitation on Liability.       
,             
  , , ,   
           ,  
         .
. Termination
(a) is License and the rights granted hereunder will terminate automatically upon any brea by You of the terms of this License. Individuals or
entities who have received Adaptations or Collections from You under
this License, however, will not have their licenses terminated provided
su individuals or entities remain in full compliance with those licenses. Sections , , , , , and  will survive any termination of this
License.

 

(b) Subject to the above terms and conditions, the license granted here is
perpetual (for the duration of the applicable copyright in the Work).
Notwithstanding the above, Licensor reserves the right to release the
Work under diﬀerent license terms or to stop distributing the Work at
any time; provided, however that any su election will not serve to
withdraw this License (or any other license that has been, or is required
to be, granted under the terms of this License), and this License will
continue in full force and eﬀect unless terminated as stated above.
. Miscellaneous
(a) Ea time You Distribute or Publicly Perform the Work or a Collection,
the Licensor oﬀers to the recipient a license to the Work on the same
terms and conditions as the license granted to You under this License.
(b) Ea time You Distribute or Publicly Perform an Adaptation, Licensor
oﬀers to the recipient a license to the original Work on the same terms
and conditions as the license granted to You under this License.
(c) If any provision of this License is invalid or unenforceable under applicable law, it shall not aﬀect the validity or enforceability of the remainder of the terms of this License, and without further action by the
parties to this agreement, su provision shall be reformed to the minimum extent necessary to make su provision valid and enforceable.
(d) No term or provision of this License shall be deemed waived and no
brea consented to unless su waiver or consent shall be in writing
and signed by the party to be arged with su waiver or consent.
(e) is License constitutes the entire agreement between the parties with
respect to the Work licensed here. ere are no understandings, agreements or representations with respect to the Work not speciﬁed here.
Licensor shall not be bound by any additional provisions that may appear in any communication from You. is License may not be modiﬁed
without the mutual wrien agreement of the Licensor and You.
(f) e rights granted under, and the subject maer referenced, in this
License were draed utilizing the terminology of the Berne Convention for the Protection of Literary and Artistic Works (as amended on
September , ), the Rome Convention of , the WIPO Copyright
Treaty of , the WIPO Performances and Phonograms Treaty of 
and the Universal Copyright Convention (as revised on July , ).
ese rights and subject maer take eﬀect in the relevant jurisdiction in
whi the License terms are sought to be enforced according to the corresponding provisions of the implementation of those treaty provisions
in the applicable national law. If the standard suite of rights granted
under applicable copyright law includes additional rights not granted
under this License, su additional rights are deemed to be included in
the License; this License is not intended to restrict the license of any
rights under applicable law.
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Creative Commons Notice
Creative Commons is not a party to this License, and makes no warranty
whatsoever in connection with the Work. Creative Commons will not be
liable to You or any party on any legal theory for any damages whatsoever,
including without limitation any general, special, incidental or consequential
damages arising in connection to this license. Notwithstanding the foregoing
two () sentences, if Creative Commons has expressly identiﬁed itself as the
Licensor hereunder, it shall have all rights and obligations of Licensor.
Except for the limited purpose of indicating to the public that the Work is
licensed under the CCPL, Creative Commons does not authorize the use by
either party of the trademark “Creative Commons” or any related trademark
or logo of Creative Commons without the prior wrien consent of Creative
Commons. Any permied use will be in compliance with Creative Commons’
then-current trademark usage guidelines, as may be published on its website
or otherwise made available upon request from time to time. For the avoidance of doubt, this trademark restriction does not form part of the License.
Creative Commons may be contacted at http://creativecommons.org/.

Glossary
applet An applet is a small program that runs in a panel. Applets provide
useful functions su as starting a program, viewing the time, or accessing
the main menu.
Canonical Canonical, the ﬁnancial baer of Ubuntu, provides support for
the core Ubuntu system. It has over  paid staﬀ members worldwide
who ensure that the foundation of the operating system is stable, as well as
eing all the work submied by volunteer contributors. To learn more
about Canonical, go to http://www.canonical.com.
cursor e blinking cursor that appears aer the prompt in the terminal is
used to show you where text will appear when you start typing. You can
move it around with arrow keys on your keyboard.
decrypted When you decrypt an encrypted ﬁle it becomes decrypted, and
viewable. Encrypted ﬁles on Ubuntu are not recognizable in any language,
they are just a string of random numbers and leers until they are decrypted using a password.
desktop environment A generic term to describe a  interface for humans
to interact with computers. ere are many desktop environments su as
, ,  and  just to name a few.
  stands for Dynamic Host Conﬁguration Protocol, it is used by a
 server to assign computers on a network an  address automatically.
dialup connection A dialup connection is when your computer uses a modem
to connect to an  through your telephone line.
distribution A distribution is a collection of soware that is already compiled
and conﬁgured ready to be installed. Ubuntu is an example of a distribution.
dual-booting dual-booting is the process of being able to oose one of two
diﬀerent operating systems currently installed on a computer from the
boot menu, once selected your computer will then boot into whiever
operating system you ose at the boot menu. Dual booting is a generic
term, and can refer to more than two operating systems.
Ethernet port An Ethernet port is what an Ethernet cable is plugged into
when you are using a wired connection.
  (whi once stood for  Network Object Model Environment) is the default desktop environment used in Ubuntu.
 e  (whi stands for Graphical User Interface) is a type of user
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interface that allows humans to interact with the computer using graphics
and images rather than just text.
  stands for Internet Service Provider, an  is a company that provides
you with your Internet connection.
kernel A kernel is the central portion of a Unix-based operating system,
responsible for running applications, processes, and providing security for
the core components.
maximize When you maximize an application in Ubuntu it will ﬁll the whole
desktop, excluding the panels.
MeMenu e MeMenu in Ubuntu . allows you to manage your presence
on social networking services. It also allows you to publish status messages
to all of your accounts by entering updates into a text ﬁeld.
minimize When you minimize an open application, the window will no
longer be shown. If you cli on a minimized application’s panel buon, it
will then be restored to its normal state and allow you to interact with it.
notiﬁcation area e notiﬁcation area is an applet on the panel that provides
you with all sorts of information su as volume control, the current song
playing in Rhythmbox, your Internet connection status and email status.
output e output of a command is any text it displays on the next line aer
typing a command and pressing enter, e.g., if you type pwd into a terminal
and press Enter, the directory name it displays on the next line is the
output.
paage Paages contain soware in a ready-to-install format. Most of
the time you can use the Soware Center instead of manually installing
paages. Paages have a .deb extension in Ubuntu.
panel A panel is a bar that sits on the edge of your screen. It contains applets
whi provide useful functions su as running programs, viewing the
time, or accessing the main menu.
parameter Parameters are special options that you can use with other commands in the terminal to make that command behave diﬀerently, this can
make a lot of commands far more useful.
partition A partition is an area of allocated space on a hard drive where you
can put data.
partitioning partitioning is the process of creating a partition.
 A personal paage arive () is a custom soware repository that
typically contains either paages that aren’t available in the primary
Ubuntu repositories or newer versions of paages that are available in the
primary repositories.

 

prompt e prompt displays some useful information about your computer,
it can be customized to display in diﬀerent colors as well as being able to
display the time, date and current directory as well as almost anything else
you like.
proprietary Soware made by companies that don’t release their source code
under an open source license.
router A router is a specially designed computer that using its soware and
hardware, routes information from the Internet to a network. It is also
sometimes called a gateway.
server A server is a computer that runs a specialized operating system and
provides services to computers that connect to it and make a request.
shell e terminal gives access to the shell, when you type a command into
the terminal and press enter the shell takes that command and performs
the relevant action.
Soware Center e Soware Center is where you can easily manage soware installation and removal as well as the ability to manage soware
installed via Personal Paage Arives.
terminal e terminal is Ubuntu’s text only interface, it is a method of controlling some aspects of the operating system using only commands entered via the keyboard.
USB USB stands for Universal Serial Bus. It is a standard interface speciﬁcation for connecting peripheral hardware devices to computers. ese could
range from external hard drives to scanners and printers.
wired connection A wired connection is when your computer is physically
connected to a router or Ethernet port with a cable, this is the most common connection for desktop computers.
wireless connection A wireless connection involves no cables of any sort and
instead uses a wireless signal to communicate with either a router, access
point or computer.

Credits
is manual wouldn’t have been possible without the eﬀorts and contributions from the following people:

Team Leads
Benjamin Humphrey—Project Creator
Kevin Godby—Lead TEXnician
Ri Fosburgh—Editor in Chief (Maveri)
Ilya Haykinson—Authors coordinator
Josh Holland—Translation maintenance

orsten Wilms—Design
Adnane Belmadiaf—Web development
Luke Jennings—ishot developer
Neil Tallim—ishot developer
Simon Vermeersh—ishot developer

Authors
Joe Burgess
omas Cantara
Sayantan Das
Kelvin Gardiner
Ma Griﬃn

Ilya Haykinson
Wolter Hellmund
Josh Holland
Benjamin Humphrey
Luke Jennings

Elan Kugelmass
Alexander Lancey
Ryan Macnish

Kevin Godby
Ilya Haykinson
Benjamin Humphrey
Alexander Lancey
Ja Leigh

Isabell Long
Ryan Macnish
Rohit R.
Steven Riards
Chris Woollard

Benjamin Humphrey
David Nel

orsten Wilms

Luke Jennings
Neil Tallim

Simon Vermeersh

Editors
Bilal Akhtar
Mario H. Burgos
Bryan Behrenshausen
Sayantan Das
Ri Fosburgh

Designers
K. Vishnoo Charan Reddy
Wolter Hellmund

Developers
Adnane Belmadiaf
Kevin Godby



    .

Translation Editors
Fran Diéguez (Galician)
Hannie Dumoleyn (Dut)
Shazedur Rahim Joardar (Bengali)

Xuacu Saturio (Asturian)
Daniel Sury (German)
Shrinivasan (Tamil)

Chris Woollard (British English)
John Xygonakis (Greek)

mozilla_help_view_project
Joey-Elijah Alexithymia
Jono Bacon
Manualbot
Chris Johnson
Elan Kugelmass
Elizabeth Krumba

Josh Leveree
Walter Méndez
Martin Owens
Tim Penhey
Andy Piper
Alan Pope
Mahew Paul omas

Special thanks
Chris_Ilias
Bo
underpass
jehurd
cl
kjhass
djstsys
e Ubuntu Documentation Team
e Ubuntu Community Learning Project

Past Contributors
Jason Cook (Editor)

Jamin Day (Editor)

Index
About GNOME, 
About Ubuntu, 
AisleRiot Solitaire, 
Appearance Preferences, 
apt-get, 
Avant Window Navigator, 

kernel, 
Kino, 
Lifesaver, 
Linux, –
Mahjongg, 
Mines, 
Movie Player, 

Brasero, , 
Cairo-Do, 
Calculator, 
Canonical, 
cd, 
Cheese, 

Nautilus, –, , , 
Network Connections, 
NetworkManager, , 
OpenOﬃce.org Drawing, 
Orca, 

Debian, 
Dell, , 
Doy, 
ecryptfs-setup-private,


Empathy, , , , 
Evolution, , , –, , 

password, 
Pidgin, 
Pitivi, 
pwd, 
adrapassel, 

Finder, 
Firefox, , , , , , , , 
gBrainy, 
gedit, 
grub-install,



Gufw, , 
Gwibber, 
Help and Support, 

Rhythmbox, , , 
root, 
Sear for Files, , 
Shotwell, , 
Shuleworth, Mark, 
Simple Scan, 
Skype, 
Soware Center, –, , 

Soware Sources, , 
Sound Recorder, 
Sudoku, 
Synaptic Paage Manager, , , ,
, 
system requirements, 
System, 
Take Screenshot, 
Tomboy, 
Tomboy Notes, 
Totem, 
Ubuntu
deﬁnition of, 
downloading, 
history of, 
philosophy of, 
Ubuntu Forums, 
Ubuntu Help Center, , , 
Ubuntu One, 
Ubuntu promise, 
Ubuntu Soware Center, , , , ,
, , 
Unix, , 
Update Manager, 
VLC, 
Windows Explorer, 
Wine, 
XChat, 


is book was typeset with XƎLATEX.
e book design is based on the Tue-LATEX document classes available at http://code.google.com/p/tufte-latex/.
e text face is Linux Libertine, designed by Philipp H. Poll. It is an open font available at http://linuxlibertine.sf.net/.
e captions and margin notes are set in Linux Biolinum, also designed by Philipp H. Poll and available at the same  above.
e terminal text and keystrokes are set in Bera Mono, originally developed by Bitstream, Inc. as Bitstream Vera.
e screenshots were captured using ishot, available at http://ubuntu-manual.org/quickshot.
e cover and title page pictograms contain shapes taken from the Humanity icon set, available at https://launchpad.net/humanity.
e title page and cover were designed using Inkscape, available at http://inkscape.org/.

